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D
igital photography is great, but 

sometimes the availability of hugely 

powerful software packages means 

that great in-camera techniques can be 

overlooked in favour of post-production fixes. 

While it naturally depends on what equipment 

you are using, your camera and lenses are 

almost certainly capable of some fantastic tricks 

that can get you a long way towards creative, 

artistic images – without the need for extensive 

retouching or compositing.

Of course, there are many techniques that 

you can incorporate into your photography, 

but over the next few pages you’ll discover ten 

methods that are easier than they might seem 

and don’t require the use of specialist kit.

From overlooked settings like auto-bracketing 

to simply moving your camera during an 

exposure, you’ll learn how to get more creative 

with your photography and discover ways to 

take artistic and imaginative images that you 

didn’t think were possible.

Cut down your post-production time by using some of these creative 
in-camera tricks on your next shoot

10 amazing
photography  
techniques 
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1. Get creative 
with exposures

One of the things that can frustrate people 

about modern photography is the fact that, 

many of its more creative facets take place 

in post-production, long after the original 

image was captured. Unless they had access 

to a fully functional darkroom, film-based 

photographers had to find ways to create 

intriguing effects in-camera.

Right from the early days of photography, 

creatives have been experimenting with the 

notion of exposing a single frame twice in 

order to splice one scene or composition with 

another. Indeed, before cameras automatically 

wound on the roll of film, photographers could 

easily find themselves accidentally neglecting 

to do so manually, resulting in the potential for 

very interesting effects to occur.

This sort of effect can be reproduced using 

many current DSLRs and CSCs, which offer a 

dedicated Multiple Exposure mode. While you 

generally only need the ability to blend two 

frames, some photographers will find that their 

cameras feature the ability to shoot as many 

as nine or ten frames. This feature can even be 

used to create long exposure effects without 

the need for a neutral density filter, as several 

short exposures combined as one frame will 

result in an effect that’s remarkably similar to 

the results produced by a filter.

Once you’ve determined that your camera 

has the Multiple Exposure mode, the process 

is relatively straightforward and there isn’t a 

long list of variables to worry about. You first 

have to determine how many frames you 

want to set for your sequence, as once you’ve 

started shooting, you can’t readjust this. The 

only other option you are likely to encounter 

is Auto Gain On/Off. Auto Gain will attempt to 

build the correct exposure for you – potentially 

useful in some situations, but not so great in 

others. It depends on the nature of the subject 

you are shooting and the effect that you are 

hoping to produce, so try experimenting with 

Auto Gain to discover what works best for you.

If you don’t have this setting on your camera, 

on this issue’s cover disc you can discover how 

to reproduce similar effects in Photoshop.

Create surrealist portraits using 
an in-camera multiple exposure

2: Take your first shot
Take a photo of your model. It works best to do 

this against a background that will be slightly 

overexposed, such as the sky.

3: Find a second subject
Take a photo of a nearby building or tree. This 

second shot will then sit over the top of the first 

image that you captured.

1: Check your settings
Depending on your camera, you may have a 

choice of as many as nine or ten exposures, but 

you really only need two for this effect. Experiment 

with Auto Gain On and Off.

Double exposures are a 

fun way of producing an 

unusual, creative effect 

in-camera without the 

need for Photoshop

10  Photography Tips, Tricks & Fixes
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3. Discover 
zone focusing 

Taking candid reportage images isn’t always 

easy because getting great photos often 

requires you to be as discreet as possible. 

Holding and aiming a camera, even if it’s a 

small CSC, will draw attention to yourself and 

will therefore make potential subjects wary of 

your presence.

One way to avoid this unwanted exposure is 

to shoot from the hip. It’s never going to be an 

exact science and there’s no way to ensure that 

every shot you take from this perspective will 

work, but it’s a technique worth getting to know 

if you want to achieve truly candid shots.

Even when composing normally, focusing 

takes time and makes you miss fleeting 

moments, and on top of that it’s impossible to 

focus accurately while shooting from the hip. 

Zone focusing is a setting that helps you to 

negate this problem, so take a look at how it 

works here.

Shoot from the hip with success 
by using this simple technique

1: Load your bracketed shots 
Click on Load Bracketed Photos and navigate 

to their location on your drive or drag and drop 

them into the window that appears.

2: Merge to HDR Options 
In the latest version of Photomatix Pro, you can 

tell the software to both ensure the images are 

aligned, and tell whether they were captured 

hand-held or on a tripod.

3: Tonemapping 
Photomatix Pro presents various presets and 

nuanced control sliders for the next stage, 

known as tonemapping. Keep in mind that 

colour HDR shots often look rather garish.

4: Convert to mono 
Use Photoshop to convert the image to black 

and white. You can also apply a local contrast 

enhancement and vignette here.

Zone-focusing 

enables you to 

capture candid 

images quickly, easily 

and discreetly

Auto-bracketing is available on most cameras, 

but many digital photographers don’t ever 

employ it, as it’s easy to assume that, by 

shooting in RAW, all but the most extreme 

exposure errors can be salvaged by clever 

tweaking in post-production. 

However, if you have any interest in high 

dynamic range (HDR) effects, the auto-

bracketing feature can be used to capture 

several different exposure values in-camera, 

without the need to process a single RAW 

file in different ways. Although HDR is most 

commonly associated with landscape and 

urban photography, it can also be applied to 

portraits in order to produce images that draw 

out the maximum amount of skin texture.

Set your camera’s auto-bracketing so that 

it covers a range of -2EV to +2EV. On some 

models, this will mean that you’ll need to shoot 

five bracketed frames, while other models 

will enable you to set three bracketed frames 

to cover this range. This depends on the EV 

steps that the camera enables you to make 

while bracketing. You’ll want to use Aperture 

Priority mode, so that depth of field remains 

constant. Check the shutter speed that the 

camera’s meter is suggesting as a normal 

exposure and ensure that this is fast enough, 

so that when your camera sets +2EV the 

shutter speed is not too slow. If necessary, use 

a slightly higher ISO or find a way to increase 

the ambient light on the subject.

Even if you don’t want to produce an HDR 

image, auto-bracketing is a great way of 

guaranteeing that you’ll get a great exposure 

in situations where you’re worried about the 

exposure or only have one opportunity to get a 

particular shot.

2. Take striking HDR images Process shots in 
Photomatix Pro

The often-overlooked auto-bracketing feature on your 
camera is useful for more than just landscapes

1: Determine the focal length 
You need to choose a focal length for your photos 

and stick to it, as adjustments to this naturally 

change the focus. Many street photographers use 

a prime lens, which simplifies matters.

2: Set the focus
Choose an object at a distance from you that 

matches where you’d like your main point of focus 

to be in your reportage images. Make sure this is 

a distance you feel comfortable working with.

3: Switch to manual 
As soon as you’ve done this, lock the focus by 

switching your camera to manual focus mode. 

This means you can maintain a consistent focus 

distance, which you can judge when shooting.

Photography Tips, Tricks & Fixes  11
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Landscape photographers almost always 

seek to produce images with the maximum 

depth of field possible. Many compositions 

are dependent on strong foreground interest, 

which is used as a leading line, or to balance 

the dynamics of the scene within the 

confines of a still image. 

There’s little point in photographers going 

to these compositional efforts if they are 

unable to make everything in the image 

seem sharp, so they need to take extra care 

with focusing to maximise depth of field.

Aperture is the chief means of controlling 

depth of field, with wide apertures like f2.8 

creating shallow depth of field and narrow 

apertures, such as f22, producing a deeper 

depth of field. However, the narrower the 

aperture, the more likely diffraction is to 

occur, not to mention the fact that narrow 

apertures are not a guarantee of sharpness.

Each combination of sensor size, focal 

length and aperture has its own unique 

value, the hyperfocal distance, that you can 

focus on to get the highest possible depth of 

field in a single shot. When you focus on the 

hyperfocal distance, your image should be 

sharp from half the distance to infinity.

The trouble is that the formula isn’t one 

that you’re likely to do in your head. With 

old prime lenses, this distance was marked 

onto the lens for a couple of the more likely 

apertures, such as f11 and f16, so all you 

had to do was rotate the focus ring in line 

with these, but on modern zooms this sort 

of thing isn’t present. Fortunately, it’s easy to 

find hyperfocal distance calculators online 

that will calculate the hyperfocal focusing for 

you. There are now also apps to do this too.

Modern lenses don’t always have reliable 

distance scales marked onto them, so if 

the hyperfocal distance is, for example, 

4.3 metres away, focusing at this point 

requires guesswork. Some photographers 

recommend stopping down to a narrower 

aperture after calculating, e.g. from f11 to f16.

“Hyperfocal focusing was the ideal choice for this image, 

shot from a fairly high tripod position and a wide angle 

lens, I could be certain of sharpness throughout the 

image without relying on autofocus or Live View”

4. Stay pin-sharp
Use hyperfocal focusing to maximise depth of field without stopping down to the narrowest aperture

What challenges does hyperfocal 

focusing present to the photographer? 

Once you see past the charts, apps and 

lens markings, it’s pretty simple really. Some 

lenses are easier than others to set once 

you have established the distance you want. 

Manual focus lenses are normally easier, as 

the gearing of the lenses is less sensitive 

than autofocus ones. The biggest hurdle is 

that lenses don’t have all that many distances 

marked on them, so some visualisation is 

needed to line up the part of the lens with 

the centre line. For example, using a wide-

angle lens is pretty easy. An 18mm lens at 

f11 has a hyperfocal distance of 97.3cm on 

a full-frame DSLR, which, when set on the 

lens, means everything from 48.6cm – half 

the hyperfocal distance – to infinity will be 

sharp. On a 50mm lens at f11 the hyperfocal 

distance is much further away at 741.6cm, 

which will end up giving you sharp focus 

from 371cm to infinity.

How do you apply it practically in the field 

and how do you judge distances? 

It can be tricky to find an exact distance, but 

I would look for the nearest distance either 

side of that and visualise where that would 

be in between by rotating the focus ring back 

and forth and judge when it’s about right by 

visualising if it’s halfway or a third of the way 

in between. In any case, I would review on 

the LCD to see the results.

Hyperfocal focusing in the field
Landscape photographer Andy Farrer (www.andyfarrer.
co.uk) reveals his pro tips for maximising sharpness
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Sunstars can add the icing on the cake in 

a great image, making the photo 

especially dramatic and attractive

It’s not just about aperture; you need 

careful composition and the right 

conditions to make starbusts work well
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5. Create sunstars

The Sun isn’t the easiest thing to 

include in your landscape shots 

in a way that works well with the 

other elements of the scene. One 

way of doing so is to create sunstars, in which 

beams of light extend dramatically from the 

Sun. Professional landscape photographer Ian 

Rolfe (www.souther nlightscapes.com) is fond 

of creating sunstars in his work. “Sunstars can 

add a very strong focal point and they can also 

add an entirely new dimension of interest to the 

image”, he says. “The loveliest ones, I find, are 

captured in the early hours of morning and near 

dusk. As light from the Sun has to travel further 

at either end of the day, it seems to work better 

when capturing sunstars. I have photographed 

them along coastlines, in mountains, general 

landscapes, forests, as well as many various 

city scenes. Historic churches, old barns,  

skyscrapers, and monuments and statues in 

city scenes are wonderful subject material.”

When creating a sunstar, the aperture is key. 

“Your first step for great starbursts is to use a 

medium to small aperture”, says Rolfe. “Often 

it means shooting at f18 or even narrower. You 

will often have to put up with some diffraction 

in your image to get a good sunstar. It always 

pays to experiment and shoot various aperture 

settings to see what works best. Make sure 

there is good contrast between the light and its 

background. Trying to get a starburst around 

the Sun if your sky is blown out is not going to 

work, as the white sky and the colour of the Sun 

do not have enough contrast.”

The lens you are using also influences the 

appearance of sunstars, as the number of 

diaphragm blades it has controls how many 

points of light you’ll be able to create. “Become 

familiar with the number of blades in each 

lens you own,” says Rolfe. “I find that the more 

streaks you have, the more dynamic the photo.”

It’s important to compose your shots to 

create the maximum impact. “The best sunstars 

are often created when the Sun is partially 

blocked by something, such as when the Sun 

is half obscured by a tree or the corner of a 

building. A great way to capture a starburst is to 

anticipate the Sun’s trajectory (as it moves into 

or out of a subject), set up your tripod and then, 

when you see the Sun poke its head in or out of 

the object, you simply start firing!”

Add a sparkle to your landscapes with this simple, yet visually appealing effect

Unsuccessful attempt:
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1: Set up your flash 

The numbers over on the right-hand side of the 

display indicate the number of bursts that the 

flash will produce and the number of flashes 

per second (in Hz).

2: Set your exposure
You must remember to ensure that your 

exposure length is in line with the settings that 

you’ve applied to your speedlight, and vice 

versa. For this, use the flash count divided by 

the frequency (Hz) formula to help you 

work this all out.

3: Start shooting 
Obviously, it’s far easier when you’re shooting 

a scene that doesn’t involve you having 

to perform the action as well, but it’s quite 

possible to synchronise the two if you’ve got a 

bit of patience. 

Stroboscopic flash in action

Stroboscopic fl ash is great for 

capturing creative images of 

motion and action

6. Use flash 
for creative 
action shots 

Speedlight flash units enjoy something of a 

mixed reputation among digital photographers, 

with some loving them and others avoiding 

them as much as they possibly can. Whatever 

your view of them, it’s hard to deny that 

the stroboscopic or multi-flash function 

has boundless creative potential. Various 

manufacturers refer to this mode differently, so 

it’s a good idea to consult your speedlight’s 

manual to determine if your model has this, 

what it’s known as and how it operates.

The basic premise is that in low ambient 

light levels, you can set your flash unit to fire 

multiple times across one or two seconds to 

capture different stages of an action in one 

photograph. Experimentation is required in 

order to explore what’s possible, but there’s 

an element of maths involved in stroboscopic 

flash and a formula that you can work to 

guide you. You are able to control the number 

of bursts that the flash will produce and the 

number of flashes per second (measured in 

Hz). Essentially, the shutter speed must not be 

any shorter than the flash count divided by the 

frequency (Hz). So, if the flash count is 4 and 

the frequency is 8Hz, then the shutter speed 

must be half a second or longer.

Get fantastic results with this 
great flash technique
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7. Paint with light

Light painting isn’t anything new – some 

of the earliest known examples of it 

are a century old. It’s a highly flexible 

technique, as it can be used both 

correctively and creatively, but both 

involve low-light conditions.

There are low-light situations in which 

extra illumination is required and flash is 

likely to spoil the photo’s ambience. In 

these circumstances, light-painting can 

provide a useful alternative, enabling you 

to illuminate a subject with a constant 

light source in a way that looks more 

subtle and naturalistic than flash. Light 

painting also enables you to illuminate 

your subject selectively and intelligently, 

paying closer attention to certain areas 

while keeping others in shadow.

You can also try using light painting 

creatively, for the very reason that it 

provides such precise control over where 

light occurs in relation to your subject. 

For creative photos, a tightly focused 

light source can be used to great effect.

Digital capture makes light-painting 

easier than ever before because images 

can be reviewed and repeated if you’re 

unhappy with the final effect.

Produce some creative images by using a combination
of both a long exposure and low ambient lighting

1: Set a delay 
Set your camera’s self-timer to give yourself a few 

seconds’ delay before the exposure begins, enabling 

you to get into position.

2: Exposure length
Provided ambient light levels are low, the exposure 

length can be determined by how long you wish to paint 

with light for.

3: Get painting 
You need to paint the area that you want to be illuminated 

evenly and consistently throughout the duration of the 

exposure. Spend too long in one spot and not enough 

time in another and the effect won’t be successful.

Capture the shot

Light-painting takes 

advantage of the long 

exposures required in 

low ambient light levels

What are the benefits of using an ND 

filter for travel/urban shots? 

For my travel photography [take a look at 

the gallery at www.nomad-icvision.com], 

many of the places that I visit are crowded with tourists 

and traffic. Sometimes, this activity is a key part of my 

composition, but most of the time, I prefer the scene 

to be empty. A 10-stop ND filter allows me to use a 

slow shutter speed in bright light. If my shutter speed 

is slow enough (ten seconds or more) it will render any 

movement as a blur or invisible.

What steps do you take when you are doing this? 

Try to compose your scene so that movement is from 

side to side. This type of movement is usually invisible 

in a long exposure. When the movement is from front 

to back, it creates a blur that can be more distracting 

than the static element. Certain movement is always 

recorded, such as light trails from traffic. In that case, 

see if you can use it to complement the composition. I 

use a screw-in filter. Once attached, it’s impossible to 

see through, which makes composing and focusing 

difficult. Switch the camera to Live View to compose 

the scene – while you may not be able to see through 

viewfinder, Live View makes short work of the filter. 

While in manual focus mode, zoom in as far as possible 

and focus the lens. Ensure that image stabiliser is 

turned off, as leaving it on may result in a soft image. 

Take an exposure and analyse the results. A 10-stop 

ND filter tricks the camera’s meter, so you might have 

to increase exposure. After a while, it becomes second 

nature to guess the correct exposure.

8. Remove crowds
Pro photographer Jon Reid reveals how 
he cleans up scenes with ND filters

Images can 

distract, as 

the eye is 

drawn to the 

activity rather 

than the 

scene itself

Using an ND 

fi lter enables 

long exposures 

to be captured, 

rendering the 

busy rush as 

an artistic and 

creative blur©
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This technique may, quite 

understandably, seem like the 

wackiest notion imaginable. It literally 

involves shooting with your lens 

detached from the camera body – 

something that you would never 

normally do – in order to adjust the 

plane of focus and, in so doing, create 

a whole host of creative effects. 

The fact that the lens is detached 

from the camera also means that you 

will get light leaking into the camera 

and onto the sensor – another factor 

which can be used for creative effect 

in the right conditions, though in 

others it might simply cause far too 

much flare. You can control this by 

orientating the front of the camera 

away from direct light sources.

There are a couple of considerations 

that you need to be aware of when 

free-lensing, however. Firstly, some 

lenses, such as Nikon’s G lenses, 

automatically close down to the 

narrowest aperture when the lens 

is detached from the camera, so 

you may find you need to use an 

older, D-series lens. The second 

consideration is that you are leaving 

the inner chamber of the camera 

exposed while shooting, which 

obviously means that you are risking 

dust attaching itself to the sensor. 

The only thing to do is to set the 

focus of the lens to infinity – other 

than that, there’s no precise recipe 

for free-lensing – it’s entirely about 

experimenting to see what sort of 

effects you can produce.

Free-lensing produces unusual creative 

effects that depend on the lighting 

conditions. Set your lens’s focus to infi nity 

and vary the position and angle of the lens

Be aware that dust is likely to enter your 

camera while free-lensing. Be careful 

not to drop the lens while shooting

9. Discover free-lensing
Create intriguing focusing effects by shooting 
with your lens detached from the camera

You can create impressionistic effects 

by purposefully moving the camera 

during a slightly long exposure

There’s no point in looking through the 

viewfi nder while camera dragging with 

an ND fi lter. Experiment and then review 

your images
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10. Camera dragging

The goal in most photographs is 

to create a sharp, well-exposed 

image and photographers spend 

much of their time ensuring that 

this is the case. Tripods and 

vibration-reducing lenses are there 

to help photographers achieve pin-

sharp shots by reducing capture 

movement during an exposure, so 

a technique like camera dragging, 

which goes against all of this, might 

seem completely counter-intuitive.

Like free-lensing, the aim of 

camera dragging is to create artistic 

effects, but camera dragging goes 

further into truly abstract territory, 

as you are deliberately moving the 

camera during an exposure. In 

some respects, it’s a form of light 

painting, but camera dragging 

can be explored in brighter 

ambient light levels by using an 

ND filter and a low ISO. This will 

enable you to get an exposure 

time of around 1/6sec to three 

seconds, which is just about ideal 

for camera dragging. Aim for an 

aperture between f11 and f22 and 

remember to focus on your subject 

before attaching the ND filter. 

Although the aim is for the final 

results to be impressionistic, you 

still want the true shapes and forms 

of your subject to be apparent.

As with free-lensing, there’s 

no precise formula for camera 

dragging – you just need to try it 

and then review the results to see 

what you’ve managed to capture. A 

good starting point, however, is to 

observe the patterns and shapes 

in the scene and attempt to mimic 

them in the way that you move the 

camera. Remember to ensure that 

any image stabilisation options are 

switched off.

Set a slow shutter speed and move the camera 
during the exposure to create an artistic look

By moving the camera 

during the exposure in 

one direction you can 

create artistic streaks 

like this

Instead of moving the camera during the 

exposure, zoom burst images are created by 

twisting the zoom ring of the lens during an 

exposure of around 1/5sec, using a narrow 

aperture between f11 and f22 and a low ISO. 

You can use a tripod for zoom bursts – this 

might make it easier to concentrate on adjusting 

the zoom ring. Compose your image and focus 

and then, immediately as you press the shutter, 

twist the zoom ring of the lens. Once again, it’s 

all about experimentation.

Capture zoom bursts
A variation on camera dragging 
that produces a very unique effect
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images across a 
range of genres”

Light your subjects to 
perfection to create 
beautiful photos

Portraits
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Shoot vistas 
with impact

Follow this guide and discover how to capture beautiful 
landscapes in any location

W
hen it comes to shooting the 

perfect landscape, often it isn’t 

just a case of pointing your 

lens and capturing the scene before you, 

even when visiting the most beautiful 

places. No matter where you find yourself, 

each location has its own set of challenges 

to overcome, whether that’s reflections 

on a lake, high-contrast forest scenes, or 

simply a vast, empty plain.

Incredible landscape images can be 

taken almost anywhere, but it’s all about 

understanding the tricks and techniques 

behind the shots. Over the next few 

pages you’ll discover tips for the perfect 

landscape shoot, including how to protect 

your kit, dealing with difficult shooting 

environments and how to make the most 

of the beautiful landscapes that the great 

outdoors has to offer.
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Twelve Apostles, Australia
Photographer Joshua Zhang 

(www.500px.com/shihuazhang) took 
this stunning shot at sunset. There 

were a large number of tourists and 
the shot kept being interrupted, but 

Zhang’s patience finally paid off and 
he took this 112-second exposure
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The coast is an alluring subject, and stunning 

results can be achieved in all weather 

conditions. When the light is overcast, try long 

exposures to capture blurred wave motion. 

Conversely, provided there’s enough natural 

light, capture the drama of the sea at shutter 

speeds of 1/500sec or faster to freeze wave 

movement. Simple, uncluttered images work 

well for expansive seascapes, but look for a 

focal point, framing shots with objects such as 

isolated rocks and cliffs.

Prepare for your shoot by checking tide 

tables and taking the right kit. A tripod is vital 

for coastal long exposures, and those with 

an in-built spirit level will help you keep your 

horizons level. A wide-angle lens is ideal for 

most seascapes, although a mid telephoto 

will make the most of cliff top vantage points. 

Always protect your equipment from salt water 

and sand, use a UV filter, and shield the camera 

body from wave spray with a plastic bag or 

more specialised housing if you have it. 

Shoot seascapes
Use creative exposures to add mood to your coastline images

1: Set up the shot 
Set your camera to the lowest ISO and desired 

f-stop, then attach it to a tripod. Use manual focus 

and zoom your lens to the required focal length.

Use a neutral density filter to record long exposuresEmphasise wave movement

2: Calculate exposure 
Take a test shot using a cable release without a 

filter, then calculate the exposure time. Double the 

shutter speed for every stop of filtration added.

3: Attach filter 
Attach the ND filter to the front of the lens. Set the 

camera to Bulb mode, and fire the shutter, timing 

the exposure then closing it after the elapsed time.

Look for interest
The wave movement 
over the rocks create an 
interesting foreground 
element to this image

Capture mood
Always be on the lookout 
for changes in weather, 
colour and mood for the 
best effect

Trevose Head
Paul Newcombe used a ten-stop 
ND filter to achieve a two-minute 
exposure, smoothing the sky and 
adding cloud movement

Morning glow
In this shot Joshua Zhang 
(www.500px.com/ShihuaZhang), 
has made use of the stunning 
golden light of sunrise
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Shoot waterfalls
Control exposure to enhance 
the look of moving water
When you arrive at a waterfall, don’t set 

up straight away. Walk around the feature 

and look through the viewfinder to explore 

different angles and camera positions, and 

include foreground elements, such as rocks, 

to frame the subject. Waterfalls are all about 

movement, so consider which exposure 

best captures its drama. When shooting 

big waterfalls, exposures between 1/4sec 

to a full second show the water’s motion, 

but still retain detail in the movement. More 

delicate waterfalls benefit from even longer 

exposures, made achievable by setting 

the lowest ISO possible and adding filters. 

Try to plan your shoots around the lighting; 

balanced light is ideal for waterfalls, bringing 

out shadow details and amplifying the 

contrast. When it’s overcast you will be able 

to shoot longer speeds for a smooth effect.
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If there’s a river or stream flowing through the 

landscape you’re shooting, think about how best 

to convey it. A wide, slow river will look and feel 

different to a fast-moving mountain stream. Use 

smaller rivers as lead-in lines to draw the eye into 

the image, or wade into a stream and crouch to 

near water level for an interesting perspective. 

Consider the effect of reflections when you’re 

photographing water, particularly when there’s a 

lake in the shot. Some reflections, such as autumn 

leaves or mountains, will enhance your image, 

but others may be distraction. In these instances, 

use a polarising filter. As well as increasing the 

saturation of your scene, a polariser can cut 

through reflections in water and enable you to see 

the riverbeds beneath the surface. 

In terms of gear, a wide-angle lens will enable 

you to include the valley as a river twists through it, 

while a telephoto is useful for bringing the curves 

of the water closer to you. Dress appropriately for 

shooting in this location, wearing waders if you 

have them. This enables you to get in the water for 

interesting perspectives, while avoiding getting wet. 

Perfect rivers 
Capture both moving and still water
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Capo Pecora, Sardinia
The photographer has taken this 
shot at a low angle for a more 
interesting perspective, including 
rocks in the foreground to draw 
the eye into the frame

Lumsdale Falls, Peak District
Here seen in early autumn, Paul 

Newcombe (www.paulnewcombe
photography.co.uk) used a circular 

polariser to minimise water reflections 
and slow down the exposure time
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Expose for 
woodland
Bracket exposures to capture 
the full range of forests
Exposing correctly for woodland can be a 

challenge, as dense tree canopies produce 

high-contrast scenes in strong sunlight. High 

dynamic range (HDR) photography can be 

used to overcome this problem, by taking 

multiple shots at different exposures and 

combining the best parts from each into one 

image. Select the Auto Exposure Bracketing 

option from the camera’s menu and move 

the markers a few stops apart. Use Aperture 

Priority mode, choosing your desired 

aperture, then compose 

the shot as normal. The 

various shots can 

then be combined 

into one final image 

using Photoshop or 

dedicated software 

such as Photomatix. 

Woodland sunrise
Taken on an early December 
morning, photographer Ceri 
Jones caught this light display

Control exposure
This image was stopped down 

from the camera’s defined 
exposure to ensure minimal 

clipping of highlights

Position the Sun
Early-morning rays break through 
the lingering mist, and the Sun 
has been placed behind a tree to 
avoid lens flare

©
 P

a
u

l 
N

e
w

c
o

m
b

e
©

 C
e

ri
 J

o
n

e
s

©
 C

e
ri

 J
o

n
e

s

Woodlands are a rewarding location to photograph. 

By nature they’re generally quite chaotic, and one 

of the downfalls of forest photography is that it 

can look cluttered or lack focus. Use a telephoto 

lens to avoid this problem, as it’ll compress the 

perspective and isolate small sections of trees. 

You’ll need to adapt to different types of natural 

light when photographing woodland. Early-morning 

or late-afternoon is generally the best time to shoot, 

as the low-angled light will illuminate trunks and 

produce dramatic shadows. Strong light is great for 

open areas, and makes for bold images. 

Woodland scenes can be dense, so include a 

point of interest to draw the viewer’s eye. Use paths 

as lead-in lines and try different shooting angles to 

create interest. Include features, such as an angled 

trunk or bright foliage, to provide a focal point.

Simplify 
woodland
Avoid clutter when 
photographing forest scenes
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Camping on the dunes
Photographer Derrald 
Farnsworth-Livingston 
(www.journeyoflight.com) 
has included the tent as a 
secondary subject to give the 
landscape a sense of scale
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Protect your kit
Continue to shoot when the 
weather gets dramatic

Photographing vistas leaves you open to the 

elements, and nothing is more damaging to 

your electronic kit than water and sand. Most 

camera bags come with waterproof covers, 

so use these in damp conditions. Keep spare 

kit zipped up when not in use, with lenses in 

pouches, and filters in their holders. Consider 

investing in a waterproof cover for your 

camera/lens setup. In an emergency, you can 

use a carrier bag as makeshift protection, but 

if you’re planning on heading out into harsh 

conditions it’s best to invest in something 

more substantial.

1: Rucksack cover
When in a dusty place, use this to protect kit

2: Packaging
Keep original packaging to keep your kit in

3: Microfibre cloth
Use a soft cloth to wipe off sea spray and rain 

before it dries on lenses 

4: Protective case
Keep filters in cases when they’re not in use

5: Raincover
Fasten this to your camera and lens to keep it dry

Darkened dunes
By photographing in the 
golden hours, you’ll record 
a very different tone to the 
sand dunes that is less 
commonly seen in this 
type of location

Deserts are prime locations to focus on 

shadow, texture and form in your images. 

The desert wind creates lines in the sand, 

and any shadow behind them leads to high-

contrast results. Look down, instead of trying 

to capture the whole scene, by crouching 

and focusing on the detail in the sand. Start 

to see light before you look for anything else 

in your composition. 

Throughout the day in a desert, the colour 

of the sand will change in accordance with 

the angle of the Sun, so plan your shoot time 

depending on what end result you want. This 

location is no exception to the magic of the 

golden hours, and the red late-afternoon 

light will accentuate the colour of the sand, 

creating much more depth to the landscape 

than would be present in overhead sunlight. 

Use a long lens if you do have to shoot in the 

middle of the day, as this will compress the 

appearance of heat waves, and convey the 

extreme temperatures of the environment. 

While it’s always important to have a UV 

filter on lenses to protect the glass, in the 

desert this is absolutely imperative. Avoid 

changing lenses outdoors if possible, as 

even gentle winds can blow up the sand into 

your equipment. 

Capture deserts
Convey the beauty of this harsh environment and protect your kit
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Escape the elements
Take simple precautions when you’re shooting in 

the field, to protect your kit from damage

1 2 3

4 5
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Bow lake, Canada
A stunning shot by 
Andrea Auf dem Brinke 
(www.brinke.500px.com)

Mountains are the mightiest of vista locations, 

and where you stand to photograph them 

will greatly affect the outcome of your picture. 

From a valley viewpoint, include near objects, 

such as overhanging trees and branches, to 

frame the shot. Looking upwards from a low 

perspective can make a mountain seem much 

more impressive and awe-inspiring, whereas 

photographing the mountain from the peak or 

higher vantage point will play upon the idea of 

scale and dominance. 

The camera doesn’t record like the human 

eye; it can often be tricky to ensure a proper 

exposure for the sky and the mountains, and 

in these situations a graduated neutral density 

filter is handy to use. Place the transitional 

section of the filter between the foreground of 

the composition and the upper peaks, moving 

it up and down in the holder and using Live 

View to help you fine-tune the transition line in 

your composition. 

As with all landscapes, you should consider 

how to light for the subject. A mountain can 

have great texture, so avoid front lighting 

that will make it appear flat. Back lighting will 

emphasise shape and form, and side lighting 

creates dramatic shadows.

Master 
mountains
Reach the dizzying heights of 
incredible mountain images

1: Calculate distance 
Enter details for your camera, focal length and 

aperture on HyperFocal Pro. Mount your camera, 

set the zoom and dial in your aperture.

Use hyperfocal focusing to maximise depth of fieldStay sharp

2: Move 
Measure the distance from the camera to an 

object in the frame using a rangefinder. Move until 

your distance matches the hyperfocal distance.

3: Lock it off 
Switch the lens to manual focus, focusing on the 

previous object. Avoid moving the lens, taking the 

final shot with a cable release or self-timer.

Shoot overcast
When shooting on 
cloudy days, don’t 
overexpose, and 
use the clouds to 
add drama
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“Back lighting will 
emphasise shape 

and form, and side 
lighting creates 

dramatic shadows” 

Mam Tor, Peak District, UK
Scenes can change quickly, and this 
mist lifted as the Sun rose

Chrome Hill
The time of year was 
important in enabling 
this shot to be taken
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Mirror effect
Capturing sharp, 
stunning reflections is 
one way to bring your 
landscapes to life
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Sense of scale
The best way to help a viewer 
appreciate the size of the 
scenery is by including a 
secondary subject

Stay simple
It can be easy to 

overcomplicate landscapes. 
Don’t be afraid to focus on the 
shapes and textural elements
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Photographing plains is a great way to focus on the composition 

of your vista shots, with rolling hills and huge expanses of 

scenery impressing a grand sense of scale. Wide, open spaces 

can be hard to photograph because they often lack a point of 

interest, so choose objects that will act as a focal point, such as 

a group of trees or a lone dwelling, using a narrow aperture like 

f16 to achieve a sharp image from foreground to the horizon. 

Plains lack distracting elements, so they’re a location where 

traditional composition techniques work well. Use the rule of 

thirds, composing your image with the help of the grid function 

on the camera’s LCD screen. While you can place importance 

on either the sky or the land, for a more unusual image, leave the 

sky out of your image completely. 

By nature, plains are wide and open, so make sure you do 

your research on the lighting, weather and conditions before 

your go out and shoot. Use apps such as The Photographer’s 

Ephemeris (TPE), a map-centric Sun and Moon calculator that 

will enable you to see how the light will fall on the land, day or 

night, for any location.

Balance plains
Add depth to scenes by picking out details

Shadow play
By shooting at 
dusk or dawn, it’s 
possible to capture 
long shadows that 
add depth 

Show scale
Include objects 
that will juxtapose 
with the sheer 
magnitude of the 
vista you’re shooting
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Rules of 
composition
Create impact with these 
traditional techniques and keep 
the viewer’s interest in the frame

Use diagonals
Diagonal lines are a great way to draw the 

viewer’s eye. They could be made up of 

anything found in the landscape, like hedges, a 

fence, a river, or the edge of a rolling plain.

Frame images
This is an effective way to draw attention to the 

subject, and helps to give the view context. 

Look for overhanging branches and rock arches 

that will help give your shot a sense of depth.

Lead-in lines
Guide the eye through an image with lead-in 

lines. Obvious examples would be a river or 

pathway that winds its way through the shot, 

but you can use more subtle things like rocks 

or waves.

Rule of thirds
It can feel like a cliché, but the rule of thirds is 

effective in creating a balanced composition. 

Compose images with the screen’s grid 

function, placing points of interest a third of the 

way into the frame.

Change your height
Many images are taken at standing height, but 

compositions can be dramatically improved 

be using a more unusual perspective. Rest the 

camera on something stable, or set the tripod 

low to the ground.

Lead the eye
Lead-in lines guide the 
eye through the image., 

The tractor acts as a 
focal point
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Forget the sky
Focus on the land for 
a more unusual shot, 
using a telephoto lens to 
compress the perspective

Creative colour
Shooting during the golden hours 

can create stunning colours to add 
an extra dimension to simple shots

Point of interest
Severa has used a line of trees 
as an effective focal point
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Learn how to shoot and edit your own sweeping panorama images with our complete guide

W
hether or not you’re familiar with 

the term ‘panorama’, you’re almost 

certain to have seen one before. 

Photographers have used this popular 

technique since the birth of photography 

as a way of capturing a much larger field of 

view than would otherwise be possible with 

a single photo. A panorama is constructed 

by simply capturing a series of images in a 

panning motion, then the resulting photos 

are uploaded to a computer and digitally 

stitched together using specialised editing 

software to create a single seamless image. 

Landscape and architectural photographers 

often use panoramas, as the greater field of 

view allows them to capture sprawling vistas 

and cityscapes in their entirety in one beautiful, 

uninterrupted image.   

If you own a more modern compact or 

smartphone then chances are you are already 

familiar with panoramas, as most smartphones 

now come with a panorama function built in, 

which allows you to capture a stunning pano 

image with the click of a button. But how do 

you capture a panorama on a camera that 

doesn’t have this function? Well, it’s easier than 

you might think, and over the following pages 

we’re going to show you everything there is 

to know about shooting and editing your own 

spectacular panoramic images!

Record a 
breathtaking 
panorama

Sweeping landscapes
By digitally stitching together shots, you 
can capture more detail in the frame
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Tripod with suitable head
A sturdy tripod with an adjustable head will ensure 

your shots are kept level, which will make things 

much easier when it comes to blending the results 

together into a single image.

Camera
A DSLR or CSC is ideal as they offer full manual 

control, but some compacts and cameraphones 

offer panorama modes that will do the work for 

you as well.

Editing software
Although there are a number of panorama 

software packages available on the market to 

choose from, Photoshop has a Photomerge 

function built in.

The gear you’ll absolutely needEssential panorama kit

Seamless shooting
With the right equipment you’ll be able 
to capture the perfect panorama

Wide-angle viewpoint
A wide-angle lens is ideal for vistas, but 
a panorama can fit more in the frame
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1: Use a tripod
Set up your tripod and attach your camera, 

adjusting the head so that it’s in the vertical 

orientation. Level the camera using the tripod’s 

spirit level (if it has one).

2: Switch to Manual mode
To ensure that each of your exposures is the 

same, you’ll need to input the exposure settings 

manually, so go ahead and switch the camera 

over to Manual mode.

3: Choose your settings
Set the aperture to f8 and the ISO to 100. Now 

look at the exposure meter on your camera and 

adjust the shutter speed until the marker is lined 

up in the middle. 

Before shooting a panorama, there are a few 

factors you’ll need to bear in mind. The first is 

that it’s important to ensure that your camera is 

level on the tripod when setting up. If your tripod 

has a built-in spirit level, use this to ensure it’s 

perfectly straight, or if not you can always just 

use your eye to level the frame with the horizon 

line. It’s also really important to make sure that 

all of the shots you take are exposed identically. 

If just one of your shots is taken at a different 

exposure, then when it comes to stitching 

them together in Photoshop you’ll be able to 

clearly see where the images have merged, 

spoiling the illusion and ruining the final result. 

If your scene has a lot of very dark and very 

light areas, this can be tricky to achieve, so 

for the best results choose a location that is 

consistently lit throughout. 

Shoot the scene
Discover how to correctly shoot and then edit the 
photos you need to create a seamless panorama

Manual metering
It’s vital that all of your 
panorama shots are 
taken using the same 
exposure values

Pan and shoot
It’s important that 
each shot overlaps 
by at least 50 per 
cent so that there 
aren’t any gaps when 
you blend them

Keep it level
A tripod will let you 
pan smoothly, but it’s 
important to make sure 
that the camera is level 
with the horizon first

Shoot vertically
Taking your photos 
vertically will allow you 
to capture much more 
detail both in the sky 
and the foreground
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Capture panoramas using 
your cameraphone

Smartphone 
panoramas

Most smartphones now offer a panorama 

mode, which means that shooting panos 

isn't just restricted to a DSLR. The panorama 

function is usually accessed through the 

phone's camera mode, though this may 

vary between makes and models. If your 

smartphone doesn't feature a panoramic 

mode, then don't worry as there are a 

number of panorama apps available on the 

market, which can be downloaded for a 

modest sum via the Apple App Store or the 

Google Play Store.

4: Lock the focus
Looking though the viewfinder, hover the active 

AF point over an object that’s roughly two thirds 

into the shot. Focus on this object, then switch the 

lens to MF.

5: Pan and shoot
Starting at the furthest left of your panorama, 

take a photo, and then pan to the right and take 

another shot. Repeat until you’ve captured the 

scene in its entirety.  

Avoid distortion

Using a focal length 
between 18mm and 35mm 
is suggested for panoramas, 
as shooting any wider than 
this can cause distortions 
and will also cause objects 
to appear smaller 

Panoramas with a compact
Some compact cameras feature a 
built-in panorama mode. The camera 
will prompt you to pan it across the 
scene and it will automatically capture 
the necessary images and stitch them 
together then and there
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1: Open up Photoshop
Once you have uploaded all of the images 

you want to use for your panorama, open 

up Photoshop and start off by heading to 

File>Automate>Photomerge.

2: Import your images
In the window that appears, click the Browse 

button and select your images before clicking 

Open. Make sure ‘Blend Images Together’ is 

ticked, then click OK. 

3: Merge the layers
Once Photoshop has finished creating your 

panorama, head to Layer>Merge Visible to 

crunch down all of the layers within the Layers 

palette into a single layer. 

Use Photoshop to digitally stitch together your imagesEdit your panorama 

Once you’ve got all of your shots in the bag, it’s 

time to upload the images onto your computer 

and get started piecing them together in order 

to create your final panoramic image. The good 

news is that if you own a copy of Photoshop or 

Photoshop Elements, then the editing process 

is largely automatic, as the software already 

comes pre-packed with a Photomerge function. 

This clever piece of kit is able to analyse each 

of your images in turn and work out how they 

should align with one another so that it can 

automatically stitch them together with just 

the click of a button. All you have to do is tell 

the software which images you want to stitch 

and then put the kettle on while it does all of 

the hard work! After that, it’s simply a case of 

tidying up the image to make it look its absolute 

best, ready to show off to your family, friends, 

and the world. 

To get started, follow our practical step-by-

step guide below. We’ll show you just how easy 

it is to stitch your shots together in Photoshop 

and tidy up the results to give your panoramic 

photo a seamless finish.

Learn how to digitally stitch together your images in 
editing software for flawless panorama results

Create your panorama 

Remember to save!

Don’t forget to save 
your work periodically 
(File>Save). That way, 
if anything untoward 
happens, at least you’ll 
have your work saved and 
ready to restore

Overlap frames
Each photo should 
overlap with the next 
so that there’s more 
to work with once you 
start to stitch them 
together in Photoshop

Crop to size
Don’t worry if you go a 
bit overboard with the 
number of photos in your 
panorama, as you can 
always crop it down later 
on in Photoshop

Before
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4: Trim the edges
Grab the Crop tool and click and drag out a crop 

across your panorama. Now, click and pull on 

the corner tabs to adjust the crop and trim off the 

rough edges. Hit Enter.

5: Fix any errors
If there are any areas between photos that haven’t 

joined properly, grab the Spot Healing Brush and 

brush over the affected area to allow Photoshop 

to correct the problem.  

6: Boost the colours
Head up to Image>Adjustments>Hue/Saturation. 

Click where it says Master and change it to 

Yellows, then set Saturation to +25. Do the same 

for the Blues channel.

Gain more control over your 
pano using apps

Edit panoramas 
on your phone

As most built-in panorama shooting 

modes are fully automatic, you inevitably 

don't have much control over the way 

the final image is constructed. However, 

there is a handful of apps available for 

download that give you more precise 

control over the way your panoramas are 

constructed for more advanced results. 

After

Finished image
Once you’ve successfully 
merged all of your images 
together in Photoshop, your 
panorama is complete, ready 
for it to be shown off in all its 
glory to family and friends

Intense colours
Shooting your panorama 
at sunset will paint the 
sky with colours, which 
can then be intensified 
in Photoshop to become 
even more eye-catching

Centre of focus
It’s always best to have 
some key features in 
your panorama; we’ve 
included a church on 
the right, a jetty on the 
left, and a central sunset

Heal imperfections
Although Photoshop will 
generally do a good job 
of joining your images, 
you can easily fix 
mistakes with the Clone 
Stamp or Healing Brush 

Before
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H
ave you ever looked upon an impressive vista, 

only to whip out your camera, take a shot and 

be disappointed by the image on the back of the 

screen? Well, the reason for this is that all digital cameras 

have a much lower dynamic range than the human eye. If 

you’re unfamiliar with the term, this simply refers to the scale 

between what the camera records as the lightest and darkest 

points within a scene. When it is faced with a scene that 

features both bright highlights and deep shadows, it has to 

make a choice as to whether it favours the exposure toward 

the shadows or highlights. Luckily there’s a technique 

known as high dynamic range (HDR) that allows you 

to take multiple shots of the same scene and then 

merge them.

Discover how to capture high dynamic range images with our easy-to-follow guide

Tips|Tricks|Fixes

Master HDR
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Essential kit 

Camera or cameraphone
A DSLR or CSC is the best choice, as they 

allow full manual control. However, some 

compacts and cameraphones do offer a 

HDR mode.

Sturdy tripod
A sturdy tripod with an adjustable head is a 

must, as you’ll need to ensure that each of 

your exposures are taken in the same spot.

Adobe Photoshop
There are a number of HDR software 

packages on the market, but Photoshop 

comes with its own HDR processing 

feature built in.

Before

By merging together three or more images that 

have been taken at different exposures, you can 

create a HDR image that features a broader range 

of tones than a normal photograph
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2: Use Aperture Priority
Switch to Aperture Priority. This will allow you to 

control the aperture while the camera takes care 

of the shutter speed. 

1: Use a tripod
Make sure that your camera is kept in the same 

position for each of your three exposures by 

setting it up on a tripod.

3: Set a small aperture
Dial in an aperture of f11 to ensure the scene 

stays sharp from front to back, then activate 

Continuous Shooting mode.

Capture incredible HDR 

The secret to any good HDR image is 

having a suitable subject to begin with. 

Although in theory you can use HDR with 

just about any subject, architecture and 

landscapes will generally lend themselves 

much better as they often feature a broader 

range of highlights and shadows, as well 

as a healthy level of texture and fine detail. 

If you’re not sure as to whether a scene will 

work as a HDR image, try taking a single 

test shot – if, when you review the shot, you 

find that your camera has been unable to 

record all of the detail in either the darkest 

shadows or the brightest highlights, then 

there’s a good chance it’ll make for a good 

HDR shot. 

Revealing the highlights
In order to capture the details 
within the brightest areas of 
the scene (mainly the sky), this 
shot had to be intentionally 
underexposed. However this 
has caused the church and 
foreground area to be cast in 
dark shadow

Capturing the midtones
This image was correctly 
exposed and has captured the 
majority of the detail within the 
midtones. The downside is that 
some details have been lost in 
the brightest areas of the sky 
and in the deepest shadows 
around the church windows

Choose the right settings and take your shotsTake multiple exposures

Enhance your images with more detailed highlights and shadows
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HDR 
with your 
smartphone
Some smartphones offer a HDR 

feature as standard. Simply turn on 

the camera and make sure that the HDR 

function is activated. Then, frame up, focus 

and take the shot. Your smartphone will 

then instantly capture a series of different 

exposures and merge them together to 

form a single HDR image.

5: Lock the focus
Focus on your subject by half-pressing the shutter, 

then set to Manual Focus to stop the camera 

refocusing. Take the shots. 

4: Activate bracketing
Bracketing allows you to take multiple exposures 

consecutively. Set it to -1, 0, and +1 stops of 

exposure compensation. 

Exposing for the shadows
This shot has been purposely 

overexposed in order to capture the 
shadow details on the side of the 

church and in the foreground. As a 
result of this, the sky has become 

burnt out and has lost most of its detail
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3: Increase the edge glow
In the new window that appears, start by locating 

the Edge Glow options at the top and increase 

the Radius slider to around 50px, and the 

Strength slider to 1.00. 

1: Open Photoshop
Open up Photoshop and start off by going up to 

the option bar at the very top of the screen. Then 

click File>Automate>Merge to HDR Pro. 

4: Adjust the exposure
Under Tone and Detail, adjust the Exposure slider 

if you need to – for our image, we decreased this 

by -.050 in order to bring back some highlight 

detail in the sky.

2: Load your images
In the window that appears, click Browse, then 

select the exposures that you want to use; click 

Open. Once you’re done, click OK to continue. 

5: Increase the detail
Now, move the Detail slider to around 50% to 

intensify the fine detail in your image. You can 

always move the slider further to the right for more 

exaggerated results. 

As we’ve already touched on previously, 

shooting the images for your HDR shot is 

just half of the process. It’s only when you 

start to blend all of your shots together on the 

computer that your HDR image really comes 

to life. However, doing this requires the use 

of a special piece of HDR software that’s 

able to analyse each of your exposures and 

successfully blend them together to create the 

final image. There are a number of standalone 

software packages currently on the market that 

are able to do this, although if you already own 

a copy of Photoshop then you’re in luck, as this 

has a HDR processing feature built in that is 

ready to use. 

To discover how to use this software 

package, be sure to read our step-by-step 

tutorial below. This will run you through how to 

merge your images together and then enhance 

them to create a truly stunning HDR photo.

Blend your photos together in Photoshop for stunning results

Get busy in PhotoshopMerge and enhance

Editing your HDR images

Before
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Our fi nal HDR image is able 

to reveal a much greater 

amount of detail throughout 

the image compared to a 

normal photo, especially in 

the brightest highlights and 

darkest shadow areas

You can take your HDR photography one 

step further by giving it a hyper-real look. 

Hyper-real simply refers to a HDR image that 

has been over-processed, and the result of 

which makes the image appear saturated with 

intense colours and increased contrast while 

maintaining a high dynamic range. 

Hyper-real HDR

6: Shadow and highlight
At the bottom of the screen, move the Shadow 

slider right to around 25% to brighten the 

shadows, and the Highlight slider left to -10% to 

bring back highlight detail. 

7: Boost the colours
Finally, increase the Vibrance slider to around 

80% and the Saturation slider to 20% to really 

give the colours a boost. Once you’re happy, 

click OK to confirm the changes.
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P
hotography is all about capturing light, 

and having good lighting can turn an 

average shot into an incredible one. 

This is even more important when it comes to 

portraits, as bad lighting can be unflattering 

to your subject – think about the times you’ve 

resulted in shots with your model squinting in 

the Sun or where their features are in harsh 

shadows. In this guide, however, you’ll learn 

some amazingly simple tricks that you can use 

to rectify common problems. 

We’ll kick off the tutorial by showing you a 

step-by-step to getting fantastic shots using 

just natural light. When working with the light, 

we advise you to invest in a reflector to help 

with these kind of shots, as you can pick up 

some extremely cheap ones online. A reflector 

can do marvellous things to your images, but 

if you don’t want to buy one just yet, using a 

large piece of white cardboard will help to push 

some light back towards your subject to create 

flatteringly lit images. 

Next up we show you how to master indoor 

shots by using your camera’s flash. There are 

some simple modes you can set that will help 

to create a more even spread of light, and you 

can also soften your flash using our DIY project 

where we show you how to turn a milk bottle 

into a flash diffuser!

Follow along with these tutorials and you’ll 

soon start mastering lighting in your portraits, 

capturing excellent shots whether indoors or 

outside, no matter the conditions

Put window light to good use

Use natural light indoors by positioning 
your subject near a window. You 
may need to use your flash to fill in 
shadows, especially if their back is to 
the light

Discover portrait 
lighting secrets
Discover how to fill in harsh shadows and create a truly flattering look in your portrait shoots
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Use the shade
On sunny days, 
position your model 
in the shade for more 
flattering light

Fill in with flash
Even when using natural 

light, adding in some light 
using your pop-up flash 

can help to fill in any harsh 
shadows on your subject’s 

face for a more even look
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Work with natural light

Make the most of soft natural light by shooting your next portrait 

outdoors. You’ll find plenty of vibrant backdrops outside, even 

during the winter months. What’s more, a simple setup is all 

you need for great shots; just your camera and an affordable 

reflector will suffice.

Don’t forget to check the weather beforehand and wrap up 

warm, even on a dry day. To get the best results outdoors, 

you’ll need to pay particular attention to the position of the 

Sun. If there’s little cloud cover, avoid squinting portrait shots 

by positioning your model in front of the Sun, or alternatively, 

shoot in open shade. A reflector will come in handy for filling in 

pesky shadows that fall on the face. Don’t forget to experiment 

with your camera settings too. Portrait mode is ideal for 

inexperienced beginners, but switching to Aperture Priority 

will give you much more creative control, as you will see in our 

handy step-by-step guide.

Take better portraits outdoors using a 
simple setup and the Sun

Put the Sun behind them
By repositioning your subject so 
the Sun is behind them, you will 
stop them squinting at the light. 

Bounce some light back in using 
a reflector to fill in shadows on 

your subject’s face for a
more even look

Harsh sunlight 
causes squinting
If the Sun is facing 
your model, it can 
cause them to 
squint, resulting in an 
unflattering shot. 
It can also produce 
harsh shadows too

Working with kids

If you’re photographing children, 
always ensure you shoot at their 
level to get flattering photos straight 
on. Keep them engaged by talking 
and showing them some of their 
shots between takes



Tips|Tricks|Fixes

Photography Tips, Tricks & Fixes  45

3: Adjust white balance
You can now fine-tune other settings in camera, such as ISO and white 

balance. As you’ll be shooting outside in bright natural light, your ISO setting 

can be kept low to prevent noise from appearing in your shots. Set it to 

around ISO 200. Changing your white balance will also help eliminate colour 

casts from appearing in your images. Select the White Balance tab in the 

camera menu and then scroll through to the Sun icon, which represents 

natural light.

1: Use a reflector
Working with natural light can be really challenging, so ensure that you 

position your model correctly, ideally with the Sun behind to avoid any 

squinting shots. Use a reflector to bounce the light back into the model’s 

face for an even exposure with minimal shadows. You could use a piece of 

white card if you haven’t got a reflector yet, but it’s a useful bit of kit to buy. 

4: Focal length and focusing
Using the correct focal length on your lens is extremely important too. Wide 

focal lengths (18-35mm) can distort facial features, so zoom in to around 

75mm for a more flattering effect. If you’re using a standard kit lens however, 

55mm will also suffice. Zoom in or out using your feet once everything is 

set to avoid re-adjusting the focal length. Once you’ve posed your model, 

position the focal point over their eyes to ensure a pin-sharp result. If your 

camera offers a Face Detection focusing mode, use it, or position the 

single AF point over the model’s face and wait for it to lock focus before you 

release the shutter.

2: Set your aperture
Select the Portrait scene mode on your camera’s mode dial, or take more 

control over your settings – and the final image outcome – using Aperture 

priority mode (A or Av), which lets you select your preferred aperture. Wide 

apertures (small f-numbers) are great for softly blurring out distracting 

backgrounds and isolating your subject so that they appear as the focal 

point within the frame. Set your aperture between f3.5-f4.5 for the best effect 

– your camera will determine the correct shutter speed for you. 
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Bounce the flash
Invest in an adjustable speedlight for better 

portraits indoors. Avoid face-on flash by rotating 

the head and bouncing the light off the ceiling.

Fill in with flash 
Use natural light by shooting next to a window. Fill 

in the shadows on the model’s face using your 

flash, which will make for an even exposure.

Flash is a versatile tool in photography 

and can be used at home or on location to 

improve lighting. Explore your camera’s flash 

settings now and start experimenting on 

your next portrait shoot for more creative and 

accomplished lighting effects. 

Flash techniques
Start taking better portraits both 
indoors and out using your 
camera’s flash with our tips 

Softer light
Set your camera’s flash to slow-sync if 
you want to incorporate ambient light 
in the background. Diffusing the flash 
will also help to soften its effect

Light diffusion
Position a white piece of 
paper over the flash as 
quick fix to help diffuse the 
light, or create a re-usable 
DIY diffuser by following our 
step-by-step guide
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Create a DIY flash diffuser

4: Position the diffuser
Trim the edges of the diffuser so that it’s 

neater. You can now shoot with your improved 

flash and get softer, more flattering results.

2: Cut through the seam
Cut the entire handle off from top to bottom. 

Now carefully cut through the back seam 

where the handle curves so that it opens out. 

3: Pop up the flash 
Turn on your camera and press the flash icon 

on the side to pop up the built-in flash. The 

handle should fit securely over the flash head. 

1: Clean the carton
Take a large, empty milk carton and ensure 

you’ve washed it thoroughly. The opaque 

plastic is perfect for diffusing flash. 

High-key effects
Position your model in front of a window and use 

a wide aperture. Use a slow-sync flash to fill in the 

foreground shadows for a high-key effect.

Lighting at night
Avoid harsh outdoor lighting by using the same 

flash mode you would indoors, but set to slow-

sync. You’ll capture a soft ambient glow.

Soften your flash

A lack of good lighting can spell disaster on 

a portrait shoot and nothing can be more 

difficult than taking a good, even exposure 

indoors. Low light can cause all sorts of 

problems, from underexposed shots to 

overly grainy images. Fortunately, most 

cameras come armed with a built-in flash. 

Using the right settings, you can capture 

beautifully illuminated portraits indoors and 

out. Avoid sticking it straight to auto, which 

will bleach skin tones and create harsh 

contrast and shadows over your subject’s 

face. Explore the flash menu and get to 

grips with settings such as slow-sync. With 

this mode you’ll be able to fill in shadows 

on the face with flash and still capture some 

warm ambient light in the background by 

using a slower shutter speed.

Indoor flash portraits
Discover how to fill in shadows and create a soft, even portrait

Harsh flash
Using your pop-up 
flash directly onto 
the model without 
diffusing it results in 
a harsh look
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Shooting up 

close can help 

you reveal 

hidden details
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L
ooking at objects up close can reveal 

fascinating details that you might 

otherwise miss, and this is one of 

the reasons why macro photography is so 

interesting. It involves shooting extreme close-

ups to make your subject appear life-sized or 

larger in your photos, and it works with almost 

any subject. Natural subjects such as flowers 

and insects are perhaps the most popular 

macro subjects, as they often have intricate 

details and patterns that reveal the beauty of 

nature. However, everyday items make great 

subjects too, just look for something with small 

details or an interesting texture that will look 

striking up close. 

You don’t need a kit bag full of expensive 

equipment to take fantastic macro photos 

either, as a trusty compact or even a 

cameraphone is capable of taking great close-

ups. However, if you want to start taking macro 

more seriously, then you might wish to invest in 

an accessory that will allow you to focus even 

closer to your subject. Over the next few pages, 

we will show you different pieces of macro kit 

to suit any budget, plus a few DIY solutions that 

you can try for free. You will also learn the best 

camera settings for macro and some close-up 

compositional techniques to make your shots 

really dynamic. Finally, we will show you some 

fun macro projects that you can try at home to 

produce really creative results. 

So grab your camera, find yourself a suitable 

subject, and let's get shooting!

Shoot impressive close-ups on any camera... 

What’s good about it…
A smaller and lighter camera is easier to 

manoeuvre, which helps when shooting from 

awkward positions.

What could be better…
There’s a smaller selection of macro kit available 

as they are a relatively new breed of camera.

What’s good about it…
Macro mode does all the hard work for you, 

making these cameras ideal for beginners.

What could be better…
The minimum focusing distance varies greatly 

between models and can often be quite 

restricting on cheaper cameras.

What’s good about it…
You always have it with you, and you can share 

images straight from the device.

What could be better…
You’ll need a clip-on accessory to get proper 

macro shots, as cameraphones usually can't 

focus all that close.

Taken on a…
CSC

Taken on a…
Compact camera

Taken on a…
Cameraphone

Discover how to take fantastic macro close-ups with any camera in our beginners’ guide

Capture 
incredible close-ups
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You don’t need to spend a fortune to be able to take stunning 

macro photos. Almost every digital camera, from compacts to 

DSLRs, now features a Macro mode that will help you shoot 

up close. Their effectiveness will differ from model to model, 

but for the best results look for a camera or lens with a very 

small minimum focusing distance, preferably 5cm or smaller. 

However, if you have the money to spend, then there are lots of 

different accessories that you can buy to improve your camera’s 

macro abilities. You may also need a few standard items of 

photography kit to help you too, so let us show you how to 

prepare your kit bag and start shooting right away. 

Essential 
macro kit
Gear to suit any budget

Camera type 

You can capture detailed 
close-ups using any 
camera, including a 
cameraphone. Simply 
select the Macro mode 
setting to get started

Lens
Invest in a specialist 
macro lens or check 
other optic options 
across the page

Sturdy tripod
A tripod will help to keep 
your camera steady for 
sharp macros shots. One 
with a short minimum 
height will help you get 
close to tiny subjects
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Macro lens  

A macro lens is the premium 

option for macro photography. 

It has a short minimum focusing 

distance, which gives you 

full access to your camera’s 

functions. They are available in 

a variety of focal lengths, but 

between 50 and 100mm will 

let you keep your distance and 

avoid blocking out any light.

Price: Approx £250/$280

Extension tubes  

These slot between your 

camera and lens to reduce the 

focusing distance and allow you 

to shoot closer up. You can use 

just one or fit several together. 

However, as you are increasing 

the length of your lens, less light 

will reach your sensor, so you 

need to adjust your settings to 

record more light. 

Price: Approx £150/$200

Close-up filter

Close-up filters screw onto 

your lens to help magnify your 

subject. They are available in 

different levels of magnification, 

or as sets that allow you to 

use several filters at once. As 

you are adding another piece 

of glass in front of your lens, it 

will reduce your image quality 

slightly, but it’s still effective.

Price: Approx £20/$30

Reversing ring

A reversing ring lets you mount 

your lens onto your camera 

backwards, allowing you to 

shoot from a shorter distance. 

However, you will be unable to 

control your aperture unless 

your lens has a manual aperture 

control ring, plus you can only 

focus by physically moving the 

camera and lens in or out. 

Price: Approx £10/$16

Capture detailed 

close-ups with 

the right kit

Phone macro

The best thing about 
taking macro shots with 
your phone is that you can 
get it into small places to 
shoot in awkward positions. 
Experiment with angles to 
see what shots you can get

Reflector  
A reflector will allow you 
to bounce light into any 
shadows for a more even 
coverage, and can also 
be used to shield your 
subject from the breeze 

Close-up photography optics
Check out the best kit options for macro
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Find interesting objects
Any object that has interesting patterns or textures works well for macro. If 

you head indoors, find a bright window with plenty of natural light. If you’re 

outdoors, move into the shade to prevent distracting shadows from the Sun.

Photograph flowers
If you want to shoot flowers outside then it is best to do it late in the afternoon 

when the Sun is lower in the sky. This will create a softer, golden light for your 

photos, making the shadows less defined and distracting.

Midday PM

Great macro photography subjects are everywhere, so you’ll 

always have the opportunity to practise your skills. Whether 

you’re shooting in the great outdoors, or staying inside on a 

rainy day, you will find no shortage of objects to shoot up close. 

Flowers and insects are a firm favourite for macro, but don’t be 

afraid to get creative and see what else you can find. 

Different times of day are best for shooting particular things, 

so it is good to have a plan for your shoot. For a start, you’ll need 

to consider the lighting so that you can keep your shots bright 

and evenly exposed. Then you’ll need to find out the best places 

to look to track down your macro subject. 

Lighting your   
close-ups
Discover what to shoot and when to 
shoot it for the best light
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The light from your flash can be quite harsh, particularly when shooting subjects up close. 

However, if you can’t rely on natural or continuous artificial light, then your flash may be 

essential for producing a bright shot. If you can afford one, then a ring flash system will 

help to create a more even coverage of light, but if you’re on a budget then a simple flash 

diffuser will do. You can even have a go at making your own from a crisp tube, tape and 

some tracing paper.

Look for insects 
Insects are most active early in 
the morning, so this is the best 
time of day to find them. Look 
for colourful flowerbeds where 

they will be feeding on the 
pollen, and hopefully staying still 

long enough for you to shoot. 
As they can be fast-moving, 
you might want to switch to 

Continuous Autofocus in order 
to keep them sharp in your shot.

You can also create a 

diffuser for a fl ashgun, 

simply cut a larger 

hole in the tube

Always check your shots on the back 

LCD screen so you know whether you 

need to adjust your camera settings

1: Create a hole
Take an empty crisp tube and wash 

it out. When it is completely dry, 

cut a small hole in the side for your 

flash to poke through. You’ll need 

to work out the best place to cut 

the hole so that the tube sits on top 

of your lens, rather than hanging 

down in front of it and potentially 

blocking your shot.

2: Cut the tracing paper 
Draw around the end of the crisp 

tube on some tracing paper and 

then cut out three or four circles. 

You can then stick these on the 

inside of the tube lid in order to 

help diffuse the flash. For an even 

softer lighting effect, stick several 

circles of tracing paper on top of 

each other.

3: Fix it to the flash 
Pop up the built-in flash on your 

camera and then place it into the 

hole you cut out of the tube, resting 

the tracing paper end above the 

top of the lens. Remember you 

will need to use Live View mode in 

order to take your photograph, as 

the end of the tube will block the 

optical viewfinder.

AM

Create your own flash diffuser
Soften your camera’s flash on a budget

Using flash

If the light is low indoors or 
out, you may need to use 
flash. Avoid harsh shadows 
and blowing out the details 
by creating your own 
diffuser, or put tracing paper 
over the flash
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Shoot from below 
It’s easy to forget that shooting from below can produce 

great images too, so make sure you experiment with all sorts 

of creative angles. Shooting from a low angle may mean that 

your shot is backlit, so you may need to fire your flash or use 

a reflector to bounce the light back into the shadowy areas.

Get creative with unusual angles for 
striking shots

Composing macro photos is really quite easy, as the 

main thing you need to remember is to crop in close. If 

you leave too much space around your subject, then it’s 

likely that you’re not shooting up close enough, so move 

in further until your subject completely fills the frame. 

There is still some scope to make your shots even more 

engaging though, as shooting from creative angles is key 

for producing striking shots. Once you have taken one 

shot, don’t just pack up and call it a day; make sure you 

move around and see what different compositions you 

can produce. It’s likely that you’ll be able to shoot several 

great images of one subject, so take your time and don’t 

be afraid to experiment.

Master macro 
composition 
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Shoot 
from above 

If you’re taking your 

photo from above, avoid 

positioning your subject 

in the centre of the 

frame. Instead, use the 

golden spiral technique 

and position the most 

important part of your 

subject in the corner of 

the shot. This will create 

a more engaging photo 

that draws the viewer’s 

eye through the frame. 

Go abstract 
Including just a section of your subject in the frame 

can create a fantastic abstract shot. Get in close and 

focus in on intricate details and patterns. This is a 

great way to show your subject in an original way and 

leave the viewer guessing about the bigger picture.  

Top framing tips
Ways to compose close up

1: Simple backdrop 
As you want your subject to be the main point 

of focus in your shot, remove any distractions 

in the scene. You can add your own backdrop 

using a piece of coloured paper or card.

2: Add interest
For an unusual perspective, try introducing 

another element. You could submerge the 

subject in fizzy water to create bubbles, or add 

individual droplets of water to create texture.

3: Include leading lines 
To guide the viewer through your shot, look for 

lines that lead towards your subject. This could 

be as simple as the petals or stem of a flower 

that you can follow to the main point of focus.

4: Patterns & symmetry  
Including patterns and symmetry is very 

effective in macro photography. It’s easy to find 

these elements in everyday objects, so hunt 

around to see what you can find.

5: Crop in later 
You can always crop into your shot later with 

editing software. This will also allow you to 

recompose your overall shot to perfect the 

position of your subject.

Use the LCD

Using your viewfinder 
when shooting from 
unusual angles can be 
tricky, so framing shots 
using the LCD monitor is 
much easier for getting into 
more awkward positions



Focusing close up
Which focusing mode works best?

Manual focus Autofocus
If your camera has Manual Focus, 

then this is the best option to use 

for macro photography. Autofocus 

can sometimes struggle when you’re 

shooting up close, so doing it yourself 

will allow you to be more accurate. You 

just need to twist the focus ring around 

your lens until you see your subject 

become sharp. It is a good idea to 

check your shot after you’ve taken it 

and zoom in to make sure it is in focus.

If you can’t focus manually, use 

Selective Autofocus instead. Position 

the focus point over the part of your 

shot you want to keep in focus, then 

half-press the shutter button to lock 

the focus onto it. If your camera is 

struggling to focus then you may need 

to move further back to its minimum 

focusing distance. Some cameras 

have a dedicated Macro Focus mode, 

so check to see if you have it.
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Discover the best 
settings for your shot

Often the secret is knowing the best way to 

set up the shot, as many cameras have a 

dedicated Macro mode that does all the hard 

work for you. It might be hidden within the 

camera menus, or it might have its own place 

on the camera body, represented by a flower 

symbol. However, if you’re using a macro lens 

or other macro accessory, then you can start 

to explore your camera’s manual functions for 

more control over the look of your images. 

However, the most important macro technique 

is focusing your shot, as this can be notoriously 

difficult when shooting up close. 

Manual vs 
Auto mode 
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Wide aperture
Using a small f-number (from f1.8 to 

f8 depending on your lens) will mean 

that only a small section of your photo 

is in focus. The area you choose to 

focus on will stay sharp and anything 

in the foreground and background will 

appear blurred.

Narrow aperture
If you choose a large f-number, 

anything between f8 and f22, then a 

large portion of your photo will be in 

focus. However, when shooting up 

close with a macro lens you are likely to 

still get a bit of background blur, even 

when using a large f-number.

Depth of field explained
How aperture blurs distracting backgrounds

Controlling your aperture will allow you to decide how much of your 

shot you keep in focus. A wide aperture (small f-number) will create 

a shallow depth of field, which blurs the background of your shot, 

leaving just a small section of your subject sharp. If you increase the 

f-number to narrow your aperture, you will start to see more and more 

of your subject come into focus. If your subject is filling the frame, you 

may need to use a relatively narrow aperture (large f-number) in order 

to keep the whole thing sharp. Macro mode is likely to automatically 

set quite a wide aperture for you, but if you’re venturing into manual 

modes then Aperture Priority is a good place to start. This lets you 

pick the aperture while your camera takes care of the shutter speed 

setting for you.

Switch to Manual
If you’re shooting in 

manual modes with a 

macro lens, pick a narrow 

aperture (large f-number) 

to increase your focus 

area. If you’re shooting 

handheld or your subject is 

moving, set a fast shutter 

speed to keep your shots 

sharp. Set your ISO to its 

lowest value and only raise 

it if your shots are too dark.

Use Auto  
If your camera 

doesn’t have 

manual modes, 

or if you’re not 

confident enough 

using them, you 

can use the 

automatic Macro 

mode instead. This 

will reduce your 

camera’s minimum 

focusing distance, 

allowing you to get 

closer than normal 

to your subject. 
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Texture’s best

Textured surfaces look 
great in black and 
white, as they help 
to create depth and 
interest. When shooting 
a vista, include some in 
the foreground
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Create your best-ever monochrome masterpiece with our simple steps for shooting 
and editing your captures, from portraits to landscapes

P
hotography is a fantastic way to 

capture scenes in unique and creative 

ways, and one of the most popular 

techniques for this is to remove colour from 

your shots. Black and white photography gives 

you an entirely new perspective on the world, 

as without colour you are encouraged to pay 

attention to the textures, details and patterns 

that you may have otherwise overlooked. It can 

also help to enhance the scene, softening skin 

tones for flattering portraits and making cloudy 

landscapes look more dramatic. Of course, 

back in the early days of film photography, 

you had no choice other than to capture the 

scene in black and white. But now that we are 

used to glorious technicolour, it can be tricky 

to go back to a world without colour. Luckily, 

the wonders of today’s image editing software 

make it easier than ever to convert your 

precious photos to black and white, with some 

programs allowing you to remove the colour 

with just one click.

Creating stunning black and white photos 

really is a lot easier than it looks, and over the 

next few pages, we will show you exactly how 

to get started. Discover the simple steps to 

shooting perfect images that will look even 

better without colour, learn what to look for in 

a striking black and white scene, and master 

artistic monochrome styles to produce truly 

creative shots. Finally, we will show you the 

best way to transform your colour snaps into a 

classic black and white masterpiece. 

Ultimate 
guide to black & 
white photography 
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1: Shoot in RAW
If your camera will let you shoot in the RAW file 

format, use it so that you will have lots more 

control when editing your shot and converting it to 

black and white.

When shooting an image to convert to black and white, you should follow the same rules that 

you would for taking a regular image. Make sure that the exposure is correct, with plenty of 

detail throughout, and that your subject appears perfectly pin-sharp. If your camera doesn’t 

have manual modes, or if you’re not confident enough to use them, then stick to auto or 

explore your scene modes to take the perfect shot. However, for more control over your 

images, use a manual or semi-manual mode. Aperture Priority mode is a good place to start 

as it will take care of the shutter speed for you. All you have to do is set a wide aperture (small 

f-number) if you want to blur the background, eg for portraits, or a narrow aperture (large 

f-number) to keep everything in focus, eg for landscapes.

Simple steps to black and white
How to set up and shoot an image fit for monochrome
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2: Instant effects
Most digital cameras have built-in black and white filters that allow 

you to shoot without colour. These are great for previewing the 

monochrome effect to see what your shot will look like, but make 

sure that you take your final shot in colour. This will allow you to have 

much more control when you convert your shot later, plus you’ll 

have a coloured version as a backup, just in case you decide that 

you don’t like it in black and white. Some cameras will let you take 

a coloured and monochrome version simultaneously, so you’ll have 

one that’s ready to share straight away, and one that you can take 

time editing yourself.

4: Correct exposure 
Achieving the perfect exposure 

is particularly important for 

black and white images. Dark 

shadows and blown-out 

highlights will be even more 

obvious when the colour 

is removed, appearing as 

featureless areas of plain black 

or bright white in your photos. In 

auto and semi-manual modes 

your camera will expose your 

shots for you, but if you’re not 

happy with the results then 

there is an easy way to override 

it. Exposure compensation 

lets you easily brighten up or 

darken your shot with a simple 

scale for instant results.

3: Control grain 
When shooting in manual and semi-manual modes, you will have full control over your 

camera’s ISO settings. This lets you adjust the image sensor’s sensitivity to light, with 

a higher value increasing the sensitivity for brighter shots. However, high ISOs also 

reduce the quality of your images, creating a grainy effect. This can look quite effective 

if you want monochrome images with a grittier or old-style look, but for crisp, detailed 

shots, try to keep your ISO as low as possible.

High ISO values will make your 

images appear noisy, with digital 

grain that can sometimes look 

stylish in black and white.

For the best quality shots, set your 

ISO to the lowest value possible to 

avoid any digital grain.

A well-exposed image should 

have plenty of detail throughout, 

but don’t avoid shadows 

completely as they will add 

necessary contrast and depth 

to your shots.

 

Setting your exposure compensation to a negative 

value will allow you to rescue overexposed images 

with missing detail.

 

To brighten up photos with detail lost in dark 

shadows, set your exposure compensation to a 

positive value to brighten it. 

Perfect exposure

Correct underexposed shots

Fix overexposed photos

Smooth quality

Grainy shots



Tips|Tricks|Fixes

62 Photography Tips, Tricks & Fixes

You can produce brilliant black and white shots 

with almost any genre of photography, from 

landscapes and portraits to wildlife and still life. 

However, there are certain things you should 

look for to ensure your captures look truly 

striking without colour…

Look for contrast 
Contrast between shadows, highlights and the 

different colour tones in your image will help 

separate the different parts of an image when 

there’s no colour.

Find patterns 
Striking patterns will look just as engaging without 

colour as they naturally feature contrasting colours 

and shapes. Look for patterns that catch your eye 

and see what they look like in monochrome. 

Considering the composition of your photos is even more important 

when shooting for black and white. Without colour to grab people’s 

attention, you will need to use other methods to make your shot 

more engaging. Firstly, you need to think about what you are 

including in the frame, as certain subjects won’t work particularly 

well for black and white. Then you also need to decide how to 

position your subject within your photo to make it as interesting as 

possible. Look for natural lines that guide the viewer through your 

shot, and position your main subject a third of the way into the frame 

for more impact. You’ll also need to consider colour tones to control 

the look of your images. 

Capture 
striking scenes
Create monochrome images with plenty of impact

Choosing 
monochrome 
subjects
What to look for when 
deciding what to shoot

Dull vistas
Avoid shooting plain blue 
or bright overcast skies, 
as they will just appear as 
a large expanse of grey 
or white in your shots
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Search for textures 
Smooth, flat surfaces can look quite dull without 

colour, so look for textured surfaces with more 

depth. Animal fur, tree bark and rope all make 

great monochrome subjects for this very reason.

Keep it simple 
Simplicity is usually key for black and white shots, 

as cluttered scenes make it difficult to pick out the 

main subject when not highlighted by colour. Less 

is more, so don’t include too much in the frame.

Stormy skies
Cloudy skies look really 

effective in black and white 
as they have plenty of 

contrast, which makes for a 
more dramatic image

Colour adjustments
Enhance specific tones by attaching coloured 

filters to your camera, or by adjusting the tones 

individually with editing software.

Green filter 
To darken red and blue tones and boost the 

contrast between the green hues in a photo, 

increase the greens with a filter or by editing. 

Blue filter 
An increase in the blue tones will make reds 

and greens appear darker but also brighten up 

blues, leaving cloudy skies lacking contrast. 

Red filter 
Boosting red tones will not only lighten red 

subjects, but will also darken blue and green 

tones for more contrast in the land and sky. 

FiltersColour tones
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High-key photos are generally very bright, 

with plain white backdrops and very few 

areas of shadow. This style of image is not 

reserved for black and white photography, 

but due to the abundance of white in the 

frame, it looks particularly effective without 

any colour at all. Typically used for shooting 

portraits and still life, high-key photography 

requires you to overexpose the background 

of your shot. Position your subject against 

a bright background with the light behind 

them, then switch to Aperture Priority mode 

and use a small f-number to ensure that 

your camera captures as much light as 

possible. If the background of your shot still 

doesn’t look completely overexposed, set 

your exposure compensation to a positive 

value to brighten it up even more.

There is a lot more to black and white photography 

than simply removing the colour from your shots. 

The genre has its own set of creative styles that 

can each give your images an entirely new look. 

Re-creating these effects can really help to 

enhance your images and complement your 

subject, adding more impact to make your 

photo really stand out from the crowd. 

There are lots of different monochrome 

styles to experiment with, but here 

we will show you some of the most 

popular. Some can be achieved 

in-camera, but others will require 

a bit of editing to achieve perfect 

results. So grab your camera 

and computer and get 

ready to try out some of our 

creative projects. 

Monochrome 
styles
Achieve classic black and white 
effects for artistic images

Stunning high-key
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Dramatic low-key
Low-key involves shooting against a dark backdrop with lots of 

shadows in your images. It can help you produce some really 

dramatic and moody-looking portrait and still-life shots, and works 

well for black and white images. You’ll need to shoot in a dark 

environment, either outdoors at night or in a dark room, and use a 

single light source to illuminate your subject. Experiment with the 

position of the light source to create striking shadows across your 

subject. Lighting from the side typically works quite well, as it will 

leave half of your subject in darkness.

Add some colour 
You don’t have to completely remove the colour from your photos to 

produce a striking image. Colouring one subject back in, or bringing 

back one colour tone can look really creative and lets you draw 

attention to a particular detail. Some cameras have built-in selective 

or partial colour creative modes to achieve the effect in-camera, but 

editing your images yourself will give the best results. You could 

select everything apart from your subject and then remove colour, 

but for more intricate subjects there’s a more effective method.

Old-fashioned feel
As well as creating stylish and modern monochrome images, black and white also 

lends itself to producing photos with an old-fashioned feel, just like those taken with 

early film cameras. To achieve this look, don’t be afraid to shoot with a high ISO value 

to create a grainy effect and then slightly reduce the contrast in your image when 

removing the colour for a faded look. To really re-create the appearance of an old 

photo print, add a sepia effect and apply a vignette by darkening the outer edges of 

your shot. 

Many editing programs and apps have retro 

effects that you can apply instantly, or you can 

adjust the colour tones to do it yourself.

1: Duplicate 
the layer
Open your 

image and go to 

Layer>Duplicate 

Layer. Convert the 

top layer to black 

and white and then 

add a layer mask in 

the Layers panel. 

2: Colour it in
Select the Brush 

tool then set the 

colour to black 

and the Opacity 

to 100%. You can 

now go on to paint 

over your subject to 

reveal the coloured 

layer underneath. 

Apply a sepia effect

Before
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Discover the ingredients needed to 
become a first-class food photographer

N
othing appeals to the senses quite 

like food photography. Not only do 

final images need to cook up visual 

splendour, but should also transmit the 

feelings, textures, colours and even scents of 

the dishes too. 

Thanks to the revolution in blogging and 

smartphone cameras, there are now millions 

of images of perfect, square-cropped images 

of breakfast, lunch and dinner out there. Of 

course, it’s more important to know how to 

use your equipment than to have the most 

expensive camera model, but we’ve got plenty 

of handy kit suggestions to help you tuck in.

A professionally curated photo of a meal can 

make the senses go wild, but you need plenty 

of experience and skill to create the most lip-

smacking results. Understanding the qualities 

of different light sources is crucial for success, 

and in this feature we’ll look at how you can 

use both artificial and natural light to flatter the 

subject at hand.

Most photographers love shooting this genre 

because they’re passionate about food. Read 

on to discover the tricks of the pros and find 

out how they transform lifeless subjects with a 

few subtle techniques.

While this might be the fastest growing 

genre in the digital age, there’s a lot more 

to consider than just quickly snapping your 

plate and moving on. Over the next few pages 

we’ve rounded up the best ingredients for a 

tasty shot, covering everything you’ll need to 

consider, from composition to colour balance. 

We’ll whet your appetite for the shoot ahead.

Capture 
stunning 
cuisine

Tips|Tricks|Fixes

66  Photography Tips, Tricks & Fixes

©
 O

le
n
ka

 K
o
ty

k



Tips|Tricks|Fixes

Photography Tips, Tricks & Fixes  67

Tips|Tricks|Fixes

Set the scene

Although it’s hard to pinpoint 
exactly what makes a good food 
shot, composition, lighting and 
styling are all important elements. 
Read on to discover how to get 
the most from the genre and take 
your tastiest ever shots

Photography Tips, Tricks & Fixes  67
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Prepare yourself
Get stuck into the genre and find out what kit you need to succeed

Food photography is a big business, both in the 

editorial and advertising industries. The genre is a 

commercial form of still life, with the aim being to 

make food as alluring as possible for advertisements, 

magazines, packaging and menus, not the mention 

in the pages of cookbooks. Images of food 

should be inspirational and bursting 

with life, either making you want to 

make, taste or eat whatever’s in the 

frame. Whether they’re working 

to bring in custom to a new 

restaurant, or boost the sales of a 

food magazine, the same basic 

principles apply.

Your kit needn’t break the 

bank however and often a simple 

setup is best. Stuart Ovenden is one 

professional who has shot for all the high-

end supermarkets, but his kitbag remains lo-fi. 

“As simple as it sounds, a hot-shoe spirit level saves an 

age in getting horizon lines dead straight when working 

quickly.” Although he mainly works with Canon’s 

50mm f1.2 lens, he’s also an advocate of the popular, 

affordable f1.4 version. “In terms of image quality and 

value for money it’s such a good lens.” When you’re 

photographing wider scenes such as a whole table of 

food, tilt-shift lenses become incredibly useful, even if 

they take a considerable investment.

Whatever your setup, you’ll probably need something 

to diffuse and reflect the light, but it’s perfectly 

fine to make your own accessories if you 

don’t have the specific equipment already. 

For example, a sheet of fabric can be 

pinned to a window to diffuse the 

light, and white walls and ceilings can 

successfully be used as reflectors. 

A tripod is another essential for 

shooting, enabling pin-sharp results 

when the lighting is dim.

Ovendon believes that to be a 

success in this area of photography, you 

have to have the confidence to know when a 

shot’s right. Imperative too, is a genuine passion 

for food. “I think that you can tell in the shots when 

people have a real understanding and enthusiasm 

for their subject.” As shoots are often a team effort 

between the photographer, chef, client and food stylist, 

being fun and friendly will also get you a long way.
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Use props

It’s important to tell a story 
with your images. Use props 
to set the scene, such as 
bowls, sieves, tablecloths, 
plates and spoons

Balanced 
aperture

A wide aperture can help 

exposure in low light situations 

and will also create a shallow 

subject stand out against 

background. 
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Pretty in pink

Some recipes will look 
striking when photographed 
from directly above, while 
other subjects, such as 
tiered cakes, need to be 
shot from a lower angle

Balance the colour

Use a grey card or filter and 
set a custom white balance 
for your food images as an 
easy way to avoid unnatural 
and unappetising colour

1: Keep it level 
Don’t be tempted to photograph 

shots on a slant, as this can 

tend to confuse the eye and 

make plates look as if they’re 

floating in mid-air. Keep your 

camera level, referring to the 

spirit level if possible and aim 

to keep any obvious lines as 

straight as possible.

2: Get in tight 
When the camera is positioned 

directly above the subject 

and centred, the result tends 

to be more graphic. This is 

a particularly good angle for 

flat subjects, like biscuits or 

pizza. Don’t be afraid to crop 

repeating subjects out of the 

edges of the frame.

3: Tilt it 
Try tilting towards the subject 

and note the effect. When food 

is tilted towards the camera, 

it engages the viewer and 

welcomes them into the frame. 

This is a common angle for 

cookbooks, serving a double 

purpose as it shows the cooked 

dish close-up.

4: Suit your subject
While an overhead 

perspective works well for 

flat subjects, three-dimensional 

foods can tend to look slightly 

odd when photographed 

from above. Always start by 

capturing your subject from at 

least three different viewpoints 

to find the best angle.
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Consider the angles
Perfect your composition and decide on the shooting perspective that suits your subject best

Before
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Inviting lighting
Discover the myriad of 
illumination options available to 
the food photographer

Like all types of photography, the lighting you 

shoot with will make or break your images. 

You don’t need a lot of equipment; it’s often 

best to start off with one diffused source such 

a softbox or a window. When you work with 

one light, you’ll also have one set of shadows, 

which makes the results much more natural 

and easy to fill in with a reflector.

Most food photographers abhor the use of 

flash and advocate using natural light wherever 

possible. Clare Barboza (www.clarebarboza.

com) is one such example, who shoots “food 

almost exclusively with natural light, [but] once 

in a very great while I’m forced to use artificial 

[sources].” If you do want to use a speedlight, 

try bouncing the flash off a ceiling or a sheet of 

white card to avoid specular highlights.

Once you’ve set up the light source itself, 

you need to decide on its direction and 

whether it’ll look most appealing when lit from 

the from the side, back or front. Barboza 

first thinks about the mood of the shot she’s 

trying to convey. “Is it bright and airy? Darker 

and moody? Do I want strong shadows or 

soft, even light?” Certain dishes actually lend 

themselves to a particular type of lighting. “For 

example, cocktail shots often do well with 

backlighting, because it helps illuminate the 

colours and make them pop.”

Natural light should always be your first 

choice for shooting, but bear in mind that it 

needs to be plentiful enough to bring out all the 

colour and contrast of your subjects. Consider 

taking dishes outside to photograph them – if 

the weather and style of the shoot allow. 

Window light
Arguably the most favourable light 

for food is indirect daylight, such as 

that from a nearby window. Avoid 

shooting in direct sunlight, as this 

will cause harsh glare.

With flash
Flash is very unpopular for food 

photography, as it generates 

harsh reflections and glare. It’s 

used occasionally in the studio, for 

example to mimic the look of sunlight.

Continuous lighting
A large light source such as a 

softbox is ideal to use when you’re 

shooting without natural light. Avoid 

having the light in your shot, as this 

will introduce lens flare.

Avoid
using flash

front, dispelling natural shadow 
details. Opt for a tripod and 

longer exposure in 
low light.
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Tricks of the trade
Pro photographers use plenty of nifty techniques 
to ensure food looks at its absolute best

Food is a difficult subject to 

capture at its best, purely 

because it dries out, goes 

cold, melts under hot lights 

and wilts very quickly. 

The delicious-looking 

concoctions found in 

magazines and print ads 

have been styled to look as 

appetising as possible, so 

it’ll come as no surprise that 

many pro food photographers 

have a trick or two up their 

sleeves designed to make 

their subjects look more 

appealing. For example, 

when hot food needs to look 

hot, cotton wool balls can be 

filled with water, microwaved 

and then hidden behind the 

subject to give off the effect of 

billowing steam.

Spray-on glycerin or 

deodorant can be used to 

create a frosty finish on glass 

bottles or give the appearance 

of moisture to the leaves 

of a salad. A much simpler 

approach can be taken, 

however, simply by misting 

fruits and vegetables with 

water. This way the droplets of 

moisture will inject life into an 

otherwise dull subject.

How natural you want the 

food to remain is entirely up 

to you, but there’s certainly 

plenty of room for creativity 

when styling the shot. 

Toothpicks are a fantastic way 

to hold flimsy items together, 

or tease out crumbs from hot 

cakes. At the more extreme 

end of the scale, shoe polish 

can be applied to meat to give 

it a more succulent colour.

Food photography 

lends itself well to a little 

inventiveness, with some 

practice and a few supplies, 

it’s possible to develop many 

different tricks that’ll help you 

keep food looking its best 

during a long shoot.

Split-second

“I love pushing the boundaries 
of still life photography and 
resolving client’s problems 
with inspiring imagery,” says 
professional photographer 
Lucas Zarabinski

Go further

Still life shooter Lucas 
Zarebinksi (www.

lucaszarebinski.com) loves to 
create conceptual images of 
food. The genre can become 
as creative as you want
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It’s possible to take several great shots 

of one scene. Just experiment with 

different compositions

High megapixel camera
Use a camera that can produce 

high-resolution photos so that you 

can crop to recompose without 

losing image quality. The Canon 

80D (£950/$1200) has 24.2 

effective megapixels. 

Lens with a
versatile zoom 
A large focal range gives you lots of 

scope to shoot wide-angle scenes 

and close-ups. The NIKKOR AF-S 

DX 55-300mm lens (£315/$400) has 

a versatile 5.5x zoom. 

Articulated LCD screen
Being able to tilt and flip your 

camera’s LCD screen is useful for 

framing shots creatively. The Canon 

G5 X’s (£650/$750) vari-angle LCD 

flips outwards so you can tilt it at 

any angle.

Tripod with spirit level 
A tripod with a spirit level will help 

you steady your camera and keep 

horizons straight. The Manfrotto 

MT190XPRO3 (£185/$219) also 

has a tilting centre column for even 

more framing options. 

Kit to help you with compositionGear guide
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C
omposition is one of the most basic 

skills of photography, and yet it is 

often the secret to turning a good 

shot into a great one. It refers to what you 

choose to include in your photo and how you 

position it within the frame. A visually pleasing 

composition should typically be simple and 

engaging, showing off your subject in the best 

way possible. There are a few tried-and-tested 

rules that you can use to help you decide what 

to include and where to place it. Although we 

call them rules, they are actually more like 

guidelines, as the way you frame your shots 

is ultimately a matter of personal opinion. 

However, these rules come in useful as a great 

starting point for when you get stuck and can 

also help to inspire you when you’re looking 

for something to shoot. Then if you decide to 

bend or break them, you can follow your artistic 

instinct to decide what is best for the shot. 

Unlike modes and settings, composition is a 

technique that can be applied no matter what 

camera you are using, whether it’s a DSLR 

or even a cameraphone. It can also be used 

with any photography genre, as many of the 

rules we will show you over the next few pages 

can be applied when shooting anything from 

landscapes to action. If you don’t get it quite 

right in-camera, we’ll also show you how to 

recompose your image using editing software. 

Discover the best ways to set up and capture eye-catching shots in any genre

Take time composing 

by using a tripod

Easy tricks for 
better composition



Tips|Tricks|Fixes

74 Photography Tips, Tricks & Fixes

The rule of thirds is perhaps the most popular 

compositional technique, as it is very easy to 

master. It involves imagining a nine-section grid 

over your scene and using the lines to help 

you position your subject. It is suggested that 

you place the main focal point over one of the 

intersecting points of the grid, as this is where 

the viewer’s eye is likely to be drawn to first. If 

you are taking a landscape photo, then you 

can also use the horizontal lines of the grid to 

position the horizon in either the top or bottom 

third. If you’re struggling to picture the grid, 

many cameras have a very handy gridlines 

display function that you can switch on and use 

instead for some extra help. 

Rule of thirds
Use gridlines to help you frame your shot

1: Top of the frame
If the foreground is the most important part of 

the scene, position the horizon in the top third of 

your photo to draw attention to it and remove any 

expanse of dull sky.

Top tips for composing landscapesWhere should I put the horizon?

2: Bottom of the frame
If your vista has an interesting sky, position the 

horizon in the bottom third of your photo to show 

it off, but be sure not to cut out any important 

foreground detail.

3: Middle of the frame
If the sky and foreground are equally important, 

position the horizon along the centre. If your 

scene is reflected in a lake or river, this will also 

help to create symmetry. 

Select gridlines

Most cameras, including 
cameraphones, have a 
gridline display. Select it in 
your camera’s menu and 
frame stronger shots with 
straight horizons
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Including lead-in lines in your photo is a great way to help 

guide your viewer’s eye through your photo or towards 

your main subject. Look out for natural lines made by 

pathways, fences, bridges or anything else you can spot, 

and carefully position them in the frame. You could even 

use the lines of a building or other structure, or introduce 

your own lines into a still-life photo. 

Foreground interest
Avoid shooting just the land and sky of a 

landscape, as this can make for a dull shot. 

Look for something of interest to include in 

the foreground, such as a building, colourful 

flowers or other inanimate object. This will 

serve as the main focal point, giving the 

viewer somewhere to first direct their gaze 

before they explore the rest of the photo. 

Golden ratio
The golden ratio is a traditional 

compositional technique often used 

by artists. It follows a design that is 

commonly found in nature and is 

universally pleasing to the human 

eye. The idea is to position the most 

important part of your photo towards 

the centre of the spiral and the rest of 

your main focal point within its curve. 

It can be tricky to master, but some 

cameras and editing programs 

have a spiral display function that 

you can use to help. 

Lead-in lines
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Look for 
symmetry
Symmetry is automatically 

appealing to the eye and 

can be found everywhere, 

be it in nature or man-made 

structures. It also gives you 

permission to ignore the 

rule of thirds, as it works 

best if you centre your

subject in the frame. 

Find patterns 
and texture

Interesting patterns and textures 

can add to your existing photo 

or serve as the main subject of 

your shot. Shoot them close-up 

to capture as much detail as 

possible, and keep an eye 

out for repetition too. 

Eye-catching elements
Look out for visually pleasing compositions
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Include 
reflections
Including reflections allows 

you to double up your main 

subject and can also create 

symmetry in your shot, or 

you could just shoot the 

reflection on its own for a 

different perspective. Look 

out for mirror images in 

lakes, puddles and even the 

windows of buildings. 

Compose 
with colour
Bright colours will help to grab people’s attention, 

and so they make a great compositional element for 

ensuring your photos get noticed. Try not to include 

more than three different colours in your shot, as this 

can leave it looking cluttered and overwhelming. 

Frame your subject
Look for something else in the 

scene that you can use to frame 

your main subject. This could 

be a natural frame such as tree 

branches or a man-made frame 

such as an archway. It might just 

be a case of shooting from a 

different angle. 
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A longer focal length 

will allow you to keep 

your distance and 

prevent lens distortion

Sometimes the best way to 

shoot your subject is up close 

so that they fill the frame. If your 

subject is surrounded by lots 

of empty space that doesn’t 

add anything to the shot, then 

zoom in to take a more striking 

image. Similarly, a close-up will 

eliminate any distractions in the 

surrounding scene to ensure 

your subject is the main focal 

point of the shot. This can also 

make for a really intimate image, 

particularly for portraits, so get your 

subject to look right into the lens for 

a really engaging photo. 

Fill the 
frame
How to take an 
intimate close-up

Adjust your settings

If your subject is filling 
the frame, use a narrow 
aperture (high f-number) to 
keep everything in focus. 
Start at f8 and check that it 
appears sharp
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Recompose your shot
Solve compositional 
problems in PhotoshopLeave some active space

Leaving active space in front of your moving subject will help 

the viewer to visualise where it is moving to. Without it, your 

shot can look a little static and create the illusion that your 

subject isn’t moving. If you are struggling to achieve this, zoom 

right out to leave lots of space around your subject that you 

can crop into later. It is a good idea to leave a large enough 

space for your subject to fit into again.

Consider the background
Watch out for anything in the background that could divert 

attention away from your subject, and re-frame to eliminate 

distractions. You could simply change your position to 

capture a different background, or add your own backdrop 

with plain card or curtains. Another way to simplify the 

background is to use a wide aperture (small f-number) to 

create a shallow depth of field and blur it out.

It's not uncommon to open an image on 

your computer and realise that a horizon isn’t 

straight, or it needs a tighter crop. Here's how 

to recompose quickly in Photoshop.

1: Straighten horizons 
If your horizon is wonky, select the Straighten 

tool and choose if you want it to automatically 

crop the shot or keep its original size. Draw a 

line across the actual horizon of your shot.

2: Crop in
The Crop tool lets you choose a grid to help 

you recompose your shot. You can use the rule 

of thirds or the golden ratio and highlight the 

section of your image you wish to keep. 

3: Flip or rotate 
Go to Image>Rotate and choose from the 

menu options. You can rotate by a set number 

of degrees, choose a custom amount, or flip 

your image horizontally or vertically.
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Plan perfect 
wildlife shots
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Delve into our fauna-filled feature and discover how to take your most expressive images of animals yet

F
or some photographers, the call of the 

wild is always strong, and the challenge 

of capturing subjects in their natural 

environment is endlessly inspiring. Whether 

you’re shooting in the local countryside or 

on a once-in-a-lifetime safari, over the next 

few pages we’ll show you how to make your 

images stand out from the rest. Be inspired 

to take a more creative approach to capturing 

your wild subjects.

Out in the field you’ll be working with natural 

light, and there’s plenty of scope for using 

results. Learning more about animal behaviour 

patterns might sound complex, but it will help 

to ensure you can capture your subject at its 

most dynamic.

Although to succeed in this genre you need 

patience in abundance, when the action does 

happen it can unfold at lightning speed. We’ll 

show you how to capture movement from your 

subjects, setting up your camera for a panning 

motion that’s sure to generate creative results. 

Follow our advice and become truly immersed 

in the wild world.

atmospheric conditions to achieve the most 

artistic effects. From highlighting a subject 

using rim lighting to silhouetting it against a 

misty backdrop, you’ll find that nature provides 

plenty of inspiration.

While long lenses are generally an important 

part of a professional kitbag, understanding 

field craft is also essential for getting close 

to subjects. We’ll explore the importance 

of researching a shoot and your chosen 

species, where to look for locations and how 

to perfect the timing of your visit for the best 

Tips|Tricks|Fixes

Build your skills

Creative wildlife 
photography often requires 
the skills necessary for 
typical animal photography, 
plus plenty more
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Understand your subject
Research animal behaviour and capture images with more dynamism

Although packing up your bags and heading 

straight into the wilderness might sound like an 

exciting prospect, in truth it’s best to make sure 

you have done extensive research before 

you even step out of your front door. 

Without being equipped with 

the knowledge necessary not 

only to find your subject in 

the first place, but approach 

it without scaring it off, your 

technical skills and kit will be 

will go to waste.

First, narrow down which 

animals you’re likely to focus 

on in your chosen location, 

and find out as much as you can 

about their ecology and behaviour 

beforehand. When your aim is to capture 

intimate and natural images, reading the subtle 

signs an animal displays can help you predict 

their next move and also therefore be prepared 

to capture it. Behaviour patterns are infinite, and 

can include mating rituals, courtship displays, 

feeding, flying and hunting, to name a few.

Specialist books, journals and of course 

the internet play host to a myriad 

of information on any given 

species, but when you need 

to locate particularly elusive 

wildlife, don’t be afraid to 

contact someone whose 

occupation it is to study the 

animal full time. For example, 

countryside wardens, 

scientists and even ecology 

students are passionate about 

their subject, experts in their areas, 

and usually only too keen to share 

their knowledge. You may even get some tips 

on the best sighting spots and times.

Of course, no textbook can prepare you 

for the real world and observing the animal 

in its natural environment is essential for 

improving your photographic instincts. Just as 

our ancestors were in tune with the animals 

they hunted for food, a professional wildlife 

photographer would benefit from becoming 

familiar with the habits of their quarry too. 

Start by looking for signs of activity such as 

tracks, tufts of hair, and obvious pathways that 

the animals have used. Keep a small diary or 

journal to hand, and note down any important 

signs of activity that you can refer back to later. 

When you do come across your subject, keep 

a record of the time and weather conditions.

While this initial level of research sounds less 

glamorous than testing out a new technique 

or lens, it’ll definitely save you time when it 

really counts, and avoid tracking subjects in 

the field only to watch them fly off as soon as 

you appear. As with all worthy endeavours, the 

more time and effort you put in, the more you’ll 

be able to discover – and photograph.
© Jaco Marx

SEASONAL 
VARIATION

As the seasons change, animals 

must adjust their behaviour to 

survive. Take the time of year into 

account, and consider how your 

subject may adapt, migrate or 

even hibernate in response 

to shifting temperatures.

Long shot
For shots of behaviour, it’s 
important that you don’t 
cause a disturbance. A 
500mm lens was used here 
to hone in on the subject

Become familiar
By observing a species over 
a long time, you’ll gradually 
become accustomed to their 
habits, and should be able to 
capture more intimate images

Know your subject
It’s important to research the reasons 
behind animal behaviour. These 
playful leopards are displaying 
natural social interactions, unaware of 
the photographer’s presence

Patience is key
As with all wildlife 
photography, you should be 
prepared to wait a long time 
before any action happens
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Time it right

Creatures may visit one 
spot at the same time 
each day – keep an eye 
out for these patterns

Fleeting moments

Researching an animal’s 
behaviour will help you 
know what they’re going 
to do next
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Forget balanced lighting and interpret the natural 
conditions for creative effects

The greatest landscape photographers 

recognise how to work with natural light for 

the most expressive outcomes, and there’s 

no reason why wildlife scenes should be 

approached any differently. In fact, wildlife 

photography is often landscape photography 

too. Whether it’s light streaming in through a 

forest glade or a dark and stormy morning, 

Mother Nature plays host to a stunning range of 

atmospheric conditions. Convey these and your 

shots should be transformed from being just 

technically accurate to visually sublime.

Light quality varies from season to season, 

so you will need to practice in every new 

situation. During winter, for example, the 

light has a greater clarity to it and introduces 

elements such as frost and mist. In snowy 

scenes, the light is generally more even and 

flat, but it’s important to keep an eye on your 

exposure, as the camera meter can be fooled 

into underexposing scenes.

Regardless of the season, 

when the Sun is low in the sky, 

backlighting is a fantastic way to make 

your subject pop. For silhouetted portraits, 

shoot towards the brightest part of the sky, 

and take a meter reading from the sky. Dawn 

and dusk will give you the best chance of a 

colourful, warm backdrop. 

During the golden hours, you can add drama 

to your backlit shots by shooting towards the 

Sun, timing the shot to coincide with when the 

Sun is closest to the horizon. At brief periods 

during the day, the Sun can produce a warm 

rim light around your subject, particularly if you 

shoot from a low angle.

There’s nothing wrong with taking animal 

portraits on a bright day, but the light is likely 

to be harsh and can cast distracting shadows 

onto the subject. If you can’t avoid shooting at 

this time, expose for the face first, switching to 

spot metering if you need more accuracy.

CLOUD 
COVER

Overcast days are good for 

photographing animals with 

bright markings, and the naturally 

diffused lighting should enable 

you to capture a greater tonal 

range. You could also 

experiment with shooting 

in monochrome 

mode.

Expose with imagination

© Saud AlOtaibi
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Low key
Making use of predominantly dark 
tones is a sure way to add drama 
to your shots. The blacks and 
shadows were amplified at the edit 
stage to complete the look

Metering success
For a low-key result like this, 
either spot meter from the 
animal’s face or use negative 
exposure compensation to tell 
your camera’s meter how to 
expose the scene correctly

Light direction
As with portraits of people, 
side lighting generates 
strong highlights and 
shadows, which work to 
make your subject look 
three-dimensional

Move yourself
Remember to experiment 
with different shooting 
angles, and move yourself 
in relation to your subject to 
alter the spread of light
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Fine art photographs work with visually 

simple ideas, but they also need to be 

incredibly well executed if they’re to 

Silhouetted shots of animals are a 

good example of this concept, whereby 

a dark outline is captured against a 

is particularly effective for animals 

that have a recognisable or attractive 

need to position yourself so that you 

photograph the subject from the right 

For a successful silhouette, use 

spot metering and aim your camera 

You’ll probably need to manually 

focus on the subject itself, and will 

get the best results by using a mid-

telephoto lens such as a 200mm or 

longer to compress the perspective 

contains unavoidable elements such as 

overhanging trees, use them to frame 

Although in some contexts it’s important to show an animal 

within its environment, less can often be more when you want 

enough to your subject and use a tight crop, the results can 

be truly intimate and mesmerising, working well to engage 

parts, you’ll be introducing an element of intrigue, as the 

technique to employ when you’re using a prime lens, and 

When framing the shot, think about the animal’s position in the 

frame, what you’re trying to convey, and therefore which details 

© Jackson Carvalho
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Try showing only specific details in the frame
Get in tight

Edited light

While pure wildlife 
photography relies on 
minimal post-processing, it’s 
possible to take editing much 
further in a fine art context, 
such as in this example by 
Jackson Carvahlo

Go for a graphic result by focusing on figureUse shapes
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Embrace movement
Your images will instantly gain impact when they 
include dynamic perspectives and motion

Arguably the greatest challenge for any wildlife 

photographer is in attempting to depict animal 

movement, either by using lightning fast 

shutter speeds to freeze the motion, or longer 

exposures for expressive and abstract blur. To 

truly excel, you’ll need to be prepared to fire 

the shutter at any moment, and this starts by 

having your camera on the correct settings 

and ready to go.

While most scenarios will benefit from a fast 

shutter speed, it’s clear that when shooting 

a leopard, you’ll need a much faster setting 

to freeze motion than a sloth, for example. If 

pin-sharp results are your aim, keep in mind 

also that long lenses are more susceptible to 

camera movement, and unintended motion 

can cause blur. Generally speaking, avoid 

shutter speeds that are slower than your 

lense’s focal length; for example using a 

400mm lens you’d need to keep your speed 

above around 1/400sec.

Switch to Aperture Priority and tweak the ISO 

for the available light, as this will give you less 

to think about when the action does occur. It’s 

also worth setting the camera’s drive mode to 

continuous shooting in order to capture the full 

range of animal movement.

Although there are some image makers that 

believe the entire frame should be pin-sharp, 

experimenting with slower shutter speeds 

and panning is a great way to attain a more 

abstract result in your imagery. The most 

obvious perspective isn’t always the best one, 

but it’s usually easy to alter your shooting 

angle and make your imagery stand out. When 

shooting birds and small animals, for example, 

if you get down to their eye level you’ll soon 

notice how intimate the image can become.

Many professionals even build their own 

houses or employ tech to attain otherwise 

impossible images, such as Will Burrard-

Lucas’s self-made BeetleCam (www.

burrard-lucas.com/beetlecam). His remote-

control camera buggy was used in Africa 

to take close-up, wide-angle shots of many 

dangerous wild animals, and while it might 

be unnecessary for many smaller species, it 

certainly highlights that there’s nothing wrong 

with tailoring your kit and techniques for 

innovative results. 

1: Choose your settings 
On your DSLR, set the Focus to S-AF or AI Servo. 

Choose a low ISO, such as 100, and switch to 

Shutter Priority. Start shooting with a speed of 

1/30sec, tweaking the duration for faster subjects.

2: Stabilise the camera
Use a tripod or beanbag to keep the camera 

anchored. Practise the panning motion, standing 

with your feet apart and knees slightly bent. If 

shooting handheld, rotate from the waist.

3: Track and tweak
As your subject moves, press the shutter and 

follow with the camera in a smooth motion, 

aiming to keep it in the same position in the 

frame. Check the results and experiment with 

shutter speeds.

Capture motion blur 
Set up your camera for panning 
with an extended shutter
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Incorporate a natural environment that truly complements your subject

Thanks to the revolution in camera technology, 

capturing photos of animals in their natural 

environment has become much more of an 

art form than the science it once was. Taking a 

fine art approach to wildlife imagery is as much 

about focusing your attention on the backdrop, 

colour palette and tonal quality of the image as 

the subject itself.

A minimalist approach often works most 

effectively, and a good place to start is to use 

out-of-focus foregrounds and backgrounds. 

This is an easy technique to master when you’re 

using a long telephoto lens, and by setting a 

wide aperture, there will be a shallower depth 

of focus. What you can control however, is the 

select point of focus, your subject’s position in 

the frame, and what’s inside the frame.

Always aim for a background that 

complements your subject, rather than distracts 

from it. Shooting from a low angle, for example, 

even lying down on the ground itself, will 

enable you to bring the foreground closer to 

the camera and accentuate the blurred effect. 

While selective focusing is a great method 

to explore in cluttered settings, a similar end 

result can be achieved when the surroundings 

themselves are tidy. Snow and calm water are 

both typically neutral backgrounds, and enable 

you to use negative space creatively while still 

keeping the subject as the key point of interest.

The key to minimalism is to concentrate on 

one or two elements or colours, and above all 

keep the composition simple. Try zooming to 

include repeating patterns, such as feathers or 

striped fur, and crop to remove any distractions. 

Bear in mind that what you choose to exclude 

from the frame can be just as important as 

what you leave in.

Perfect your background

1: Replace dull skies 
Create a composite using a dynamic sky image 

to add interest. Purists can feel uncomfortable 

about this, but it’s generally acceptable if the 

image isn’t intended for a competition.

2: Convert to monochrome 
Some images work better in black and white 

when there’s a strong tonal range. Convert 

using an adjustment layer and slide the colour 

channels for a finely controlled edit.

3: Remove distractions 
Foliage and glimpses of other animals can 

detract from your main subject. Use the 

Healing Brush and Clone Stamp tools in 

Photoshop to remove unwanted elements.

© Simon Roy

© Flickr Creative Commons – Tambako

Delve into the post-processing stage for captivating end resultsGet creative with editing

Distracting background

When images have a cluttered 
backdrop, it generally causes 
your subject to get lost in the 
scene. Very simple backgrounds 
usually produce the most 
dramatic wildlife photos, 
highlighting your subjects so that 
they stand out
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Shoot creatively and 
then edit in Photoshop 
for amazing effects

It's fun to 
experiment!
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Motion blur
Master macro
Night-time 
portraits
Pet photos

Creative 
projects
Take your photos 
to new heights
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146
“The choice is hard 
with so many potential 
subjects”
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Nature’s colours 
Any landscape will make 
a great subject for this 
project, but including a 
tree in your composition 
will help you show the 
changing colour of 
the leaves

T
he great outdoors is a wonderful 

source of inspiration for your 

photography. There is so much 

to see and shoot that you will never run 

out of opportunities to practise your skills 

and produce stunning shots. Better still, 

the outside world is constantly changing, 

from year to year, season to season, and 

even day to day, so you can revisit the 

same spot again and again yet always 

produce a different shot. 

With so many potential photo subjects 

available, it can be difficult to decide 

exactly what to shoot, so we have put 

together a few photo project suggestions 

for you to try. No matter what time of 

year it is, there will be something fun 

and creative in these pages for you to 

have a go at. We will show you how to 

take atmospheric portraits in low light, 

using lens flare to your advantage, 

and shoot striking street scenes with 

creative motion blur. Discover how to 

capture stunning photos of the local 

wildlife, and fantastic action shots in 

the open air. There’s also top advice for 

photographing water creatively, plus a 

guide for making your portrait subject 

look as if they are floating in mid-air. 

First though, prepare for your outdoor 

adventures with our top tips for planning 

ahead and making sure you make the 

most of each outing. Then we will kick off 

the outdoor projects by showing you how 

to capture the changing seasons with 

a spectacular photomontage. If you’re 

struggling to get motivated, you could 

even challenge yourself to complete all 

ten in a set period of time, ticking them 

off as you go. So pick up your camera, 

head outside, and start capturing your 

best-ever images today.

Get outside and start capturing creative images of any 
scene with our handy practical projects

10 outdoor 
projects

Precise composition 
When you take a new shot, bring the previous 
one with you so that you can line it up exactly 
the same. A tripod will help with this

As the seasons change, so does the 

landscape, with each spectacular vista 

looking completely different from one 

month to the next. To show this change, 

take a photo from the same spot every 

three months. Once you have four 

photos, compile them into a collage or 

photomontage to show the seasons 

changing in one fascinating image. 

Many editing programs have handy 

functions for combining your shots 

automatically, or you could use an app 

on your smartphone or tablet to make 

it even simpler. Alternatively, you could 

take your photos more regularly and 

turn them into a time-lapse video using 

movie editing software or an app on your 

smartphone. This will allow you to speed 

up the change to show a whole year in 

just a few seconds. 

1. Record the seasons
Create a photomontage of the ever-changing landscape
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Outdoor photography tips 

Find a spot
Do some research 

to find great photo 

spots to visit in your 

local area, such as 

zoos, public parks 

or picturesque 

countryside. Or you 

could stay even closer 

to home and find 

some plants and birds 

to shoot in your own 

back garden. 

Protect
your gear 

If you’re going to be 

shooting in wet or cold 

conditions, then make 

sure you and your 

camera are protected. 

Consider placing your 

camera in a clear 

plastic bag to keep the 

rain off and ensure the 

battery stays warm for 

optimum performance. 

Pack your bag
Think carefully about 

the kit you will need 

before you go out on 

your shoot. A tripod 

will help you keep your 

camera steady in low 

light, while filters will 

allow you to control 

the light for creative 

effects. A waterproof 

case will also come in 

handy in a downpour. 

Check 
conditions 
Before heading out, 

take a look at the 

weather forecast. 

Bright midday sun 

is not always best 

for landscape shots, 

especially if you’re 

looking for cloud 

interest, and overcast 

days are more 

flattering for portraits. 

Consider 
lighting  
Natural light has a big 

effect on the look of 

your shots, so it may 

impact the time of 

day you shoot. Dawn 

and dusk provides the 

softest light for your 

photos as the sun will 

be lower, and cast a 

lovely golden glow 

over your subject.

Start a project  
To narrow down 

your overwhelming 

choice of subjects, 

start a photography 

project to fire up 

your imagination. For 

example, look for 

letters or shapes in 

nature, shoot only one 

colour, or look for a 

subject for each letter 

of the alphabet. 

Set a reminder

To help you remember to 
take each photograph, 
set up a reminder on your 
phone to prompt you when 
the season changes
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When you are out with your camera, don’t just admire the wider view. 

Look closely at the smaller things around you too, as they can be 

just as fascinating to include in your photos. Natural subjects such 

as flowers and leaves are particularly interesting, as they have lots of 

intricate details that will look great when photographed up close for 

stunning macro shots. Man-made objects make great macro shots 

too though, so pay attention to the details of nearby buildings, fences, 

vehicles and other structures. 

You can take close-up snaps with any camera, but if you want to get 

really close to your subject then it is worth investing in a macro lens, 

extension tubes or close-up filters.

2. Get close-up with nature
Reveal the hidden details in the world around you

Nature’s wonders

Keep an eye out for 
interesting patterns, textures 
and details that will show 
up in your photographs but 
others may have missed

1: Set your mode
Use Macro mode, or if you want more control, 

switch to Aperture Priority mode and use a wide 

aperture (small f-number) to blur the background.

Take a close-up shot in three easy stepsShoot macro

2: Focus manually
Your camera may have a macro focus mode. 

If it doesn’t, see if your camera will allow you to 

manually focus, or use Selective Autofocus. 

3: Check the shot  
Bring your taken photo up on your camera screen 

and zoom in to check that it is sharp. If it looks a 

little soft, re-focus and shoot again. 
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Pick your settings
To capture plenty of light and 

blur the background, use Portrait 
mode or switch to Aperture 

Priority and pick a small f-number 

If you’re taking photos near still water, buildings 

with windows or any other shiny surface, look to 

see if there is anything reflected in it. This can 

present you with fantastic photo opportunities 

for producing creative shots. For example, a 

landscape reflected in a lake will allow you to 

duplicate the scene and make your photo twice 

as great, while a window-covered building means 

that you can capture more of your surroundings 

in one shot. You could even take a portrait of 

someone reflected in a window, or capture a 

mirror image in a puddle on the ground.

Natural light is often the most flattering for portraits, but certain times 

of day are better for shooting than others. For example, the hours 

just before sunset and just after sunrise are ideal. As the Sun is 

low in the sky, it casts a lovely soft light across the scene that can 

improve almost any outdoor photo. Position your portrait subject 

so that the Sun is behind them to prevent them from squinting in 

your shots, but try to include the sunlight in the background of 

your photo. This will cause some creative lens flare and reduce the 

contrast in your photo, giving it an atmospheric, dreamy quality and 

naturally softening their skin.

4. Include 
reflections

3. Shoot an 
atmospheric portrait

Use water and windows 
to enhance your shots

Use natural light to create a dreamy photo

Bright and beautiful 

If your subject appears too 
dark, fire your flash to fill in 
the light, or use a reflector to 
bounce it back to their face
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Even busy towns and cities make great places to practise your 

photography skills. As well as shooting the local architecture, 

you can also capture people going about their everyday lives or 

pluck up the courage to ask a stranger to pose for you. There 

are several different techniques you can try out in urban areas, 

including flexing your black and white photo skills with help 

from our guide on page 58. If you want to take some candid 

street shots, then you will need to master the art of shooting 

undetected and be able to control the appearance of blur in 

your photos. Follow our guide to find out how. 

5. Capture a 
striking street scene
Control blur to record the hustle and bustle of urban life

1: Set the speed
To take a shot with no blur, set a fast shutter 

speed of 1/125sec or faster. To create a sense of 

movement, slow it down to capture motion blur.

Record the busy world around youSnap on the street

2: Adjust the screen
If you don’t want to make it obvious that you’re 

taking photos, shoot from the hip and use your 

camera’s LCD screen to frame your shots. 

3: Use the zoom  
To get great close-ups of people without them 

noticing your camera, make use of your zoom to 

get closer while still keeping your distance. 



Tips|Tricks|Fixes

Photography Tips, Tricks & Fixes  95

Shoot handheld
When taking photos 

on the street, stay clear 
of using a tripod so 

you can move without 
getting in people’s way

With their unpredictable and wary nature, wild animals are notoriously difficult 

to capture on camera. However, this is what makes it so rewarding when you 

do manage to get a great shot. There are a few tricks that you can keep up 

your sleeve to improve your chances too. Planning ahead and researching your 

subject will help you be in the right place at the right time, and you can always 

entice them into view with some food. Use your zoom to get great close-ups from 

a distance and also make sure that you keep as still and quiet as possible so as 

not to scare them off. 

6. Track wild 
creatures
Photograph amazing animals in the wild

Avoid blur

For sharp shots, use an 
action scene mode or set 
your camera to Shutter 
Priority and use a shutter 
speed of 1/250sec or faster

Street portraits

If you want to take a posed 
portrait of a stranger, politely 
ask their permission and 
then offer to send them the 

photo as a thank you
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Keep it simple

If the background of your 
photo is really simple, you 
should only need to take one 
shot and remove the stool 
in editing software

There are all sorts of fun ideas you can use to spice up your 

portrait shots, plus it will help to keep your subject entertained 

during the shoot. You could do something simple such as 

introduce props, for example flowers or a hat, or try wacky poses 

like jumping in the air. However, if you want to get really creative 

then you can employ some editing tricks too. In just a few clever 

steps, it’s easy to make your subject appear as though they are 

floating in mid-air. All you need is a stool for them to sit or stand 

on, and some editing software for removing the support later. 

You could even get your subject to hold balloons or an umbrella 

to really enhance the floating effect.

7. Make your 
subject float
Take a creative portrait with a difference

1: Take the first shot…
Find a simple backdrop for your shot. Set your 

camera on a tripod or sturdy surface and shoot 

your subject sitting or standing on a stool.  

Shoot and edit your magical photoCreate a levitating effect

2: Capture the second
Next, stay where you are but get your model to 

move out of the frame and take the stool with 

them. Now take a photo of the empty backdrop.

3: Remove the stool   
Open the background image in editing software, 

then place the other photo on top. Add a layer 

mask then brush over the stool with a black brush.
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8. Smooth 
moving water 

9. Look for 
symmetry  

10. Take an 
action shot

When photographing moving water, there is a simple trick you can 

use to make your shots even more impressive. Set your camera 

on a tripod or sturdy surface and switch it to Shutter Priority mode. 

Now set a slow shutter speed, anything slower then one second, 

and take a photo of the water. The long exposure will have recorded 

the movement of the water as blur, smoothing it out. To blur it more, 

simply use a slower shutter speed that will keep the shutter open 

for a longer period of time. The tripod is essential for keeping the 

camera steady and ensuring that the water is the only thing blurred 

in your shot, and you will need to attach an ND filter for really slow 

shutter speeds on bright days. 

A really easy way to create an engaging photo is to make it 

symmetrical. Of course, this requires you to find a subject or scene 

with perfect symmetry, but that is much easier than you might think. 

Examples of symmetry can regularly be found in architecture, as 

structures are typically built with perfect proportions. However, 

you could also look out for symmetrical subjects in nature too, as 

examples can sometimes be found in flowers and plants. When 

composing your shot, position your subject in the centre for 

maximum impact, switching on your camera’s gridline display if you 

need help lining things up. 

Photography is great for revealing things that we 

might otherwise miss with the naked eye, and 

action shots are a perfect example. By using 

an action scene mode or a fast shutter speed 

in Shutter Priority mode, you can freeze any 

movement within the frame to record a split-second 

of action too quick for you to register. To practise 

this technique, try photographing a sporting event 

or even a vehicle in motion. Alternatively, you could 

take an action portrait, getting your subject to jump 

or run around or throw some leaves in the air.

Take stunning shots of seascapes and waterfalls

Line it up for a pleasing photo 

Freeze movement for 
striking split-second shots 

Keep it sharp

To avoid jogging the 
camera and causing blur 
when you fire the shutter, 
use remote shutter release 
or activate self-timer
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1: Blur the background 
Using a wide aperture setting (small f-number) will 

not only let plenty of light into your lens, but it will 

also create a shallow depth of field and blur any 

lights in the background into creative circles. 

2: Choose your settings  
When using flash, can keep your ISO as low as 

possible to avoid grain. You will also need to use 

a fast shutter speed to keep everything sharp. 

Without flash, you may need to raise your ISO.

5: Zoom in
For an intimate portrait, take a close-up head 

and shoulders shot. Zoom with your lens and not 

your feet, as a short focal length will distort your 

subject’s face and create an unflattering effect.

6: Find your angle 
Experiment with different compositions for your 

shot, look for the best angle to capture your 

subject from. Shooting from high angles or at eye-

level is generally the most flattering for portraits.

4: Correct the colours
The light from your flash can be quite cool, leaving 

your subject looking a little pale and washed out. 

Using the Flash white balance preset will warm 

your shot up a bit for more accurate colours.

3: Focus correctly 
Accurate focus is important when using a wide 

aperture (small f-number) as you need to ensure 

the background is blurred, not your subject. Set 

the focus point over the subject’s eyes. 

Our settings

Aperture: f1.8 ISO: 100 
Shutter speed: 1/200sec

Compose night-time portraits
Essential tricks for taking beautifully lit portraits after dark
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If you’re not confi dent with using manual 

modes, use a night portrait scene mode to get 

your camera to pick the best settings for you

Fire your fl ash to illuminate your subject. Try 

bouncing the light off of a piece of white paper 

to soften it, for more fl attering results

Spot metering mode will get your camera to 

measure the light for where you focus (ie your 

model), to make sure they are well exposed



P
hotographers have always experimented with 

ways in which to create intriguing effects, right 

from the early days of film. Traditionally, the 

same slide of film was exposed twice to produce 

a superimposed image, but the effect can now be 

reproduced using one of the many modern DSLRs that 

has a dedicated Multiple Exposure mode.

If your camera doesn’t have a dedicated mode, 

however, or you want a bit more creative control over the 

final result, you can also mimic the effect in Photoshop. 

In this tutorial you’ll discover how to shoot the best initial 

portrait image for the technique, as well as how to edit 

Merge several images into one for striking abstract portraits

Shoot a double exposure

Left 

On trend

You might have seen the effect 

of overlapping several photos on 

the covers of music albums, in 

magazines and adverts. Despite its 

intricate appearance, it’s easier to 

achieve than it looks

the two images in Photoshop for a striking and abstract 

final result.

One of the great things about this project is you don’t 

have to shoot your portrait and overlay images at the 

same time. Why not experiment with some from your 

archive? It’s easy to have a go provided that you’ve got 

a camera with manual shooting modes and a willing 

model to stand for the shoot.

Follow this step-by-step tutorial, as we go through 

both the shooting and editing steps you need to merge 

two photographs together, with the help of some simple 

Photoshop blending modes.
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2: Dial in settings
Lower the ISO to a value of around 

160. You’ll be shooting against a 

bright background, so shouldn’t need 

to raise it any higher. Next, select an 

aperture of around f5, ensuring that 

your model’s whole face is in focus. 

Change to a wider aperture if the 

scene isn’t bright enough.

3: Position your subject
Position your model against a bright 

background, such as the sky on an 

overcast day. They should ideally be 

side on to you – a profile shot is more 

successful than a face-on image, as 

their features will be more identifiable 

in silhouette. Move yourself to avoid 

any messy background scenery.

4: Set the focus
Some lenses struggle to focus 

properly when they’re pointed at a 

bright light source, such as a white 

sky. If you find that this is the case, 

switch to manual focus on the lens 

barrel and use the focus ring to 

ensure your model’s face is sharp.

5: Check result
Take a test shot once you’ve set up. 

There’s no right orientation, but you 

must check for distracting elements in 

the frame. Dial in a positive exposure 

compensation if necessary, ensuring 

the camera overexposes the sky. 

Retake the final image when you’re 

completely happy.

6: Shoot fill image
You can choose anything for the 

second photo, but natural subjects 

such as leaves and flowers work best. 

Shoot a scene containing interesting 

shapes or textures to effectively fill 

your silhouette image. Alternatively, 

find a pre-existing image to overlay 

your portrait shot with.

Shooting 
steps

5 6

1: Set up camera
Switch your DSLR to Aperture 

Priority using the top dial. Select spot 

metering, as this is the easiest way to 

expose the shot correctly in varying 

conditions. Make sure you’re using a 

suitable lens – a 50mm prime works 

well for this type of portrait shot.
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The setup

In-camera technique
Use a DSLR to create the effect 
without editing software

Modern cameras often have a myriad of extra functions 

buried in their menus; most high-end Nikon DSLRs 

and certain Canon bodies such as the 6D enable you 

to perform the double-exposure technique in-camera. 

Navigate to the Shooting Menu, scroll down to find Multiple 

Exposures and press OK (Enable or Disable on a Canon 

system). From there you can then decide how many 

frames you want to shoot, and how you want the camera 

to expose your shots. Use Live View to easily align your 

images, but take care not to overexpose the final result. 

Handily, you don’t have to take the two shots at the same 

time, but can save one to a memory card until you find a 

complementing fill image.
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Direct your model
Shooting on an overcast day 

is ideal. If the sunshine is 

bright, face your model slightly 

away from the Sun in order to 

prevent them from squinting

Choose your glass
A dedicated portrait lens 

works well for this technique, 

but it needn’t be expensive. 

For this shoot we used a 

Canon EF 50mm f1.8

Change your angle
Crouch down for a lower 

shooting perspective to 

achieve a clean white 

background that’s free from 

distracting elements



Editing steps
1: Prepare your base
Open your portrait in Photoshop and 

go to Image>Adjustments>Levels to 

increase the brightness and contrast. 

You might also want to use the Clone 

tool to remove any distractions.

2: Import second image
Open your fill image, go to Select>All 

and copy. Open your portrait shot and 

paste one image on top of the other. 

Go to Edit>Transform to Rotate, Scale 

and Flip your image.

3: Blend and adjust
Select the top layer and change the 

Blend Mode to Screen. You can use 

the Move tool to reposition the fill layer 

over the portrait, paying attention to 

what’s covering the features.

4: Bring out the detail
Create a Levels or Curves adjustment 

layer from the bottom of the Layers 

palette. You can use either method 

to bring out detail in the mid-tones. 

Desaturate the face layer for a more 

subtle result.

1 2

3 4

BEFORE AFTER

Photography Tips, Tricks & Fixes  103

Tips|Tricks|Fixes

5: Quick results
Merging two shots together is a great 

way to add intrigue and interest. The 

blending process is straightforward 

when you shoot portraits against a 

bright background

5 5
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Photograph birds in flight
Learn the essential tricks for capturing dynamic images 
of our feathered friends in motion

S
uccessfully capturing images of birds in 

flight can be a difficult skill to perfect. 

Not only is the subject moving – 

sometimes at great speed – but its direction can 

also be unpredictable. 

with small birds that have rapid wing beats, such 

Capturing sharp, well-framed images of these is 

those new to shooting photographs of birds in 

tracking a bird, waiting for it to reach that 

optimum point for the perfect shot, only for it 

mind, selecting a good shooting position with 

a clear area devoid of possible obstructions is 

preferred location, spend some time studying 

so read on to discover how to use these for 

1: Get the best equipment
A lens with the focal length of 300-500mm is 

the preferred choice for photographers looking 

conjunction with a tripod and gimbal-type head 

4: Set to continuous focus
A continuous focusing setting should be used 

because a burst of several frames will usually 

2: Check the lens mode

ensure that the image stabilisation or vibration 

handheld, this mode should be appropriately set 

5: Set camera exposure modes

3:  Set the focusing mode and 
distance

Make sure your lens is set to autofocus and, if 

applicable, the optimum focus range setting is 

6:  Take up a good stance when 
panning

Assume a sturdy panning stance to help minimise 

locking on to a target, then fire a burst of shots 



Tips|Tricks|Fixes

106  Photography Tips, Tricks & Fixes

P
ortraits are frequently presented in 

black and white, simply because 

monochrome is incredibly flattering 

and has a wonderfully classic look and feel. 

However, its ubiquity means that it’s always 

worth looking for ways to create black-and-

white portraits that have something that’s just a 

little bit different about them.

One way of doing this is to experiment with 

gritty, film noir-style images, in which creating 

a moody atmosphere is the name of the game. 

From a shooting perspective, it’s a great 

technique to try with less experienced models; 

there’s no looking at the camera nor serious 

posing involved. Instead, the goal is to create 

a sense of tension through hard, high-contrast 

lighting, close attention to clothing and location, 

and dramatic editing techniques.

Although important to virtually all black-and-

white photography, with a film noir portrait 

the relationship between light and shadow 

is absolutely key to the success of the final 

image. The secret is to create the sense that 

your subject exists within the dark environs 

of a world of shadow, a world illuminated by 

dramatic shafts of light that are often, according 

to the conventions of the genre in film, 

enveloped with smoke. A sense of mystery has 

to be created through what can’t be seen rather 

than what can be.

Create a film noir portrait
Shoot and edit atmospheric black-and-white portraits

Classic film noir

The location, attire, lighting 
and time in Photoshop come 
together to produce an 
image resembling a still from 
a film noir classic
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4: Trigger the flash 
You’ll need an off-camera flash to light your 

model, which is easier to do with a wireless flash. 

Pocket Wizards are a popular option, but you can 

also use your camera’s proprietary facility, such as 

the Nikon Creative Lighting System (CLS).

5: Flash settings 
While a lower-powered flash can work, you’ll have 

more flexibility with a high-end flash unit, such as 

the Nikon SB-910 or Canon 600EX-RT. Using a 

narrow aperture to underexpose loses you flash 

power, so the more powerful the flash, the better.

6: Off-camera flash
Set the flash on a stand and position it so that it’s 

angled down onto the subject to create a dramatic 

light source befitting film noir. Don’t use flash 

modifiers to soften the lights, as a fairly hard light 

works best for this effect.

1: Pick the location 
The environment you choose for your shoot is 

very important. The classic Forties and Fifties film 

noir movies often used poorly lit alleyways filled 

with fog or smoke. When shooting outside, look 

for a location that matches the genre.

2: Choose Manual 
For this technique, you’ll need control over the 

ambient exposure and the flash exposure. This is 

best achieved using your camera’s Manual mode, 

so that you have full control. Set ISO 100 for 

quality and capture RAW files for editing flexibility.

3: Set the exposure 
We want to make the image seem as though it 

was taken at night. Key to this is underexposing 

the ambient light. Set the shutter speed to around 

1/200sec, and dial in an aperture that results in a 

suitable degree of underexposure.

Shooting steps
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Posing your subject
Work with your model to produce 
the right pose for your portrait
Spend some time at the beginning of the shoot 

giving your subject clear instructions about the type 

of pose that you want them to hold during the shoot. 

Film noir essentially dictates that your model should 

not be making eye contact with the camera, which is 

beneficial if you are working with an amateur model, 

as not having to worry about looking into the lens 

typically makes them feel more comfortable. In fact, 

if you get your lighting, exposure and editing right, 

the eyes will often be shrouded in shadow in the end 

result. The subject’s eye-line and general stance 

are important nonetheless. Don’t forget to consider 

clothing as well – film noir is chiefly associated with 

the Forties and Fifties, so the wardrobe used should 

be as contemporaneous as possible.

The setup
Ensure you have all of the correct 
components for the perfect shot

The right pose 
Ensure that you discuss 
the sort of look that you 
are after with your model – 
show them examples and 
direct them

Standard lens 
A focal length between 
35mm and 70mm is 
probably ideal for this sort 
of portrait, although you 
could experiment with wide-
angle lenses too

Off-camera flash 
Make use of an off-camera 
speedlight flash unit – and 
triggered wirelessly – to 
light your subject
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1: Make exposure adjustments 
The first thing to do with your image is tweak the 

lighting. Adjust the Exposure, Contrast, Highlights 

and Shadows. Add a subtle vignette and use the 

local adjustment options to add drama.

2: Convert to mono 
For some easy but authentic period drama, 

turn the image to black and white. Adjust the 

tonal values accordingly in order to get the best 

possible conversion. 

3: Add a street light 
Set swatches to white/black. Make a layer set 

to Linear Dodge (Add). Add light with the Radial 

Gradient and duplicate. Add a layer set to Screen, 

with Diamond Gradient for the light. Adjust opacities.

4: Add smoke and fog 
Create a new layer. Use Filter>Render>Clouds. 

Lower the Opacity. Use the Reflected Gradient on 

a mask for more control. Use the Erase and Free 

Transform tools to adjust the smoke.

5: Spread the light 
Create a new layer. Use Reflected Gradient and 

Ctrl/right-click on the layer, go to Blending Options, 

set it to Screen and split the black triangle. Take 

the left half to 88 and the right to 255. 

6: Final adjustments 
Flatten the image, duplicate the layer and go to 

Filter>Blur>Gaussian Blur. Select Soft Light and 

split the This Layer triangle by holding Opt/Alt, 

with the left half on 25 and the right on 115.

Before After

Editing steps
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2: Choose the right settings
Use Bulb mode in order to take a really long 

exposure (the shutter stays open until you release 

the shutter button). You can also use Shutter 

Priority mode at as slow a speed as you can set. 

Set the ISO to 200.

1: Mount your camera 
A sturdy tripod is essential. Get the best your 

budget allows. It needs to support your camera’s 

weight and withstand wind. Tripods with 

independent moving legs will cope better with 

uneven terrain.

3: Focus with the torch
Switch to manual focus and shine the torch onto 

where your main point of focus will be. Look 

through the viewfinder or at the LCD zoomed at 

100 per cent and turn the focus ring until the area 

is sharp.

Before

Exposing and painting with lightShine a light
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Shoot great night 
shots with a torch
Transform dark scenes into colourful captures

D
uring the winter months, most people save their photography 

for the weekends when there’s a better chance of light, without 

even considering venturing into the darker hours of the night. 

It’s easy to understand why; it’s dark, almost lifeless, and without any 

hint of drama. In fact, there almost seems like no incentive to go out 

with your camera at all, but the opposite is true, as the darker hours are 

essentially a blank canvas, waiting for a pinch of flare and creativity to 

be added from you. 

Photography is based primarily on light, and at night you have the 

benefit of complete control over where the light falls in your image. 

You may have passed by a post box a hundred times on the way back 

from a night out, or driven past a barren tree without any leaves. Or 

what about that park bench or even the unassuming rubbish bin on the 

corner of your street? Yet it’s the ordinary, everyday things like these 

that are prime potential candidates to be painted with light, transforming 

them into vibrant points of interest that feel like they are jumping out of 

the photograph. 

The wonderful thing about painting with light is that almost anything 

and everything can be considered. As long as you follow the few basic 

tips in this article, the scope for creativity is enormous, and aside from 

the camera settings, the most effort required is for you to hold a torch. It 

sounds simple, and for the most part it really is! You’ll just need to open 

your eyes a little bit wider than usual, grab your camera, tripod and 

torch, and head out into the night, ready to paint your scene any way 

you want to.

Follow our tutorial to learn the simple tricks you need to start light 

painting. Why not try it out in your back garden, or even in your home if 

you don’t want to head out in the cold!

4: Use a cable release
A cable release will allow you to open the 

exposure and lock it without having to hold down 

the shutter button with your finger. It also ensures 

clean, shake-free images along with using a 

sturdy tripod.

5: Paint in light
Press down the shutter and then use slow, 

sweeping motions with a bright torch to spread 

the light evenly, or hold it in one position for 

intense effects. To add in colour, see the boxout 

for this easy trick!

1: Use a lens hood
Lens hoods are handy for those times when 

you stray too near to the lens with your torch. 

Unless you want flares in your shot, then fit a 

hood onto the lens.

2: Add coloured filters
Adding colour to the scene will make your 

images stand out. Coloured gels or sweet 

wrappers placed over the torch lens are ideal. 

Acetate can be bought at art stores or online.

3: Work on firm surfaces
If the ground is soggy, or if the tripod is light, 

take advantage of hard, even surfaces like 

tarmac to set up your shot on. This will ensure 

steady, shake-free images.

Handy helpAdditional tips
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Using a fast shutter speed, you are 

able to freeze motion in its tracks

For long exposures, 

support your camera

Use a slow shutter speed and pan the camera to 

capture motion blur

Control motion blur 
with shutter speed skills
Discover how to take control of shutter speed for stunning effects

S
hutter speed is the key to capturing 

stunning shots of motion, whether you 

want to show a sense of movement 

or freeze action in its tracks. You can use 

it to take shots of sports, dance, or your 

kids running to keep everything sharp, 

or get creative with it and slow it down to 

intentionally show blur in a stunning way – 

you too can take seascapes with smooth 

water like the pros! 

Shutter speed is also a vital step to getting 

a perfect shot, as it must be combined with 

aperture and ISO to get the perfect exposure. 

Over the next few pages, we explain 

everything you need to know about this vital 

setting, from how your shutter works and the 

best mode to use to experiment with shutter 

speed, to explaining the issue of camera 

shake, caused at slow shutter speeds. We 

then take you through our favourite creative 

uses of shutter speed, with five mini projects 

you can try today. Get stuck in and you’ll 

soon be controlling the way motion appears 

in your shots.
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Shutter speed plays an important role in an 

exposure, alongside aperture and ISO. Your 

camera’s shutter speed determines how long 

the image sensor is exposed to light. Once 

light enters the lens through the aperture, the 

shutter will open for a set time (depending on 

the speed you’ve set) to let the sensor record 

the image. 

The slower the shutter speed, the longer the 

exposure. Long exposures are typically used to 

capture creative images or subjects in low-light 

conditions. Using slow shutter speeds, you 

can blur water, experiment with zoom burst 

effects, capture light trails and much more. 

Shutter speeds that are slower than 1/80sec 

are considered slow shutters.

Fast shutter speeds, however, are ideal 

if you’re shooting in bright conditions and 

want to freeze fast-moving subjects such as 

sport, children or wildlife. Using a fast shutter 

speed, you’ll be able to capture all of the 

action with pin-sharp precision, and provided 

you’re using the correct focusing setting, 

your images will be clear and detailed too.

So set your camera up on a tripod, switch 

to Shutter Priority mode (see ‘Shutter Priority’ 

boxout) and experiment with different speeds 

for various effects.

At fast speeds (over 

1/125sec) you can 

freeze split seconds 

of movement for 

sharp shots

At medium speeds 

(around 1/60sec-

1/125sec) you will 

capture a small 

amount of blur

At slow shutter speeds 

(1/80sec and longer) 

you will capture a lot 

more motion blur

1/250

1/60

Second

Second

What is shutter speed?
Find out how shutter speed can affect your images

Camera shake is a common problem 

and is the result of using slow shutter 

speeds without a tripod. Tripods 

are an essential piece of kit, and 

particularly so if you’re shooting with 

long exposures or working in low light. 

Mounting your camera on a tripod will 

let you set slower shutter speeds, as 

the camera will not move while the 

exposure is being taken, lessening the 

chance of camera shake. As a rule, 

always use a tripod if you’re shooting 

with speeds slower than 1/80sec. If 

you don’t have a tripod, speed up 

your shutter and widen the aperture to 

compensate for the reduction of light. 

Avoid camera shake
The key to getting stunning monochrome shots
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The shutter in action

Shutter Priority

How it raises and closes

Adjust just your shutter speed

If you’re not quite ready for Manual mode but 

want to get more creative with your shots, 

Shutter Priority mode is available in most high-

end camera models. Often featured on the 

mode dial as ‘S’ or ‘Tv’, Shutter Priority has the 

same function regardless of the camera make 

or model. With it, it’s possible to change the 

speed of your shutter to get the effect you want, 

whether it’s to blur motion or freeze it.

The great thing about Shutter Priority is you 

can experiment with creative effects without 

worrying about exposures, as the camera will 

determine the correct aperture and ISO based 

on the shutter speed setting you’ve selected. 

How your camera’s shutter works
Discover how your shutter helps to expose the photo

1: Protecting the sensor 
The sensor, which creates your 
image, sits directly behind the 
shutter’s curtains. The length 
of time the shutter is open 
depends on the speed you’ve 
set. Slower speeds mean it is 
open for longer, so the sensor 
is exposed to more light. Fast 
speeds make the curtains 
open and close quickly

2: Controlling the curtains 

On DSLRs, when you release the shutter 
button, the mirror that is positioned in front 
of the shutter will rise. On all cameras, the 
shutter’s motor will control the speed at 
which the shutter curtains open during an 
exposure, depending on the shutter speed

1: Releasing 
the shutter
Before you release 
the shutter button, 
the image sensor is 
completely covered 
and protected from 
any light by the 
shutter’s curtains

2: Exposing the sensor
The first curtain will now begin 
to drop, exposing the top half 
of the image. The second 
curtain will then follow, which 
means the sensor is exposed 
evenly to light

3: Finalising the exposure
Once the shutter speed time has 
ended, the second curtain will drop 
completely to cover the sensor, 
protecting it from the light

3: Shutter curtains
A focal plane shutter has 
two thin curtains. After 
pressing the shutter release 
button, one curtain will drop 
down to begin exposing 
the sensor to light. The 
second curtain will then 
follow to close the opening
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High speed
You can capture some great effects shooting 

at high speed, including abstracts. This was 

shot in natural light using a fast shutter speed 

of around 1/600sec. A wide aperture and high 

ISO compensated for the lack of available light 

and ensured an even exposure. 

To get the effect, cover an old, medium-

sized music speaker with a black bin bag and 

apply bright, slightly watered-down paint over 

the woofer. Switch your camera over to Burst 

mode and Shutter Priority so that you can set 

a fast shutter speed of around 1/600sec. Use a 

tripod to focus the camera manually on a point 

where you expect the paint to rise to. You’ll then 

need to play upbeat music to get the paint to 

bounce. Release and hold down the shutter to 

capture multiple frames of the paint moving in 

time to the music. 

1/600
Second

If you want to capture a sense of motion while keeping 

your main subject sharp, panning is the secret. It works 

really well with moving vehicles to capture their sense 

of speed. To begin with, set your camera to continuous 

shooting and Shutter Priority mode, then select a medium 

speed of around 1/60sec. The speed you require will 

depend on how fast your subject is moving, so you may 

need to experiment with this. 

You’ll need to support your camera to prevent camera 

shake, and a monopod works really well for this as it 

allows you to easily move about. Pre-focus using manual 

focusing on the area your subject is about to move into, or 

half-press the shutter in autofocus. Then when they move 

into the frame, fully press the shutter and swivel your 

camera along with their direction of movement.  

Panning

1/60
Second

Shutter speed effects 
Experiment with your shutter speed to get some arty images
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Zoom burst
Zoom burst techniques are fantastic if you’re shooting stationary 

still-life subjects. They also work particularly well with colour, so be sure 

to choose an object that’s suitably bright and bold and with plenty of 

interest to shoot. 

To capture an image using this technique, you’ll need a tripod and 

zoom lens with a good focal range. Set your camera up on the tripod and 

position your subject centrally in the frame. Using your zoom lens, crop in 

close to your subject and focus on the central point. 

Once you’re set up, switch your camera over to Shutter Priority mode 

and select a slow shutter speed of around 1/30sec to start. Keep one 

hand on the zoom barrel so that you can rotate it anti-clockwise as soon 

as you release the shutter button. Check the results in playback to ensure 

you’re using the right shutter speed.

Misty water
Misty seascapes and waterfalls may seem out of grasp to a 

beginner, but they are in fact surprisingly easy to capture on 

camera. Once you’ve selected your scene, set your camera 

up on a steady tripod and switch over to the Shutter Priority 

mode. As you’ll be using slow shutter speeds, it’s preferable 

to shoot under lower light conditions, such as sunset, to avoid 

overexposing your image. However, a neutral density filter can 

be used during the day to filter the bright light and reduce its 

intensity for longer exposures.

When shooting, always set your focus point over a stationary 

part of the scene and set a slow shutter speed of around 

1/20sec to start. Keep checking your images in playback, as 

you may need to slow the shutter further depending on the 

light and look you’re after.

1/20
Second

Light trails
Light trails are surprisingly easy to capture and require slow 

shutter speeds and a steady tripod. To get great results, find a 

busy stretch of road that has a continual flow of traffic and set 

your camera up on the tripod. To make the most of the moving 

red and white lights, try to shoot from a slight angle, with the cars 

appearing to flow through the frame. Switch over to Shutter Priority 

mode and select a shutter speed of around 1-2sec. The camera 

will determine the correct aperture and ISO. 

Focus the camera on a bright, stationary point in the frame and 

then release the shutter to record the motion. Always check results 

in playback to see if you need to change the settings.

2
Second

1/30
Second



Refine fine art florals
Shoot stylish flower portraits and turn them into fine art monochrome masterpieces

T
hink of flowers and what comes to mind? Colour, 

of course; fields of shimmering sunflowers, or beds 

of tulips and daffodils adding vibrant splashes to 

parks and gardens. But you don’t need colour to produce 

successful photographs of flowers. In fact, stripping the 

colour away can be a huge benefit because by doing so 

you remove a layer of familiarity, leaving behind what really 

matters. In this way, you’re able to place the emphasis on 

the wonderful shapes, textures and tones that all flowers 

possess; the curves and forms that nature has created. 

In this tutorial, we show you how to create simple, but 

striking flower portraits then convert them to black and 

white. No special equipment is required – just window 

light, a sheet of black card or fabric as your background, 

and a reflector. Choose flowers that are bold and 

structured, such as arum and stargazer lilies, or gerbera 

daisies. Most high street florists will stock specimen 

blooms that you can buy individually.

Once you’ve taken the initial colour images you can 

choose your favourites and convert them to moody 

monochrome using Lightroom, Photoshop or third-party 

applications such as Silver Efex Pro. This is a great project 

to try on one of those all too familiar wet, grey days when 

you’re confined to the great indoors.
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Stargazer lily

With simple props, available 
light and a little patience, you 
can turn flowers into fine art 
monochrome studies that will 
look fantastic printed, framed 
and displayed on the walls of 
your home
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1: Position the props
Position your black background at 90 degrees 

to a window or patio doors. Place the vase and 

flower in front of the background. Then position 

a white reflector opposite the window to bounce 

light into the shadows. You can remove this later 

if required.

2: Set up your equipment
Position a tripod directly opposite the flower and 

attach your DSLR in portrait format. Adjust the 

height of the tripod so the lens is at the same level 

as the flower. A standard zoom will be an ideal 

lens for your portraits. Attach a remote release to 

the camera.

3: Take a test shot
Once your equipment is set up, stop the lens 

down to f8 or f11, set the ISO to 100 and focus the 

lens either manually or using AF. For critical focus, 

use Live View and zoom in on the flower. Set the 

camera to Aperture Priority exposure mode and 

take a test shot.

4: Check the test image
Take a look at the image on your camera’s 

preview screen and check the histogram to see 

if the exposure is correct. The dark background 

may cause the brighter flower to overexpose, in 

which case you’ll need to adjust the exposure 

compensation and reshoot.

5: Decide whether to reflect
A reflector will bounce light into the shadows 

on the flower and reduce contrast. Whether you 

prefer this look or not is completely down to 

personal preference. Removing the reflector will 

produce bolder side-lighting effect, which can 

work better with some flowers.

6: Fire away
Once you’re happy with the composition and the 

test images look okay, take the final shots. Lock 

up your DSLR’s mirror then wait for a few seconds 

before tripping the shutter to ensure there are no 

vibrations that might cause camera shake and 

reduce the image’s sharpness.

Shooting steps

Tips|Tricks|Fixes
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The setup

Keep it simple
Black is an ideal 
background as it makes 
the flowers stand out 
boldly, although you could 
also experiment with grey 
or white

Work with a tripod
Light levels are much lower 
indoors than outside, so 
mount your DSLR on a 
sturdy tripod to eliminate 
shake and ensure optimum 
image quality

Light naturally
The soft light from a 
window or patio doors 
is ideal for moody flower 
portraits. Bright, overcast 
weather offers perfect 
lighting conditions

See in black and white
Get an idea of what your final image 
will look like by working in mono

If you’re shooting a white flower against a black 

background your images are going to appear black 

and white, even when shot in colour. However, if the 

flower is colourful – such as a bright-red gerbera – 

and you’re not sure how it will look in black and white, 

all you need to do is set your DSLR’s image quality 

to capture both RAW and JPEG and also select 

Monochrome shooing mode. That way, when you 

take the shot you’ll see a black-and-white image on 

the preview screen, but you’ll still have a colour RAW 

file to convert later – although you may even decide 

the black-and-white JPEG is good enough straight out 

of the camera!
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3: Add effects
As the background wasn’t completely black towards the top left, the Burn 

Edges tool was selected and the All Edges (soft 1) preset. This ensures that 

the whole background is consistent.

1: Open the RAW file
Using Photoshop, apply Lens Corrections by clicking on the Colour and 

Profile tabs. Make adjustments to exposure and contrast at this stage, but if 

it’s well exposed you can open it and save it as a 16-bit Tiff file.

4: Save the image
Flatten the layers (Layer>Flatten Image), then remove unwanted details. 

Here, the rim of the vase was removed using the Clone Stamp tool in 

Photoshop. The Healing Brush tool was also used to remove blemishes.

2: Fade to grey
We used Silver Efex Pro to convert the image to black and white. Adjust 

Contrast, Brightness and Structure to achieve the desired look, or 

experiment with the presets for a quick fix.

Before After

Editing steps
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Take perfect pet photos with ease
Essential tips for capturing great pet portraits 

P
hotographing your pet is a great way to 

document them as they grow. However, their 

unpredictable nature makes them tricky to 

photograph. Unlike human subjects, you can’t direct 

them to pose, so great shots take skill and patience. 

However, once you get it right, you’ll have fantastic 

pictures of your furry friend to cherish forever. 

Trying to capture your pet’s personality results in the 

best photos. You could take your shot indoors at home 

or go out to the local park, but choose somewhere 

without a distracting background. If you are indoors, 

try to position your pet near a bright window, but if this 

isn’t possible, raise your ISO a little to make your sensor 

more sensitive to the available light. Use flash if you 

must, but this could startle your pet. 

As you can never be quite sure what your pet is 

going to do next, you’ll need to act quickly to capture 

the action. In this guide, we show you the best manual 

settings for your shot. Taking pet portraits of your loyal 

companion is a great chance to practise your action 

photography skills, so follow our step-by-step guide to 

get perfect results without the fuss.
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Pets in pensAdditional tips

1: Set your 
speed 
Set your camera 

to Shutter Priority 

mode and select a 

fast shutter speed 

of 1/200sec or faster. 

This will enable you 

to freeze your subject 

in the frame, even if 

you can’t get them to 

stay still for you. 

2: Pick Continuous AF 
To keep your pet shots pin-sharp, switch to 

Continuous Autofocus. This will get your camera 

to continually focus while you are pressing the 

shutter, so that your pet will be in focus even if 

they’re moving unpredictably.  

3: Switch to Burst mode 
To increase your chances of getting a great shot, 

use Continuous shooting or Burst mode. This will 

take a series of shots in quick succession while 

you hold down the shutter, giving you several 

photos to pick from. 

4: Zoom in
Make use of your camera’s zoom to get close-up 

shots of your pet without having to chase after 

them. Zooming in will also help you get a more 

engaging shot and eliminate any distractions in 

the background. 

5: Get their attention
As you can’t instruct your subject to look at the 

camera, try to get their attention by holding a toy 

or piece of food just above the lens. With a treat 

in front of them, they’ll look pretty happy too! You 

can also get good shots of them playing or eating. 

Steps to blur-free shotsPhotograph pets

2: Focus carefully  
When using a wide aperture (small f-number), 

you will need to make sure you focus on your 

subject and not the fence. Use single point 

focus or manual focus.

1: Use a wide aperture
Switch your camera to Aperture Priority mode 

and select a wide aperture (small f-number). 

This will create a shallow depth of field to blur 

the cage wire in front of your subject.

3: Get in close 
The closer you are to the animal’s cage, the 

more you will be able to blur out the wire. You 

could even try zooming though the gaps to 

eliminate the cage entirely.
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1/1000sec

1/8sec

8sec

Blurred water
By using a slow shutter speed, 
the fast-flowing water has 
become blurred, making it 
appear soft and milky, and giving 
the image an interesting effect

Try using an ND filter

By attaching a neutral 
density filter to your lens, you 
will reduce the amount of 
light entering your camera, 
allowing you to use slower 
shutter speeds

G
enerally speaking, a slow shutter 

speed is something to be avoided, as 

shooting handheld with one will mean 

that any movements of the camera or the 

subject will cause the image to blur, ruining 

the shot. However, this doesn’t mean that slow 

shutter speeds are completely useless. When 

used correctly, long exposures are actually 

very useful, and can be used to capture some 

fantastic imagery. Provided that you keep your 

camera stable on a tripod while the photo is 

being taken, shooting with a slow shutter speed 

will cause any movement in the scene to blur, 

while stationary objects will remain sharp. 

This can be particularly useful when used on 

subjects like fast-flowing water, as it transforms 

the water into a soft and attractive blur.

The good news is that this technique isn’t 

just reserved for photographing moving water 

either. It can also be used in a multitude 

of other ways to conjure up interesting 

photographic effects, like creating light trails or 

capturing motion blur. Over the next few pages 

we’ll be showing you how to do just that by 

taking you through the process and explaining 

everything there is to know about using slow 

shutter speeds the right way. Once you’ve 

mastered the basic principles, you’ll soon find 

out just how easy it is to become a master of 

long exposures.

Become a master of slow
shutter speeds
Discover how to use slow shutter speeds to capture awe-inspiring images with our complete guide
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Taking a photo of 

fast-moving water using 

a slow shutter speed will 

blur the water and make 

it appear soft 

Tips|Tricks|Fixes

Tripod
A sturdy tripod is essential as it’ll enable your 

camera to remain perfectly still during the long 

exposure. Any camera movements while the 

photo is being taken will ruin the result.

DSLR or CSC
To start shooting with a slow shutter you’re going 

to need full control over the camera settings. 

Either a DSLR or CSC is ideal for this as they offer 

a full range of manual controls.

Shutter release cable 
A shutter release cable allows you to start the 

exposure without actually having to touch the 

camera, reducing the risk of blurring. Alternatively, 

you could use the camera’s self-timer.

Must-haves for long exposuresEssential kit

Sharp background
Making sure that the camera was 
kept perfectly still during the exposure 
by using a tripod has meant that the 
background has remained sharp, 
while the water has blurred

Photography Tips, Tricks & Fixes  125
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1: Choose Shutter Priority
Turn on your camera then start off by switching it 

over to Shutter Priority mode (S or Tv on the mode 

dial). You will then need to set a slow shutter 

speed of 20sec.

3: Boost the ISO 

As we’re shooting in very low light, increase the 

camera’s ISO until you’re able to achieve an 

aperture value of between f8 and f11 – ISO 400 

worked for us.

2: Use a tripod
Set up your tripod, attach the camera, then frame 

up the shot. Focus halfway into the scene by half-

depressing the shutter button, then switch the 

lens to MF to stop it re-focusing.

Using long exposures
Learn how to set up your camera and start shooting with slow shutter speeds

One of the easiest ways to start shooting with slow 

shutter speeds is to switch the camera over to Shutter 

Priority mode. As its name suggests, Shutter Priority 

allows you to dial in the desired shutter speed while the 

camera takes care of the aperture value.

One thing to be aware of when shooting in Shutter 

Priority mode during the day is that if you find that 

the aperture value on your camera starts to flash, or 

displays ‘Hi’, this means that the camera isn’t able to 

close down the aperture enough to correctly expose the 

image. To fix this, reduce the ISO to the lowest possible 

value (usually 100) or attach an ND filter to reduce the 

amount of light entering the lens. If you’ve done both of 

these and your shot is still overexposed then you may 

need to try again on a cloudier day when the Sun isn’t 

as bright.

When using a slow shutter speed at night, the 

headlamps of any cars passing though your shot will 

leave colourful trails of light in their path. These bright 

streaks are known to photographers as traffic trails, and 

they can add a beautiful sense of motion to an image. 

Here we show you how to capture your own.

Slow but not too slow!

The slower the shutter speed, 
the more blurred moving 
objects will appear. But if the 
shutter speed is too slow 
they will hardly appear in
 your shot at all!

Traffic trails
Using a long exposure has 
caused the passing car lights 
to create continuous streams 
of light, which are otherwise 
referred to as a traffic trail
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How Shutter Priority works
Shutter Priority is a semi-automatic 

shooting mode that is commonly found 

on DSLRs, CSCs and other cameras 

that offer a range of different manual 

shooting modes. It works by allowing 

you to define the shutter speed you wish 

to use, while the camera automatically 

adjusts the aperture value to ensure a 

correct exposure. This mode is useful 

for long exposures when you know you 

want to use a really slow shutter speed. 

However, there are a few drawbacks 

to this mode – the most prominent 

being the fact that there is generally a 

much greater range of shutter speeds 

available than there are apertures. This 

means that sometimes when using a 

really slow shutter speed, the camera is 

unable to reduce the aperture enough 

to make a correct exposure, resulting 

in an overexposed shot. To overcome 

this problem, photographers attach ND 

filters to the front of the lens to reduce the 

amount of light that enters the camera.

4: Take the shot 
Attach a shutter release cable (or just use the 

camera’s self-timer function) to avoid knocking the 

camera during the exposure, then fully depress 

the shutter button to take the shot.

Do I need filters to 
take long exposures?
The longer the shutter speed, 

the more the camera's sensor 

is being exposed to light. 

Therefore, if you want to create 

a correctly exposed image, 

you'll need to balance this out 

by either reducing the amount 

of light entering the lens (using 

a smaller aperture or a filter) or 

decrease the camera's sensitivity 

to light (using a low ISO). If you're 

shooting on a bright, sunny day, 

this can be problematic, so try 

waiting for the Sun to become 

obstructed by a cloud, or even 

shooting later in the day when the 

sunlight is much less intense.

Filters help to reduce the 
amount of light that 
reaches the sensor, to 
avoid overexposure

Correctly exposed sky
The long exposure has 
allowed the camera to 
correctly expose for the dimly 
lit dusk sky too, for a much 
more appealing result

Before
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S
oap bubbles produce vibrant colours, rich 

iridescent patterns and strange fisheye-type 

reflections. When a bubble bursts, a moment 

of intense drama is added into the mix. However, 

photographing bursting bubbles is notoriously difficult. 

Poor light can create transparent bubbles, and the 

slightest breeze can cause a photographer to chase 

after a bubble blowing around in the wind. Then there’s 

the added problem of capturing the exact moment of 

the burst. 

In this tutorial, we’ll show you some simple steps for 

capturing bubbles mid-burst. The images featured here 

were taken in a garden on a bright and calm day. Strong 

sunlight allows good image quality and clear reflections. 

Occasional clouds diffuse the light, providing richness 

to the bubble’s colours. Hedges also provide a dark 

background, drawing out a range of colours on the 

bubble’s surface. 

The basic technique is simple. The bubble is blown 

from one hand while the camera is held in the other. The 

photographer then moves back and forth to keep focus 

on the bubble while an assistant bursts the bubble. The 

pop can be timed out loud to coincide a series of shots 

with the moment of the burst. 

Capture bubble bursts
A quick guide to creating beautiful, naturally lit bursting soap bubble photographs

Bursting soap bubble

A bubble is captured 
mid-burst. One half of the 
bubble clearly reflects a 
brick building and a tree, 
while the other half explodes 
dramatically, disintegrating 
into water droplets
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4: Hold bubble at arm’s length 
Before photographing, you will need to create a 

good working distance between the bubble and 

the camera. Holding the bubble at arm’s length is 

a good way to achieve this. With a flick of the wrist 

you can then release the bubble from the wand. 

5: Hands on the camera 
Having flicked the bubble free from the wand, get 

back to the camera, as you’re ready to take shots. 

Autofocus rarely recognises the centre of the 

bubble, so focus on the edge. Alternatively, use 

manual focus and see the reflections.

6: Time the burst 
Position yourself so you keep a dark background 

behind the bubble and brightly lit objects near 

to create interesting reflections. Ask someone to 

pop the bubble, trying to fire a series of shots to 

coincide with the burst. 

1: Adjust camera settings 
An aperture of f5.6 provides enough depth of field 

to keep the reflections in focus. A shutter speed 

of 1/320 is fast enough to avoid motion blur, and 

keep patterns sharp. Try continuous AF and 

underexpose to avoid the bubble being too bright. 

2: Thin the bubble film out 
If you dip the bubble wand into the bottle and 

blow a bubble straight away, the liquid will be very 

thick, so the film on the bubble will appear dull, 

transparent. Blow a stream of bubbles to thin the 

film out. Thin films create richer bubble colours.

3: Blow a bubble 
Blow the bubble in one hand while holding the 

camera carefully in the other. Blow gently to create 

a large bubble. Put the bubble bottle on the 

ground so that you don’t have to carry it around 

with you, but be careful not to trip over it!

Shooting steps
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Colours 
and reflections
Find landscapes and light that provide 
incredible colours and reflections
Interesting bubble photographs have clear reflections of 

the photographer, the finger that burst the bubble, and 

the surrounding landscape. Viewers can get drawn into 

these photos because they begin looking carefully at the 

landscape inside the bubble.

Early-morning or late-evening sunlight helps to light 

up the objects being reflected, making them stand 

out brightly. Try experimenting with which objects or 

landscapes you can reflect in the bubble. Thicker and 

thinner bubble film also combines with the light to create 

different colours and patterns. When the Sun is behind the 

bubble, for example, it can brightly light up the rim of the 

bubble, creating a nice and strong and colourful border to 

the sphere.

The setup
This tutorial is all about timing, so make 
sure you’re ready for the shot

Support the camera 

The camera is held in the 
right hand and the bubble 
is blown from the left. Once 
the bubble has been blown, 
bring your hand back to the 
camera to provide support

Remember the background
If the background was brighter, the bubble 
would appear more transparent. The 
darker the background, the richer the 
bubble’s colours will be

See the colour
Bubbles change colour as 
they dry out. Wet bubbles 
are transparent or green, 
and then go through blue 
and yellow phases before 
drying out and bursting
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Before After

Editing steps

Draw attention

By tweaking slightly, 
the eye is drawn to the 
moment of the action. 
Very slight edits make 
the reflections stand out

1: Crop for composition 
Select the Crop tool and crop around the bubble 

to create a pleasing composition with your bubble 

taking centre stage. Cropping slightly, like this, 

helps to draw attention to the action of the burst, 

which is the main attraction of the photo. 

2:  Select using Magnetic Lasso
Select the Magnetic Lasso to track around the 

surface of the bubble. Selecting the bubble in this 

manner enables you to make any image edits 

that might wish to the bubble only, leaving the 

background alone.

3: Edit for contrast and sharpness 
Now you can edit the bubble to draw 

out the reflections. Add a little contrast 

(Image>Adjustments> Brightness/Contrast), 

adjust the Levels (Image>Adjustments> Levels), 

and sharpen (Filter>Sharpen>Unsharp Mask).
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1: Consider composition
Composition is often the key to a great 

architecture shot. Experiment with positioning 

the structure off-centre or in the middle of the 

frame to create symmetry.

Using a short 

focal length can 

distort the look of 

the building, so 

step back and 

zoom in to keep all 

of the lines of the 

structure straight 

Switch your camera to Aperture Priority and select a narrow 

aperture (high f-number). This will keep everything in focus 

2: Include lead-in lines 
Lines can help guide the viewer’s eye through 

your photo, so look for fences and paths that 

head to your subject, or find a building with 

interesting diagonal lines. 

Capture stunning architecture from the best angles

Shoot architecture 

Our settings

Aperture: f8 ISO: 100 
Shutter speed: 1/800sec 
Focal length: 55mm 
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5: Check the weather forecast 
The weather can have a big effect on your shot. A 

bright blue sky provides a colourful backdrop but 

stormy clouds can also add some moody interest. 

6: Control your ISO
If you’re shooting in the day, use a low ISO for high-

quality shots. However, as the light fades, use a 

higher value or a slower shutter speed and tripod. 

4: Think about the scene’s lighting
The time of day can really effect the image – dawn or 

dusk will give shots a golden glow, while the midday 

sun can often cast shadows across the structure.  

3: Experiment with shooting angles
Move around the building to find the best angle 

to shoot it from. A low angle can make for a more 

dramatic image, or shoot from a high vantage point. 

Matrix/Evaluative 

metering will read 

the light for the 

entire scene, and 

your camera will 

pick the best 

shutter speed for 

the exposure
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I
f you’re looking for a fun yet challenging 

photo project to sink your teeth into, then 

look no further. This technique exploits the 

lack of depth within a 2D image, allowing you 

to toy with perspective to cleverly create the 

appearance that a flower in the foreground is in 

fact part of a woman in the background’s skirt. 

Although rather a simple concept, in practice 

there are a number of elements that need to 

be carefully juggled in order to get the shot to 

look just right. For instance, the flower must 

be angled perfectly from the side of the frame 

to line up with the model’s waist, all while 

ensuring that the aperture is set wide enough 

so that the background isn’t completely lost to 

blur. If this seems a little complex, then don’t 

worry as we’ve got you covered with our step-

by-step tutorial, where we’ll reveal how you can 

capture your own image with ease. 

Once you’ve bagged your shot, it’s then 

time to take it over to Photoshop for a spot of 

enhancing that’ll help polish up your shot to a 

professional-looking masterpiece. Read on to 

discover how to get creative with portraiture.

Play with 
perspective
Experiment with perspective to 
create this fun and quirky portrait

Flower skirt

With little more than a DSLR, 
a tripod and a flower, you can 
create your very own camera 
trickery image with results 
that are sure to amuse your 
friends and family
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4: Use manual focus 
No matter how good your camera’s AF system 

is, it may still struggle to focus on objects placed 

close to the front of the lens. Switch your lens over 

to MF using the switch on the lens barrel, then you 

should rotate the focus ring until it’s at the closest 

focusing distance.

5: Pose your model 
It’s time to position the model. For our shot, we 

want to make the flower appear as if it is a tutu on 

our model, so we asked our model to pose as if 

she were mid-dance. Ensure that your model isn’t 

too far from the camera so that they aren’t too out 

of focus.

6: Position the flower and shoot
With your model in position, grab your flower and 

look through the viewfinder. Dangle the flower 

into the shot so that it’s in focus in front of the 

model. As soon as you’re ready, take the shot with 

your free hand. It may take a few attempts to get 

everything positioned correctly.

1: Use a tripod 
Although for this technique we won’t be using 

a slow shutter speed, a tripod is a vital piece of 

kit to use as it will enable you to free up one of 

your hands. This is necessary as you’ll need to 

properly position the flower in front of the camera 

lens a bit later in the shoot.

2: Switch to Aperture Priority
With your camera powered up, switch it over to 

Aperture Priority mode (A or Av on the mode dial) 

and set the Aperture value to around f5.6. With 

this mid-range aperture, it should let in enough 

light while ensuring that your model isn’t too out of 

focus in the background. 

3: Increase the ISO 
Take a look at the shutter speed. If it’s currently at 

1/60sec or slower, you may need to bump up the 

ISO in order to gain a faster shutter speed and 

prevent your model’s movements from becoming 

blurred. To avoid noise, try to keep your ISO as 

low as you can. In our shot, we opted for ISO 400.

Shooting steps
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Choose your flower
Picking the right kind of flora is 
key to a perfect picture
Take a trip to your local supermarket or florist and 

you’ll find a vast array of flowers to choose from, 

which can make it tricky to pick the right one for 

your shot. It’s important to remember that the flower 

you select is going to be at the very heart of your 

image, so take your time when selecting a bunch. 

Carefully inspect each of the flowers, keeping an 

eye out for healthy blooms with good colouring, 

while avoiding any flowers that have creased or 

damaged petals. It’s also important to choose a 

type of flower that has a long and flexible stem, so 

that it’s able to gracefully droop into the frame – 

flowers with stiff stems, such as roses, are no good 

in this situation.

The setup

Pose your model
Communication between 
yourself and your model is 
key to gaining a successful 
shot. While looking through the 
viewfinder, you’ll need to clearly 
direct them in order to get them 
into the correct position Position the flower 

The flower needs to emerge 
from the edge of the 
frame, so choose a flower 
with a long stem to avoid 
accidentally capturing your 
fingers in the photo

Free your hands 
Mounting your camera onto 
a sturdy tripod while shooting 
will free up your hands in order 
to help you better position the 
flower within the frame
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Before

After

Editing steps

1: Brighten and increase contrast
Open the image in Photoshop, then head to 

Image>Adjustments>Brightness/Contrast. 

Increase the Brightness to 45, then boost the 

Contrast to 40. Click OK to confirm the changes.

3: Warm up the shot
Go to Image>Adjustments>Photo Filter to add 

warmth. In the window, set the Filter option to 

Warming Filter (85), then increase the Density to 

around 25%. Click OK to confirm.

2: Boost the saturation
Next, go up to Image>Adjustments>Hue/

Saturation and in the dialog box, move the 

Saturation slider to the right to a value of 20 to 

intensify the colours within the image. Click OK.

4: Add a vignette
Go up to Filter>Lens Correction and in the 

window click the Custom tab. Under the Vignette 

options, set the Amount to -50 and the Midpoint to 

+90. Click OK, then save your creative portrait.
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Switch off the Sun

Using this relatively 

straightforward technique, you 

can create the illusion that it’s 

dusk or even the middle of the 

night, even when it’s actually the 

middle of the day

138  Photography Tips, Tricks & Fixes
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Turn day into night
Discover how to make a portrait taken in the middle of the day look like it was captured after sunset

S
hooting at night can result in very atmospheric portraits, 

but the technical challenges involved – and the inherent 

inconvenience – can be prohibitive. This is why many nighttime 

scenes in films are actually shot during the day with the colour 

temperature manipulated to make them appear as though they’ve 

genuinely been captured after dark. The exact same principle can be 

applied to stills photography. 

The middle of the day doesn’t generally produce the most flattering 

ambient light for portraits, but if you underexpose the ambient light, 

tweak the white balance and work with flash you can create the 

impression that the photo was captured after the Sun has set. When 

you first see the results produced using this approach, you might think 

that the technique involved is very difficult to master, or perhaps that 

lots of Photoshop is involved, but neither is true. The settings that are 

used are very simple and the only post-production required will be the 

usual refinements you’d make to any image. 

It’s recommended that you shoot in RAW, as this will enable you to 

make any required adjustments to the colour temperature should you 

require it. Shooting in JPEG will give you similar results, however you 

will not have the same flexibility or quality of images.

1: Adjust the exposure
You need to overpower the ambient light. To do 

this, set your camera to manual exposure and use 

a shutter speed of 1/200sec and aperture of f11 or 

narrower. Use ISO 100 or the lowest you can.

4: Set the main light
Position the first speedlight off-camera at about 

45 degrees to your subject to light them. No CTB 

(colour temperature blue) gel is required because 

the white balance will take care of that.

2: Set the white balance
Most cameras enable you to dial in a specific 

Kelvin temperature. Remember that you want to 

create a blue colour cast so a value of 3030K will 

probably be about right for a night-time feel.

3: Capture in RAW
Shooting in RAW is a safety net when playing with 

colour temperature. The camera’s LCD doesn’t 

always show colour accurately, so images may 

look wildly different on a calibrated computer.

5: Add a second light
Use a second flash with a full CTO (colour 

temperature orange) gel, or even two, to light a 

wall near the subject. This works with the blue 

colour temperature to give the illusion of night.

6: Take the image
Use radio triggers to fire the speedlights, adjusting 

their power settings in order to achieve a suitable 

exposure. You’ll probably find they both need to 

be on either full or half power.
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Create a stunning macro masterpiece
Discover how to capture incredible floral close-ups

M
acro is one of the most intriguing types of 

digital photography, as it allows you to peer 

into a microscopic world that is otherwise 

missed by the naked eye on a daily basis. Under 

magnification even the most simple and unassuming 

household items can be transformed, making for some 

stunning photographs. Flowers are a common choice, 

as their bright colours and intricate textures translate well 

under magnification. 

To photograph a subject close up, your camera 

needs to be able to focus at a shorter distance than it 

normally would. Unfortunately, most standard lenses 

have a limit as to how close they can get to a subject 

before they’re unable to achieve sharp focus. Thankfully, 

macro lenses have been built in order to overcome this 

issue, and they are available for most makes of DSLR 

and CSC. Remember that before shooting, it’s always 

best to check to see what the lens’s enlargement ratio 

is – this is usually found somewhere on the lens barrel. 

‘True’ macro images are taken at a ratio of 1:1, while 

lenses with a smaller ratio (ie 1:2) will only offer half the 

amount of magnification.

1: Use a tripod
 When shooting under magnification using a 

macro lens, even the smallest of movements will 

be exaggerated, so setting your camera on a 

tripod is a must to keep your shot in focus.

4: Set your aperture
Switch the camera to Aperture Priority mode (A or 

Av) and set an aperture of f8. Remember, when 

focusing close up, even using an aperture of f8 

will only create a very small in-focus area.

2: Set up your subject
Sit your flower in a vase and place it next to a 

brightly lit window – or head outside if the weather 

is nice. Placing a piece of coloured paper behind 

the flower will create a clutter-free backdrop.

5: Use Live View to focus
When taking photos close up, it can be hard 

to get the focus right where you want it using 

autofocus. Switch to manual focus and activate 

the camera’s Live View to help get sharp focus.

3: Add the drops
Dissolve two teaspoons of sugar in a cup of water 

– this will help the droplets stay in place while you 

shoot. Using the head of a pin, or a pencil tip, 

carefully blot small drops of water onto the flower.

6: Take the shot
While looking at the camera’s screen, turn 

the focus ring on the lens until the drop of water 

is pin-sharp. Now press the shutter button to take 

the picture, being careful not to knock the camera. 

Tips|Tricks|Fixes

Set up your camera to take a close-up shotShooting
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1: Increase Brightness/Contrast
Go to Image>Adjustments>Brightness/

Contrast and move the Contrast slider right to 

add contrast. This is the quickest, easiest way, 

but offers less control than the methods below.

2: Adjust the Levels
Head up to Image>Adjustments>Levels. In the 

window, move the Black point slider to the right 

to darken the shadows, then move the White 

point slider to the left to brighten the highlights.

3: Experiment with Curves
Go to Image>Adjustments>Curves. In the 

window, drag the curves diagram to adapt it 

into an S-curve. This will darken shadows and 

brighten highlights to boost contrast. 

Add contrastShoot

1: Crop the image 
Open your image in Photoshop and grab the 

Crop tool. Make a tight crop around your subject 

while holding Shift on the keyboard to keep the 

crop in proportion. Hit Enter once you’re happy. 

2: Add contrast 
Head to Image>Adjustments>Brightness/

Contrast. In the window that appears, drag the 

Contrast slider to a maximum value of 100 to give 

your image a boost of contrast. Click OK to apply.

5: Sharpen your shot 
Head to Filter>Sharpen>Unsharp Mask. In the 

window that appears, set the Amount to 50, 

then move the Radius to a value of 2. Leave the 

Threshold set to 0 and click OK to confirm. 

3: Boost saturation 
Go to Image>Adjustments>Hue/Saturation. We 

want to boost the background, so click Master 

and choose the correct colour (Cyans in our 

case). Increase Saturation to +75 and click OK. 

6: Add a vignette 
Go to Filter>Lens Correction. In the window, click 

Custom and locate the Vignette options. Move the 

Amount slider to the left to around -30, then move 

the Midpoint slider right to around +70. Click OK. 

Use Photoshop to enhance your floral shotEdit

4: Remove blemishes 
Grab the Spot Healing Brush (J) with a brush 

size of 20px. Ensure the Content-Aware option is 

ticked at the top, then paint over any imperfections 

on the flower to quickly remove them. 
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1: Visit HelloCanvas 

First, go to www.hellocanvas.co.uk. Once you’re 

at the website, click on the orange Order Here 

button in the middle to get started making your 

canvas print. 

2: Upload your image 
Next, click the Upload Photo button at the top of 

the list and, in the window that appears, locate 

your image. Click on it to select it, then click the 

Open button. Wait while your image uploads. 

4: Additional features 
Here you can adjust the number of prints you’d 

like, add creative effects such as sepia toning or 

black and white, or add a wooden frame to your 

canvas. Once you’re finished, click Next. 

3: Adjust the canvas 
Select the size of canvas you would like, then 

decide whether it should be portrait or landscape. 

You can also determine the edge style using the 

options on the page. Click the Next button.

5: Place your order 
Here you’ll be given a rundown of your order. To 

make adjustments, hit Previous to go back a step. 

Otherwise, click Next to complete your order by 

entering your payment and postage details. 

Stay sharp
Making sure your water 
droplet stays pin-sharp is 
the key to a great shot

Pleasing backdrop
Keep it plain and clutter-free 
for a professional studio look

Refraction
Angle your camera so you 
can see the flower’s centre 
in the droplets

Bright colours
Make your image really 
stand out with eye-catching, 
vibrant colours

Turn your image into wall art with HelloCanvasShare

Macro lenses are a must

A macro lens is able to focus 
much closer to objects than a 
standard lens and is vital if you 
want to capture close-ups
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Perfect tones
Ensure that the colours 

are realistic by creating a 

custom white balance 

using a grey card 

Colour consistency

Setting a custom white 

balance enables you to shoot 

a sequence of images with 

the same, consistent colour 

temperature throughout

Expose well
Make sure that when you 

shoot the grey card, your 

image is neither over nor 

underexposed at all 
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Set a custom white balance
Save time in post-processing and ensure that you’re capturing completely consistent colours in-camera

T
hankfully, the auto white balance capability 

of digital cameras currently on the market is 

generally excellent. It’s unusual now for any 

camera to miscalculate the white balance and produce a 

colour temperature that looks noticeably incorrect.

However, the algorithms involved are not infallible; 

fluctuations can occur, even when the shooting 

circumstances haven’t changed. In certain situations 

colour consistency is vital, like shooting a sequence of 

images for a product or commercial shoot. 

If you’re capturing RAW files, inconsistencies in the 

white balance can be adjusted post-capture, although 

this adds a step to the editing process. A solution is to 

create a custom white balance at the start of a sequence. 

Different manufacturers have different implementations, 

but a common method is to photograph a grey card, 

select the image in the menu and set this as the basis for 

a custom white balance. It shouldn’t take any more time 

than the same task in Camera Raw or Lightroom, while 

also ensuring the white balance is extremely accurate.

1: Use a grey card
A professional grey card should ideally be used 

while creating a custom white balance. This must 

be positioned in the same setting as your subject 

in terms of lighting, facing towards your position.

4: Choose a preset destination
If you happen to be using a Canon DSLR, you will 

be able to skip the following two steps. If you’re 

using a Nikon DSLR, however, at this stage you’ll 

need to choose a Preset Destination, such as d-1.

2: Shoot the card
Your camera should be set to the factory white 

balance setting if possible, or auto white balance. 

Take an image of the grey card, ensuring it fills the 

frame, and try not to over or underexpose.

3: Go to the menu
Now find the relevant menu on your camera. On 

a Nikon you will be looking for the White Balance 

menu to select Preset Manual. If you use a Canon, 

you will need to find Custom White Balance.

5: Choose Select Image
On a Nikon, scroll down to Select Image. If this 

option has been greyed out for any reason and 

is unavailable, you will need to select a different 

Preset Destination from the previous menu.

6: Find the grey card
Now find your grey card image from earlier, 

remembering that you need one that’s neither 

over nor underexposed. Select this as your 

chosen custom white balance reference image.

Adjust your white balance to save time in post-productionShooting
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Before

Underexposed results

Using the camera’s default 

metering mode, the camera 

has exposed for the bright 

background, causing our subject 

to be underexposed and thus cast 

in shadow

Correctly exposed

By switching our camera over to 

spot metering, we were able to 

expose the image specifically for 

our subject, resulting in a well-

exposed photo 
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Y
our camera’s metering system is an incredibly 

useful tool that enables it to quickly measure the 

amount of light entering the lens and calculate 

the shutter speed and/or aperture setting that it should 

use to capture a well-exposed image.

By default, most cameras are set to matrix metering, 

which takes a light reading of the entire scene and 

determines the optimal exposure settings. When faced 

with trickier lighting and greater contrasts, however, this 

mode can struggle. Switching to an alternative metering 

advantages of shooting with spot metering. In particular, 

we’ll take a look at how to make the most of working with 

this mode in a scene that features deep shadows right 

alongside blooming highlights. Read on to discover how 

to expose effectively with metering modes.

1: Take a test shot
Turn on your camera and with it set to any of the 

your shot, focus and take a quick test snap of 

your chosen scene to evaluate the lighting.

4: Frame up
Remember that spot metering will only meter 

for the small area around the central AF point in 

your chosen frame, so ensure that it is positioned 

directly over your model for a correct exposure.

2: Examine the results
Press the Playback button to review the result. If 

your test shot is incorrectly exposed like ours in 

the example, it’s time to use a different metering 

mode to achieve a more accurate exposure. 

3: Switch to Spot Metering mode
Now access your camera’s metering modes 

by either pressing the shortcut button or going 

through the settings menu. From the list of 

modes, select Spot Metering and continue.

5: Recompose the shot
If your subject is towards the edge of the frame 

you can hover the central AF point over them and 

press the Exposure Lock (*) button to store these 

settings, allowing you to recompose the next shot.

6: Shoot and review
Once you’ve framed up, focus on the subject and 

take the shot. Press the Playback button to check 

the results – the shot should be correctly exposed 

for the subject, not the bright background.

Master spot metering
Discover how to take correctly exposed images in even the trickiest of lighting 
situations using your camera’s different metering modes
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150  Ultimate photo fixes

160  How to fix colour casts

162  Recover lost shadow details

164  Rescue clipped highlights

166  Reduce camera shake

168  Boost colour in select areas

170  Increase tonal range

172  Replace a dull sky

Follow these simple tutorials 
to improve and enhance 
your problem photos
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Change the way you shoot, 
edit and process images

Using RAW
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TOP TIPS
Edit in RAW
Repair prints
Recover
shadow detail
Edit exposure
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Spot Healing
Master basic fixes like Spot Healing, 
Cloning and Content-Aware Fill

Boost colour
Learn how to get bright and 
more precise with individual 
colours in a picture

Enhance details 
Bring out the very best 
in your portraits by 
smoothing skin, editing 
exposure, boosting 
contrast and more



Tips|Tricks|Fixes

Photography Tips, Tricks & Fixes 151

Master the essential photo fixes in this guide and make your shots shine

I
t was once a novelty to possess a pinhole or 

Polaroid; more common perhaps to own a film 

or disposable camera. Then came the digital era, 

in which photography became more convenient and 

a popular pastime for many. Now, with the boom of 

the smartphone and social media, most of us have a 

camera in our pocket.

 The satisfaction of a beautiful picture has stayed the 

same though; it might be a selfie of your family for your 

phone’s lock screen, or a sunrise patiently captured with 

the best kit known to photographers. But no photo is 

beyond a little improvement.

 Every Photoshop user should have the shortcuts 

of photo enhancing in their arsenal; procedures that 

provide simple solutions but which you can also be 

creative with and have some fun. 

 In a world where everyone is taking and sharing 

photos, you don’t need to be a top photographer for 

your snaps to stand out. You just need some tricks up 

your sleeve, like the ones provided here.

Patching
Fix annoying, flyaway 
hair with very little effort, 
and minimalise your 
time spent on erasing 
unwanted details

Ultimate
photo fixes
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Many of your digital photos won’t need a heavy editing hand to turn them from an average image 

to a good one. Rather, you will find that there are certain tools and processes that you will use time 

and time again for big improvements. In this section, we will be looking at how you can quickly and 

easily correct colour, exposure, composition and more using the most basic of tools. These tips 

should be your first port of call when editing an image, as it prepares them well for using in more 

creative projects. 

Improve your images using some of the most common Photoshop tools

General fixes
for your photos

Before

Make colours stand out

If you want to focus on one particular 
colour, try sliding the Hue up to 8 
points either side of the original colour 
in the Adjustments. This can turn 
red colours slightly pinker and blue 
colours slightly more cyan, which really 
makes a selected colour stand out

Boost skies
The Smart Brush 
tool in Photoshop 
Elements gives you 
quick blue skies 
with very little effort

Curves
Using Curves, or Adjust 
Color Curves, you can 
make very powerful 
edits to colours, adding 
impact to a scene

4: Smart Brush
A great way to boost colours in Elements is to 

use the Smart Brush tool. Options such as Blue 

Skies and Intensify Foliage target specific colours. 

Simply paint over the area you want to adjust. 

3: Color Curves
In Adjust Color Curves, you can pick presets and 

see how it affects the colours in your image. The 

curve diagram changes to reflect your choices, 

helping you understand what curves can do.

2: Curve control 
Curves control colours and tones. In Photoshop, 

visit Image>Adjustments and tweak the curve. 

Elements has a useful option called Adjust Color 

Curves, found at Enhance>Adjust Color menu. 

1: Hue/Saturation
Hue/Saturation is applied as an adjustment layer 

or through Image>Adjustments in Photoshop). 

Sliding the Saturation control right boosts colours, 

while Lightness increases luminosity. 

Boost your colours
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Create the lomo effect Go black
and whiteJust by controlling the RGB 

curves separately, you can create 

a Lomo effect. Pull the top half of 

the red curve upwards, and the 

bottom half of the green curve 

downwards; then pull the top half 

of the blue curve downwards 

and the bottom half upwards, to 

create a backwards ‘S’ shape.

One way to improve colour in your 

photos can actually be to remove it 

altogether. Some images look better in 

black and white, as it adds drama and 

impact. There are many ways to turn a 

photo monochrome, but we suggest 

trying a Black & White adjustment layer 

in Photoshop.

Sometimes the simplest of tools can make 

a really big difference to your photos. For 

example, the Crop tool is a great way 

of improving your composition with little 

effort. In both Photoshop and Photoshop 

Elements you can use the Crop tool and 

constrain it to a certain ratio or resolution. 

You can also turn a grid on to help you 

figure out the best way to crop. 

Crop images 
for better 
composition

Before

Before

3: Levels adjustment
The triangles underneath the histogram control 

shadows, highlights and midtones. By moving 

them you can change an image’s exposure. Hit 

Auto, then experiment to get the right exposure.

4: Shadows/Highlights 
The Shadows/Highlights command is found in 

the same menu options as Levels. This lets you 

precisely control the exposure of the shadow and 

highlight points across your whole image.

2: Use your Levels 
Levels is the best tool to adjust exposure. In 

Photoshop it’s in Image>Adjustments>Levels. 

This brings up a histogram showing the 

distribution of tones across your image. 

1: Use the Exposure control
Elements has a built-in quick fix for exposure 

issues. In Quick mode, choose Exposure 

and choose the thumbnail that gives the best 

improvement. The slider lets you adjust the effect. 

Adjust your exposure
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Content- 
Aware Fill
Removing distracting elements 

over a gradient background 

can be a challenge by hand; 

it’s really difficult to get the 

gradient to match up. The 

Content-Aware feature makes 

this much easier. The simplest 

application is found in the 

Edit>Fill command. Create a 

selection around a distracting 

element and go to Edit>Fill and 

choose Content-Aware from 

the Use options.

1: Identify elements for removal
Here’s an adorable image, but there are some 

areas that can benefit from some attention. Things 

like the light splash on her cheek, the stump in the 

background, sheds over the fence, and flyaway 

hairs can all be removed to create a better image. 

2: Remove the stump
The most egregious visual distraction is that ugly 

old stump. Create a selection around it and go to 

Edit>Fill. Choose Content-Aware and hit OK. If the 

results have a strange halo, use the Clone Stamp 

to treat those areas.

3: Remove flyaway hair
The tiny strands of flyaway hair can be easily 

cloned out by sampling the background area just 

above or below the hair, then carefully tracing 

along the strand. Make sure the boards line up or 

the edit will be obvious.

Almost every photo contains 

something unintentional. Maybe it’s 

an aeroplane interrupting your sunset; 

perhaps an ugly bus barrelling across 

your serene country landscape. 

Whatever it is, if you don’t want it there, 

Photoshop can remove it. The Clone 

Stamp tool was created for this very 

purpose, and Photoshop’s Content-

Aware features make short work of 

issues that used to require a lengthy 

adjustment. The main concept behind 

the technology is to create sample 

areas from the surrounding pixels, 

then use those samples to fill in the 

targeted area. It can work wonders for 

distracting background elements, or 

flyaway hairs and facial blemishes. 

Now you see it, now you don’t! 
Remove problem areas with ease

Cloning & 
Content-Aware

Before
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Clone 
Stamp edit

Work together

The Clone Stamp tool is a classic solution 

to the problem of removing distracting 

elements. The technique involves sampling 

pixels from one portion of the image 

to paint over another area. To sample, 

hold down Alt/Opt and click on the area 

you want to sample. Then paint over the 

element to remove, and the tool copies, 

or clones, pixels from the sample point to 

paint with.

By working the tools in conjunction with 

each other, even large portions of an 

image can be successfully removed 

and replaced with synthetic background 

area. The trick is to continue working the 

area after the first tool application. If the 

Content-Aware results are not desirable, 

create a new selection and try again. Then 

use the Clone Stamp tool for a final tidy.

4: Remove the sun spot
For the spots on the girl’s cheek, try first to 

remove them by making small selections and 

using Content-Aware Fill. However, you should still 

be prepared to use the Clone Stamp to perform 

additional edits.

5: Tidy the background
Use the Clone Stamp tool to brush out the shed 

and roof in the background over the fence. Don’t 

just select a single sample point, or the image 

will show repetition. Change the sample point 

frequently to maintain variety.

6: Apply final touches
After the unwanted elements are removed, 

add the final edits to finish the photo. Consider 

treatments, such as increased Clarity in the 

Camera Raw Filter, and adding an Iris Blur. These 

effects will help hide the cloning edits.

Clone Source panel

When attempting to align a 
sample point for the Clone 
Stamp tool, you might be 
reluctant to change the 
sample point and lose the 
alignment. To solve this, go 
to Window>Clone Source. 
The icons along the top of 
the panel allow you to save 
up to five sample settings

Clear areas
Content-Aware Fill makes light 
work of removing small items 
from your images, such as the 
unsightly stump in our original
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1: Remove blemishes
Using the Spot Healing brush, click on the facial 

skin blemishes and imperfections to quickly 

remove them. You can also create a degree of 

skin smoothness by painting away rough areas. 

The Patch tool is actually 

a superior solution to the 

Content-Aware Fill feature. 

But it doesn’t get the same 

attention because it’s not fully 

automated. Instead it blends 

the Content-Aware technology 

with artistic direction to 

produce better results. Select 

an area you wish to remove, 

then set the tool to Content-

Aware and drag the selection 

to a sample area and let 

Photoshop handle the rest!

While the Clone Stamp and Content-Aware Fill tend to get most 

of the retouching spotlight, they are far from the only players 

on the Photoshop stage. There’s an entire supporting cast to 

explore. Two great places to start are the Spot Healing brush 

and the Patch tool. Both have Content-Aware technology 

integrated into their functionality, and are very helpful for 

seamlessly removing elements the other tools struggle with. 

They work on very similar principles, but provide a means of 

guiding the automated process to make sure the tool isn’t pulling 

pixel information from an unwanted source.

The Spot Healing brush and Patch
tool enable simple retouching

Alternative 
cloning tools

2: Remove flyaway hair
Individual strands of hair can be easily traced over 

and then removed with the Spot Healing brush. If 

the background area of the image is a solid colour 

or a simple gradient, the Patch tool can quickly 

remove entire areas of stray hair.

3: Remove other distractions
Now remove any other distracting elements. Here 

we removed the hand peeking into the frame with 

Content-Aware Fill and the Healing Brush. A touch 

or two of the Clone Stamp tool can be helpful for 

areas the automated process can’t figure out.

4: Add warmth and boost
Finish up by adding a Photo Filter adjustment 

layer to add warmth to the image as well as a 

Curves adjustment layer. Use a subtle S-shape 

for the curves in order to give the contrast a bit of 

a boost.

Quick retouching
The Patch Tool

Before

Controlled hair
Remove any unwanted 
elements seen in the 
background or the 
foreground areas of 
portraits. This keeps 
the visual focus locked 
onto the subject
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It’s not just background distractions that are subject 

to removal. Foreground intrusions can be eliminated 

just as easily. In this image we cleaned up the 

branches sticking out in front of the girl’s 

blouse and leg. We also removed the 

vine in the background, and the utility 

box attached to the tree – all with a few 

simple sweeps of the Clone Stamp tool 

and the Content-Aware Fill.

Foreground 
intrusions be gone!

Spot 
Healing 
Brush
The Spot Healing brush 

is ideal for removing 

small areas, such as skin 

blemishes or strands of 

flyaway hair. The difference 

in this tool is that you don’t 

need to define a sample 

area first. The tool calculates 

it from the surrounding 

pixels. The key is to keep the 

brush size just slightly larger 

than the target spot or hair, 

so that the result blends in to 

its surroundings seamlessly.

Subtle deletions
Foreground elements such 
as twigs and foliage don’t 
necessarily ruin a picture, 
but their removal certainly 
improves matters

Change the blend mode

Many of the brush-based tools 
include an option for changing 
the blending mode. Darken or 
Lighten help target stubborn 
pixels that resist change in the 
normal settings. Just remember 
to return the setting to Normal 
when you’re finished

Before
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The Filter menu offers an array of creative 

effects, including options that turn your images 

into works of art. But transforming photos into 

frescos is not all the Filter menu offers. There’s 

a great selection of tools that help enhance 

your images but also fix problem areas.

Here we take you through some of the key 

features within the Filter menu. You’ll learn to 

correct lens distortions, reduce noise in low-

light captures, smooth skin and sharpen up 

soft shots. Follow the tutorial and find out how 

to use the Unsharp Mask filter for sharper shots 

in only a matter of minutes and a few clicks.

Find out how to fix up your 
photos with Photoshop’s filters

Find the best
filter fixes

1: Duplicate the layer
Open the image to sharpen in Photoshop. 

Right-click on the Background layer and select 

Duplicate Layer. Re-name to Sharpen Layer and 

click OK. Now select your new layer to activate it. 

Go to Filter>Sharpen>Unsharp Mask. 

3: Sharpen the edges
Select the Radius slider, which controls the 

sharpening lines. These need to be wide enough 

to make a difference, without being noticeable. 

Around 1.7 pixels works for large prints. Less is 

good for smaller prints or online use.

2: Adjust the amount
Select the Preview icon and zoom in to an area 

you want to appear sharper. Slowly increase the 

Amount slider, which determines how strong the 

sharpening will be. Start at 100%. You can change 

this later.

4: Fine-tune the results
The Threshold slider should be kept low, between 

1-10. Set it to around 2, which will ensure the 

image appears sharp but also prevents any noise 

becoming noticeable. Once you’re happy with the 

results click OK and then save your image.

Sharpening effect
The Unsharp Mask filter 
affects the entire image. 
To sharpen only specific 
areas of an image, 
use layer masks or the 
Sharpen tool found in 
the Tools palette

Close up
Close-up captures 
or portraits should 
always be sharpened, 
as the viewer will be 
drawn to a much 
smaller area of focus

Sharpen for output

How much sharpening you apply 
depends on the image’s output. High-
quality canvas prints can withstand 
more sharpening, so set the Radius 
between 1.0-2.5 pixels. For smaller 
prints, set the Radius between 0.4-1.0 
pixels and for websites between 
0.2-0.3 pixels

Before
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Create 
Smooth skin
Adding a little blur to shots is a great way to 

smooth skin for flattering portraits or even 

enhance a background blur effect you’ve 

maybe not managed to capture in-camera. 

Explore the blur options within the Filter menu 

for different effects. Surface Blur is great for 

softening skin; in the dialog box simply bring 

the Radius slider up to around 60 pixels and 

pull the Threshold up to 7.

Reduce noise
This is one problem that 

pretty much everyone has 

experience of. If you’ve taken 

an image in low light without 

the use of flash, your camera 

will often select a higher ISO 

setting, which makes the 

camera more sensitive to 

light so that you get a brighter 

exposure. However, high 

ISOs introduce noise into your 

images. In order to reduce the 

appearance of noise, go to 

Filter>Noise>Reduce Noise. 

Within the dialog box, adjust 

the Strength and Preserve 

details sliders to reduce 

luminance noise, and use the 

Reduce Color Noise slider for 

taking control of any colour 

noise in your image. 

Correct 
distortions
Within the Filter gallery you’ll find plenty 

of useful tools, including Lens Correction. 

Use the filter to fix optical distortions 

created by some camera lenses. It’s a 

fantastic tool that will not only help you to 

remove barrel and pincushion distortion, 

so that the lines appear straighter in your 

shots, but also reduce obvious chromatic 

aberration, vignettes and even correct the 

image perspective caused by vertical or 

horizontal camera tilt. 
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1: Balance
One way to correct colour in Photoshop Elements 

12 is use Quick mode using the top buttons, and 

choose Balance. Use the slider to offset the cast, 

moving it to the right to reduce a blue cast. 

1: Adjustment layers
Adjusting colour in Serif PhotoPlus can be done 

with adjustment layers. To add a new adjustment, 

go to the Layers menu along the top and down to 

New Adjustment Layer>Color Balance.

1: Choose photo
Open Photoshop Touch and tap the middle 

button at the bottom. Pick the Gallery option to 

load one of your photos. Tap it to go into the app.

How to fix colour casts
Take control of terrible hues and learn to balance colour to create the 
best version of your image

W
hite balance, or colour temperature, is usually taken care 

of by the camera automatically at the moment an image is 

captured, but it’s not always accurate. Auto white balance 

settings can struggle in strong or mixed lighting conditions, which will 

result in unwanted colour casts. When an image has the wrong colour 

balance, it will appear to have an obvious tint of either blue or red. The 

strength of this tinting can vary widely, and in some cases, damage 

colour in your image beyond repair. 

To help you sort out your white balance woes, we have picked out 

three applications that can correct colour casts quickly and accurately. 

Join us here as we show you how.

Photoshop Elements

Serif PhotoPlus

Photoshop Touch for phone

Goodbye blues!

No longer is this image 
suffering from a poor colour 
cast – just a few easy tweaks 
and the strong, bluish tint 
can be reduced

After

Before
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2: Expert mode
If the first method doesn’t work, try going into 

Expert mode. In the Enhance menu along the top 

of the interface, find Auto Color Correction. This is 

an instant way to fix a subtle colour cast.

2: Color balance
The adjustment will show in the Layers panel. If 

it’s not there, double-click on the Color Balance 

thumbnail. As this image is predominantly blue, 

start by changing Yellow/Blue to show 0, 0, -31.

2: Image fixes
Tap the Adjustments button at the top. A menu 

with a number of fixes appears. Try Auto Fix first, 

but if you dislike it, use the back arrow (top-right).

3: Remove colour cast
Another method is to go to Enhance>Adjust 

Color> Remove Color Cast. Use the eyedropper 

to click on parts of the image that should be 

black, white or grey, until normal colours return.

3: Green hues
There’s still a hint of a green cast in the shadows. 

Slide the Magenta/Green adjustment to -10 (the 

figures should be 0, -10, -31). That’s the midtones 

fixed. Now click on the option for highlights.

3: Temperature
Go back to Adjustments to choose Temperature. . 

This gives you one slider to control the amount of 

blue and red, to cool down or warm up the photo.

4: Warming Filter/Cooling Filter
You can also go to Layer>New Adjustment 

Layer> Photo Filter. Use a Warming Filter (81), 

at 50-60% Density, with Preserve Luminosity, to 

offset blue casts. Use Cooling Filters for red casts.

4: Blue hues
You can still see blue hues in the white areas. 

Slide the Yellow/Blue down to -15 to colour 

balance the highlights. View a before and after of 

the image by clicking the layer’s eye symbol.

4: Adjust blues
To reduce a strong, blue cast, change the slider 

to 45-50%. Tap the tick button to confirm the 

changes, and Done in the top-left to save.
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Before

Handy hint for similar settings

If you’re editing a burst of images that 
are similar in tone and content, you can 
save your edit information as a preset to 
use again and again
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Recover lost shadow detail
Use the Shadow/Highlights tool to bring back detail in the darkest of images

E
xposing an image correctly is one of the key 

elements of a great shot, but unfortunately 

shooting conditions can be unpredictable. 

Certain weather conditions – harsh sunlight, overcast 

skies – can lead to details being lost in shaded areas. 

The traditional method to overcome this would be to 

use a reflector or flash to bounce or fill in light into the 

area, but you might not have these to hand. Thanks to 

advances in software, however, you can now easily fix 

this in post-production. 

Software like Photoshop and Elements feature an 

array of powerful adjustment tools to help edit shadow 

detail and harness contrast. Here, we will focus 

specifically on the Shadows/Highlights panel.

To follow along, use an image that’s dull and 

overexposed. This is a fantastic tool to help you 

bring back this level of detail that would usually be 

lost. Featuring both an Advanced mode, as well as a 

simplified view, it caters for all levels of experience, and 

the slider-based control makes amendments easier.

1: Pick Shadow/Highlights
Open your image in Photoshop. If you want to 

make edits, such as cloning or cropping, do these 

first, but steer clear of colour or contrast. Then go 

to Image>Adjustments>Shadow/Highlights.

4: Darken your highlights
In order to avoid halos, use the Highlight section 

and alter the Amount to 75%, the Tonal Width to 

65% and the Radius to 485px. This will give you 

the darker tones, but with a lot more subtlety.

2: Set your skill level
Once you select Shadow/Highlights, you’ll see the 

image change automatically to a built-in preset. 

You can alter this via the two main sliders, or pick 

the Show More Options tab for more control.

5: Correct the colours
We’re converting to black and white, so we want 

to keep plenty of detail. Using the sliders, increase 

Color Correction to +75 and alter Midtone 

Contrast to +30 to increase colour contrast. 

3: Make your adjustments
For this image, we’re converting to black and 

white, so we want plenty of shadow detail. Using 

the Shadow sliders, alter the Amount to 35%, the 

Tonal Width to 80% and the Radius to 125px.

6: Final presentation
Crop your image and convert to black and white 

at this stage (go to Image>Adjustments>Black & 

White). Use a Curves adjustment to add drama to 

your shot in Image>Adjustments>Curves.



Tips|Tricks|Fixes

164 Photography Tips, Tricks & Fixes

Rescue clipped highlights
Use Photoshop’s histograms and adjustments to correct clipped detail in overexposed images

C
lipped highlights is one of the most 

problematic areas of photography that 

you’ll come across when capturing 

images under bright daylight. As the dynamic 

range of a sensor isn’t as wide as the human 

eye, we need to call upon a number of 

techniques to control clipping. Bracketing is one 

such way to avoid clipping, but what if we only 

have one image to work with? 

Clipped areas in this image include the 

central parts of the sky and some of the 

paintwork on the car. Where there should 

be texture and vibrant colour, there’s just 

a bleaching of white. Using Photoshop’s 

colour histograms, we can view the balance 

of red, green and blue throughout the 

image. Unfortunately, not all the lost detail 

in the image can be retrieved, but using the 

following techniques you’ll find that there’s still 

a considerable amount of detail and texture 

waiting to be exposed.

Detailed highlights

What wasn’t visible before 
applying a handful of key 
adjustments can now be 
spotted, such as smaller 
clouds in the distance



Tips|Tricks|Fixes

Photography Tips, Tricks & Fixes 165

1: Histogram view
Open up your image. To get a better look at the 

exact clipped areas, go to Window>Histogram. 

From the small drop-down menu inside the 

palette, select All Channels View, and set Channel 

to Colors. 

2: Selective checking
This graph shows the majority of the blue and 

some red and green areas falling outside the 

visible spectrum. You can use the Rectangular 

Marquee tool to select and analyse certain areas 

of colour.

3: Clipped levels
Another way you can view where clipping occurs 

is by going to Image>Adjustments>Levels. This 

time, just hold Opt/Alt while clicking on the far 

right marker under the histogram to show the 

clipped areas.

4: Duplicate the background
To begin retrieving detail in clipped highlights, 

start by creating a duplicate of your chosen 

image. This can be done by pressing Cmd/Ctrl+J, 

or by dragging the layer onto the Create A New 

Layer button.

5: Adjust shadows and highlights
Now you can continue by going to 

Image>Adjustments>Shadows/Highlights. 

This adjustment will then automatically lighten 

shadows, but you can choose to undo this by 

setting the Shadows Amount slider to 0%. 

6: Control highlights
Increase the Highlights Amount slider to 35% 

to start seeing details return to areas of clipped 

exposure. Increasing this too much, however, can 

create banding across transitions from dark to 

light areas.

7: Restrict the tones
0Tick the Show More Options box in the 

Shadows/Highlights adjustment and then 

decrease the Color Correction slider to 0, and set 

Midtone Contrast to -35%. Hit OK to confirm the 

adjustments you’ve made.

8: Enhance saturation
Go to Image>Adjustments>Hue/Saturation and 

set Saturation to +15. Use the Eye icon on the 

layer to view a before and after of the image. Our 

image now has more detail on the car’s body than 

before. And we’re done!

Before

Overexposed areas lose detail, colour and 

texture, but Photoshop has the tools to fi x this
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L
ow-light photography can be a 

challenge with a handheld camera. 

The longer the shutter is open, the 

more light your sensor has to work with, 

but this also means you run a higher risk 

of blur caused by the camera’s slightest 

movements. These shots are ordinarily 

bound for the recycle bin as they are 

practically worthless. 

With Photoshop CC’s Shake Reduction 

filter, however, hope is not lost. This feature 

can recover details that were blurred or 

softened by slight camera movement. 

While it’s not possible for this filter to fix 

out-of-focus photos, the majority of images 

affected by simple handheld motion blur can 

be easily restored to their envisioned glory.

Reduce 
camera 
shake in CC
Use a fantastic new feature in 
Photoshop CC to reduce blur 
caused by camera movement

4: Blur Direction tool
Use the second area, the Blur Direction tool, to 

manually trace along a visible motion blur. This 

will only work when focusing on small blurs that 

still have recoverable details, so keep the Trace 

Length small.

1: Make it a Smart Object
The Camera Shake Reduction tool supports 

Smart filtering, so it’s a good idea to apply it in 

that form. Open your image, Ctrl/right-click on the 

layer thumbnail and select the Convert To Smart 

Object option.

3: Set the Blur Trace bounds
Resize the default outline area in order to enclose 

the most noticeable blur. In our image it’s the 

church building. Check the Preview option and 

adjust the Blur Trace bounds in order to get the 

best effect.

5: Preview effects
Notice how the Advanced section shows 

estimation region thumbnails. Each of these is 

represented by a pin on the main image. The 

preview shown is also just a rough estimation of 

the final effect.

2: Shake Reduction
The Shake Reduction is considered a sharpening 

effect, and rightfully so if the intent is to remove 

motion blur. Go to Filter>Sharpen>Shake 

Reduction. Then you need to make sure the 

Advanced tab is open.

Before
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Reduced motion blur

The new filter goes a long 
way to reduce the blurring 
effect caused by the camera 
shake. It can recover details 
previously thought to be lost

7: Reduce noise
Go to Filter>Camera Raw Filter and switch to 

using the Details tab. In the Noise Reduction area, 

you can adjust the Luminance and Luminance 

Detail sliders in order to assist in eliminating the 

visible noise.

6: See the results
Hit the OK button and let Photoshop process the 

filter. Examine the results. The image is certainly 

much sharper, but the process has introduced 

some noise and other artefacts that aren’t really all 

that desirable.

8: Finish up
While the Camera Raw Filter is still open, make 

any other processing adjustments you deem 

necessary. In our case, we have increased the 

Clarity and Vibrance, and added a slight lens 

vignette too.
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Boost colours in select areas
Use PhotoDirector to apply colour adjustments to the parts of an image that need them the most

C
yberlink’s PhotoDirector 5 Ultra is 

capable of applying a vast number of 

edits to a photo and readying them 

for print. Adjustments can be done selectively 

or globally to an image, giving you control over 

which subjects are altered. In the following 

steps we demonstrate how you can improve 

colour and tone to different parts of an image 

using a handful of quick tools in this software. 

This technique is definitely a great way 

to single out parts of an image for selective 

enhancing, whether it’s to colour, exposure 

or sharpness. We look at how to apply 

PhotoDirector’s Regional Adjustment tools 

to improve the blues in the sky and then the 

foreground colour as well, while avoiding the 

building in the mid-ground. Using a mask 

formed by a gradient, any adjustments remain 

consistent and uniform. There’s also a special 

brush that enables adjustments to be painted 

on freely.

Enhance your colours

Using Vibrance and Saturation 
sliders with the Regional 
Adjustment tools, colour can 
be injected into the foreground 
and background areas
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1: Open your image
To load an image into PhotoDirector, click on 

the first plus symbol inside the Project tab under 

Library. Inside the pop-up box, pick the source 

folder containing the image, then click on Import 

to open.

2: Load toolset
Head into the Adjustment section of the software 

using the tabs along the top. By default the Global 

Adjustment Tools will be listed for you. Hide these 

and reveal the Regional Adjustment Tools by 

using the arrows.

3: Gradient masking
 To improve just the sky area, click on Gradient 

Mask under Regional Adjustment tools. Draw a 

straight line from the top of the sky downwards 

until it has been covered by the red mask that 

fades out.

4: Improve colour
Now go to the Tone section of adjustments. 

Increase the Vibrance slider to strengthen the 

colour in the masked area. View a before and after 

comparison by clicking the pencil and box button 

under the photo.

5: Adjust with brushes
With the sky adjusted, click on the Adjustment 

Brush option under Regional Adjustment Tools. 

This allows you to paint adjustments over parts of 

your image that need it the most, with control over 

the sliders.

6: Add colour selectively
Before using the brush, you should boost 

Saturation to between 20 and 30 (this can be 

turned down later). Set the brush Size to 36 for 

even coverage and paint over the elements that 

have dull colour.

7: Enhance further
After brushing over the parts of your image to 

improve saturation, it’s time to start adapting 

additional sliders, such as Vibrance, Exposure 

and Contrast, to enhance the image according to 

your liking.

8: Add more masks
You can choose to include extra masks using 

the Mask drop-down list to add colour to other 

areas of the image. Using masks will help you 

to separate areas of the image for particularly 

selective adjustments.

Before

Post-shoot analysis of the 

shot reveals that colours were 

lacking saturation and impact
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Increase tonal range
Create HDR exposures using luminosity masks to control the entire tonal range of your image

T
his technique of creating luminosity 

masks is a way of splitting up the 

exposure of an image through its 

shadow, midtones and highlight regions. 

Just like normal masking you’re used to in 

Photoshop, where some parts of the image are 

hidden and others revealed, a luminosity mask 

is used to hide the lights from the darks and 

vice versa. 

In these steps we will show you how to use 

multiple luminosity masks with the Curves 

adjustment layer to create the ultimate HDR 

effect. To start off with, a basic luminosity 

mask needs to be made to reveal just the 

midtones to highlights. By using a sequence of 

clever shortcuts in Photoshop, we can create 

increasingly smaller selections of the highlight 

regions and mask them out from everything 

else. By continually making smaller and smaller 

selections, the areas used for the luminosity 

masks become finer and finer.

Luminosity control

The Curves adjustment was 
used here with luminosity 
masks for controlling the 
entire brightness range of 
just one image
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1: Load selection
You can get started by creating a luminosity mask 

for the highlights in the image. To do this, go to 

the Window menu in Photoshop and down to 

Channels. Cmd/Ctrl-click on the RGB channel to 

load a selection.

2: Mask highlights
While the selection is active, you can create a 

Curves adjustment layer from the options at 

bottom of the Layers palette. Now we have a 

Curves adjustment with its mask showing just the 

highlight areas.

3: Control exposure
The exposure of the highlights, or the sky in this 

particular image, can be controlled by changing 

the Curves adjustment. Pull from the centre of the 

diagonal line in a downward direction to darken 

the sky.

4: Brighten highlights
A similar mask can be used on even brighter 

sections. Cmd/Ctrl-click on the mask of the 

Curves adjustment layer to load it as a selection, 

then Cmd/Ctrl+Alt+Shift to create a second, 

smaller selection.

5: Make multiple adjustments
You can now continue by adding another Curves 

adjustment layer using this smaller selection and 

adjust the brightness of the highlights to create 

a more dynamic image. Repeat this step for 

improved HDR.

6: Mask the shadows
To create a mask for the shadows in your chosen 

image, Cmd/Ctrl-click on the mask of the first 

Curves adjustment layer made. Then go to the 

Select menu and click on Inverse to flip the 

selection around.

7: Shape the effect
With the mask active around the shadow regions, 

add a new Curves adjustment layer and place 

below the other layers. Pull the diagonal line 

upwards in the lower half to brighten the shadow 

regions in the image.

8: Darken shadows
Reload the selection from the mask, and then 

press Cmd/Ctrl+Alt+Shift-click over the mask to 

load a smaller selection for the darker areas. Add 

another Curves adjustment and then edit the final 

shadows in the image.

Before

Exposing both a bright 

sky and a shadow-

heavy foreground isn’t 

easy. We can bring out 

details with multiple 

luminosity masks
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O
f all the elements that need to work 

in order to create a great landscape 

shot, the sky is often the one that 

ends up letting you down. A great image is 

very much dependent on the presence of just 

the right degree of cloud coverage; you won’t 

be able to easily achieve strong visual interest 

in your photos without the varying textures and 

clouds, sunsets and sunrises can easily be a 

Replace a dull sky
Improve your scenic shots by exchanging an 
uninspiring sky for a much more appealing one

little dull. Too much cloud, meanwhile, will result 

in another set of issues, but the perfect balance 

isn’t necessarily going to occur precisely when 

you need it to.

Many photographers solve this problem by 

replacing a bland sky with a more dramatic one, 

captured on a separate occasion. This approach 

may not appeal to purists, but it can produce 

very effective results, provided that you use the 

right editing techniques in Photoshop.

Tips|Tricks|Fixes

Appealing seascape

By replacing the original, 
boring sky with a much 
more attractive one using 
Photoshop, the final image 
does the scene justice
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1: Drag and drop
Start by opening both files – the main image and 

the image containing the replacement sky – in 

Photoshop. Select the area of sky you want to use 

and use the Move tool to drag and drop this onto 

the main image.

2: Convert to Smart Object
Before you get started with the process of 

manipulating the sky in order to reappropriate 

it for your main photo, convert it into a Smart 

Object. This should help to prevent the quality of 

the sky degrading.

5: Refine the blend
Once you have done this, you may find that you 

need to tidy up the blend using the Brush tool (B), 

so create a Layer Mask for the sky layer and then 

work with a black brush to do this, varying the 

Opacity of the Brush tool.

8: Final touches
To unify the two different elements of the new 

photo better, try using the Color Balance (Cmd/

Ctrl+B) adjustment to warm the entire scene 

slightly. Drag the top and bottom sliders towards 

red and yellow.

4: Blend the sky
Cmd/right-click the sky layer in the Layers palette 

and select to view the Blending Options. Use the 

This Layer and Underlying Layer sliders under the 

Blend If section to blend the photos. This will be 

more effective than opting to use masking.

7: Change the foreground
Use the Move tool (V) in order to create a mirror 

effect with the sky, then change the blend mode 

of the sky to Soft Light. Create a Layer Mask and 

then use the Brush tool (B) set to black to refine 

the mask.

3: Transform the sky
Press Cmd/Ctrl+T to activate the Free Transform 

tool. Ctrl/right-click the sky layer and adjust the 

scene as necessary so that the most impressive 

section of the sky is visible. Stretch it so it covers 

the original.

6: Duplicate the sky
Flatten the image and make a selection of the sky 

before pressing Cmd/Ctrl+J to copy the selection 

onto a new layer. Make this a Smart Object, and 

then press Cmd/Ctrl+T, Cmd/right-click and select 

Flip Vertical.

Before
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Selectively edit exposure
See how to harness the power of Camera Raw to salvage a poorly exposed shot

E
very digital photographer knows that 

shooting in RAW format grants an 

amazing degree of leeway for correcting 

images. The additional information captured 

is often enough to transform a shot from 

being discarded for bad lighting into a shot 

prominently displayed in your portfolio. 

In this tutorial we will teach you how to 

correct a bad exposure using Adobe Camera 

Raw, including how to make adjustments to 

select areas in your shot, rather than global 

enhancements. This helps when some areas of 

the shot are correctly exposed, but others still 

need a little bit of help. We will then also show 

you some other key edits Camera Raw can 

offer you. 

Keep in mind that this approach works best 

using RAW images, but can still be used on 

images shot in JPEG as well. The techniques 

are the same – the only difference is the range 

of light information you have to work with.

Regal return

After some quick corrections 
in Camera Raw, the image 
has been rescued from 
being sent to the scrap heap 
due to bad exposure
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Before 1: Launch Camera Raw
Open the image in Camera Raw. If the image 

is a RAW file, opening it in Photoshop will 

automatically launch Bridge. If it’s a JPEG file, 

Camera Raw is available through Photoshop’s 

Filter menu.

2: Try Auto
In the Basic Module of Camera Raw, there’s a 

link at the top of the sliders for Auto. This auto-

correction does not always give the best of 

results, but it does provide a good starting point 

for custom editing.

3: Correct the white balance
Above the image is a row of icons – the third one 

looks like a grey-filled eye dropper. Sample an 

area on the image that should be fully white. This 

will help you to remove unwanted colour casts in 

your image.

4: Use manual settings
Make any manual adjustments to the sliders on 

the right that you feel are required. These are 

global settings that affect the entire image. In our 

image we upped the Clarity to 52 and the Whites 

to 57.

5: Adjustment brush
Find the Adjustment Brush icon along the top of 

the image. Use it to generate a type of selection 

over any area you wish to adjust separately. 

The Show Mask option is useful for seeing the 

selection area.

6: Adjust the settings
Next, use the sliders to make local adjustments. 

These will only influence the area highlighted 

by the adjustment brush. We then increased 

Contrast, Clarity, Sharpness as well as decreased 

the Shadows.

7: Crop the image
Use the Crop tool, found in the row of icons along 

the top of the image. Drag out the crop frame 

to correct any concerns about composition and 

image balance. Now double-click the image to 

apply it.

8: Add final effects
Find the Effects tab on the right of the interface. 

Add a Post Crop Vignette for a finishing touch to 

your image. We used an Amount set to -23 with 

Feather set to 84. Press the Done button to save 

all your settings.

This shot of the famous 

Lincoln Memorial is poorly lit 

and certainly doesn’t deserve 

to be placed in a photo frame
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Enhance contrast and colours
Use the Apply Image command to apply blend modes to individual colour channels

After processing

Photoshop’s Apply Image 
command uses the photo’s 
own colour channel 
information with blending 
modes to produce hue-
specific alterations

Before

We will start with 

this portrait. It’s a 

great shot, but the 

colours are washed 

out and a bit bland
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T
here are several different methods 

of adjusting colour in Photoshop. 

One of the less-used, yet remarkably 

powerful tools is the Apply Image command. 

This command is usually used to perform the 

same type of operation that can be done by 

creating a merged layer and setting the blend 

mode. It’s the same effect, but in a dialog box 

instead of a separate layer. However, the Apply 

Image command can actually apply individual 

colour channels. Usually the Channel setting 

remains at the default composite channel of 

RGB (or CMYK, or LaB), but it can be set to 

any channel, even saved selections or custom-

created channels. In this tutorial we explore 

how to adjust the background and skin tone of 

a portrait using this great hidden technique.

1: Background Selection
You can start out by duplicating the background 

layer with Cmd/Ctrl+J. Then use the Quick 

Selection tool to create a selection of the 

background area. Don’t worry about selecting the 

stray hairs yet.

2: Refine Edge
Press the Refine Edge button in the Options bar 

and adjust the settings to get a good selection 

edge. For our image we used the Smart Radius 

with the size to 10px, Smooth set to 12 and 

Feather to 7.6px.

3: Save the Selection
Go to Select>Save Selection. We decided to 

name ours ‘Background Selection’. Photoshop 

stores saved selections as a Channel, so click 

on the Channel panel to see it appear below the 

individual colour channels.

4: Apply Image
Head over to Image>Apply Image. To enhance 

the background, use the Green channel, check 

Invert and set the Blending mode to Overlay with 

Opacity at 63%. Enable Mask to use the last 

saved selection.

5: Adjust skin tone
For skin tone edits, Apply Image again and use 

the Red channel. Use the mask, but Invert it to 

focus on the model, not the background. Then 

set the Blending to Colour Burn and reduce the 

Opacity to 25%.

6: Create a custom channel
The Apply Image command can use any channel, 

not just the default colours that are usually 

available to you. Switch to the Channel panel and 

duplicate the Red channel by taking its thumbnail 

to the New Channel icon.

7: Increase contrast
Use the Levels adjustment 

(Image>Adjustments>Levels) to increase the 

contrast of the image. Pull the outside handles 

inwards to the centre until the model’s skin is 

almost completely white.

8: Use the custom channel
In the Layers panel, you can now run the Apply 

Image command, but this time select the Red 

Copy channel to use the newly created custom 

channel. Set the Blending to Soft Light and 

Opacity to 30%.
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Enhance your portraits 
to perfection 
Discover how the wide range of tools in DxO OpticsPro 10 Elite can 
create professional-looking portraits in moments

1: Correct White Balance
DxO OpticsPro 10 Elite features a number of 

White Balance presets, but you can use the White 

Balance Color Picker to select a neutral area of 

the image to produce a custom setting.

2: Adjust Exposure Compensation
Before making changes to the global exposure 

value of the image, you should activate the 

highlight alerts beneath the histogram so you can 

keep an eye on any areas of clipping.

3: Change the contrast
A simple Contrast adjustment slider enables you 

to tweak the overall contrast of the image. There’s 

also a separate Microcontrast slider, which 

facilitates the adjustment of pixel-level detail.

Create a perfect portraitDxO OpticsPro

D
xO OpticsPro 10 Elite is able to do so much more for your 

images than simply correct optical flaws. Photographers of all 

different genres can take advantage of the wide range of tools 

and facilities that it offers for processing and getting the best quality 

from both RAW files and JPEGs. 

Although it may have close associations with architectural 

and scenic photography, there’s really plenty on offer for portrait 

photographers too, with a portrait-toning preset and Multi-Point Color 

Balance tool, alongside classics, such as the cropping and Unsharp 

Mask tools that are also on offer. Although not the obvious choice, this 

software can be very beneficial to the portrait enthusiast.

In fact, DxO OpticsPro 10 Elite offers you a complete RAW image-

conversion solution, aided by the downloadable camera and lens 

modules that make this software truly unique as an image-editing 

program. In this tutorial, you’ll see how to enhance a portrait in just a 

couple of minutes.

Before
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6: Image correction tools
There’s no need to exit DxO to apply cropping 

or dust-removal adjustments, as these are all 

included in the DxO Interface. Access them in the 

palette on the far-right or at the top of the screen.

7: Localised colour adjustments 

If you’d like to make very specific adjustments 

to the colours, you can use the Multi-Point Color 

Balance tool. Tell the software to preserve the 

integrity of the white balance.

8: Improve the sharpness
Use the Unsharp Mask tool to improve edge 

sharpness and clarity in the image. Remember that 

you’ll need to zoom in to 100% in order to get an 

accurate preview of the changes being applied.

4: Use Selective Tone
This can make your portraits appear more 

professional, as you can target the highlights, 

midtones and shadows in the image. As with 

Exposure Compensation, activate the clipping alerts

5: Colour toning
DxO OpticsPro 10 Elite features toning presets available in the Light and Color menu, including a Portrait 

preset to improve skin tones. The Intensity slider adjusts the strength of the effect.

Professional polish

Just a few minutes spent in 
DxO OpticsPro 10 Elite turns 
the image into something 
that looks far more stylised
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2: Spot the marks
Crop the image by clicking on the first option. 

Look to remove raggedy edges and to straighten 

the image. Click on the Spot Healing tool and 

draw over small specks and white marks to 

remove them. 

1: New view mode
Open an old photo in Elements and click on the 

Guided tab. Now just pick the Restore Old Photo 

option from the list of edits down the right. From 

the top-left, set the View mode to Before & After – 

Horizontal. 

3: Heal pixels
Use the Healing Brush tool on medium-

sized specks and crease lines. Hold Opt/Alt to 

sample ‘good’ areas and then paint over the ‘bad’ 

pixels. Use the Clone Stamp tool in a similar way 

to fix the largest areas.

 Give images a new lease of lifeRestore shots
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Repair old prints
Use Elements’ Restore Old Photo guided edit

D
ig out your old photos and load them into Photoshop 

Elements to restore them back to their former glory in just 

a few clicks. Follow our steps for using the Restore Old Photo 

guided edit, and see how it can work miracles on tattered, scratched 

and torn images.

Over time, photos can deteriorate in quality for a number of reasons. 

These include fading and discolouration, caused by too much exposure 

to sunlight, or bent corners and scratches from being stored loose in 

a box. These, along with other factors, can destroy photos that could 

reveal clues to our past.

If you have images that have suffered from a tear here, or a crease 

there, scan them in and the new Restore Old Photo feature in the latest 

version of Photoshop Elements offers the right tools for undergoing 

some serious restoration. From the Spot Healing tool for dealing with 

those small, indiscriminate blemishes, to the Clone Stamp tool for 

gradually weeding out larger areas such as tea stains or faded 

corners, you’re sure to find what you need.

Once all blemishes have been cleaned up, converting your image 

to black and white will remove any discolouration or sepia toning. 

Sharpening and Dust Removal also form part of this new guided 

edit, but are not necessarily required for every restoration project. 

As a guided edit, Elements makes it very easy for anyone of any 

ability to follow along, but working knowledge of the tools is still 

required for making the best results possible. 

When you’re happy with the restoration, we even show you how 

to really bring the image to life by adding colour. The result is a 

transformation worthy of framing or showcasing in a family tree. Before

4: Complete coverage
Using the Spot Healing, Healing Brush and 

Clone Stamp tools, go over your image to heal 

the remaining problem areas. Be sure to sample 

areas of similar pixels so that the results look nice 

and clean.

5: Restore colour
Finally, click on Convert to Black & White to 

remove the sepia colour. Using Auto Levels and 

Contrast will adjust the exposure back to normal. 

Go back over the image with the Blur tool to hide 

any imperfections.

1: Expert mode
After restoring the image to black and white, 

you can add colour using Brushes. After hitting 

OK in the Guided Edit, click on the Expert tab. 

Click on Create a New Layer at the top of the 

Layers panel.

2: Brush setup
Change the layer’s blend mode to Color. Select 

the Brush tool (B) and in the Tool Options 

choose a soft, round, 100px brush. Click the 

Foreground colour box and set its colour to a 

fleshy tone.

3: Apply colour
Brush over the skin and watch how your old 

image comes to life. Select a dark brown for 

the hair, and light red for the lips. Add new 

layers for each colour applied, setting their 

blend modes to Color. 

ElementsColourise
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Balanced exposure 
Our shot was underexposed to retain detail and colour 
in the sky, resulting in the buildings being in shadow. 
Processing a RAW file means that much more detail 
can be brought back out of the shadows than if you 
used a JPEG file

Pro photographer Chris Humphreys guides 
you through the key ways that RAW editing 
can recover detail and enhance your shots

Refined Colours
Because the RAW file contains 
much more colour information 
than the out-of-camera JPEG 
file, you have more control over 
colour manipulation. The RAW 
file looks far more realistic and 
hasn’t suffered from halo effects 
in the sky or desaturation of the 
stonework like the JPEG file has

Essential RAW 
photo fixes
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R
AW files are the digital equivalent 

of the unprocessed film, with most 

pros shooting and editing RAW 

extensively. RAW files are not images – they 

are a collection of uncompressed data from 

the camera’s sensor along with information 

on the shot’s settings at the time of shooting. 

This data needs specific software to process 

it and turn it into an image. JPEG files from 

the camera have been processed with the 

camera’s firmware, so while you can tell it 

Edited from RAW Unedited 
JPEG
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Lost features 
By shooting in JPEG exclusively, you 
limit your scope for extensive edits to 
the images. In this example, the details 
in the shadows were irretrievable

Extreme detail
This shot benefitted greatly from the 
16,000+ levels of brightness in the 
14-bit RAW file compared to 256 in 
the 8-bit JPEG image. The RAW file 
retains so much more detail, enabling 
greater manipulation of exposure, 
shadows and highlights without 
compromising on image quality

Easily edited
The original JPEG image has already 
had in-camera noise reduction and 
sharpening applied, whereas the 
RAW file is unedited and can be fine-
tuned for noise and sharpening much 
more easily. The higher levels of detail 
retained also help to limit noise and 
make for more effective sharpening

“Shooting RAW 
opens up many 
possibilities”

to use certain settings to process an image, 

you are essentially handing over control to 

your equipment.

Tapping into the potential of a RAW file 

can open up many possibilities, not only 

processing, but how you go about shooting. 

Shooting RAW gives you more scope to correct 

exposure errors in post-processing, enabling 

you to concentrate on capturing the moment. 

JPEG still has its place – watch any live 

sports and you’ll see pros shooting JPEGs 

and uploading them instantly, only possible 

due to smaller sizes. Each file type is useful 

in different situations, but read on to find 

out how RAW can give you total control 

over your images.

Edited 
from 
JPEG
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Both Adobe Camera Raw and Lightroom use 

the same controls for making adjustments 

to exposure. When we talk about exposure 

adjustments, we don’t just mean the overall 

brightness of the image – we also mean 

setting the points, lifting shadows, suppressing 

highlights and adding tone curves.

Although there are no specific rules, there 

are some key moves that can be applied when 

looking at exposure adjustments. The black 

point and white point define the overall range 

of tones your image will have, so it’s a good 

starting point. Using the Black slider, hold 

down Alt and move it slowly left, pushing this 

edge of the histogram all the way to the far-left. 

Holding down Alt while you do this will turn the 

image white. You will start to see areas of black 

appearing, which represent clipped shadows – 

when you see this, hold back a little.

Do the same for the White slider adjustment, 

except sliding it right to push the right-hand 

edge of the histogram to the right. You’ve 

already locked in the black point, so what 

you’re doing is stretching the histogram to 

cover the image’s full range.

Now look at the Exposure slider, which 

is responsible for the middle third of your 

histogram. We are using this to adjust overall 

image brightness. More often than not, when 

shooting with DSLRs we tend to underexpose 

as it’s easier to pull details out of shadows than 

to recover them from highlights. 

Two of the most useful RAW adjustments 

are the Shadow and Highlight controls. These 

enable you to pull detail out of shadows 

without affecting overall image brightness, and 

to subdue overexposed highlights to show 

more detail. Don’t assume you always want to 

max out these sliders.

Your other main adjustment controls are your 

Contrast slider and Curves tab. Both will add 

or remove image contrast by spreading out the 

midtones across the histogram and deepening 

shadows – images for print or publication will 

usually require a fair dose of contrast.

Adjust 
exposure
Learn how to use RAW files to pull 
detail and save images

Bring out detail
While we have boosted 
the exposure, we couldn’t 
go too far with this as it 
would affect the highlights. 
We’ve increased the 
Shadow slider to the 
maximum to show detail 
in the rocks without 
affecting everything else

Prevent loss
To counter the increase in 
exposure causing loss of 
highlight detail, the Highlights 
slider has been moved to 
bring out maximum detail 
in the highlights around the 
Sun area. This also brings 
out more colour from the 
reflections on the water

Unedited 
JPEG

Unnatural tones 
The edited JPEG file here 
shows an odd colour cast 

caused by extensive editing. 
By editing in RAW, this can be 

easily avoided
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Exposure correction 
Vibrant, punchy and full of detail 
that would have otherwise been 
lost, the converted RAW file has 
really provided the true potential of 
this scenic shot

RAW files are typically 12- or 

14-bit, which means they have 

4,096 or 16,384 brightness levels 

respectively. This provides room 

for big edits and corrections.

JPEG files are 8-bit, which gives 

them only 256 brightness levels. 

When making exposure edits, 

you push the image harder, so 

posterisation issues can occur.

Brightness

Noise reduction algorithms are far 

more sophisticated in RAW editing 

software than in-camera. Applying 

them in a RAW editor will give you 

far better results. 

Out-of-camera JPEG files have 

already had noise reduction 

applied to them, so if you plan on 

making exposure adjustments then 

quality will suffer as a result.

Noise

As RAW files are a collection of 

data, you have ultimate control 

over colour enhancements, while 

there are many more controls and 

options for adjustment.

JPEG images are processed for 

colour adjustments and are then 

converted to 8-bit format, so the 

colour information gathered by the 

sensor is lost forever.

Colour

One of RAW’s biggest strengths 

is the ability to choose your white 

balance after shooting. This is 

useful when shooting in varied or 

artificial lighting conditions.

JPEG images have white balance 

applied at the time of shooting, 

either by the Auto setting or by 

user input. This makes it more 

difficult to correct colour casts.

White balance

Most RAW editors use non-

destructive editing. As you’re only 

editing a series of data, the file can 

be reopened at any time and the 

original data is intact.

Because JPEG images are 8-bit 

and use compression, any time 

you edit or save the file, it causes 

further degradation of quality that 

can never be retrieved.

Quality

JPEGRAW 

Five reasons why RAW comes out on top
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Balance the light
Overall exposure has 
been increased by 
+0.7EV, which has the 
effect of correcting the 
overall image brightness, 
but also lifting the 
highlights in the sky and 
losing detail in the horizon 
that we don’t want

Edited 
from 
JPEG

Edited from RAW
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Adjustment to image sharpness and reducing 

noise is one of the key benefits of shooting 

RAW. Generally speaking, sharpening is the last 

adjustment you should be making to any image, 

so you will always be looking to reduce noise 

before sharpening the noise-reduced image.

Looking at the Detail tab in Adobe Camera 

Raw or Lightroom, you’ll see two sections for 

Sharpening and Noise Reduction. The Noise 

Reduction section is split into two sections, 

Color and Luminance. The Color slider looks 

for areas of similar colour and blends them 

to create smoother transitions. The default is 

set to 25 and generally this does the job. It’s 

the Luminance slider that most people use to 

visible noise. RAW images as a default have no 

luminance noise reduction added, so you will 

most likely need to add a little. Use the preview 

as a guide and slide the Luminance tab right 

– you will now have a smooth image with no 

noise whatsoever. However, you have also lost 

a fair bit of detail, so reduce this until you see 

minimal noise seep back into your image.

You can then use the Detail slider to tell the 

software how much detail you want to retain. 

Again, go easy on this as increasing the Detail 

amount will reintroduce noise as the software 

thinks you are telling it that the noise is detail 

that you want to retain – a figure of around 50 

usually works well. The Contrast slider adds 

in more detail, but more often than not, more 

noise, so generally leave this alone.

As a final action we can add sharpening. This 

can be done in the RAW editor and exported 

as is. Alternatively, save the image as it is and 

apply any final sharpening in Photoshop using 

the Unsharp Mask tool. As a rule of thumb, 

keep the Amount set to below 100 and the 

Radius below 1. As with noise detail, adding 

in sharpening detail will only sharpen by edge 

contrast, so if there is any noise visible it will 

make it more apparent. 

Sharpen and reduce noise
Find out the right way to apply noise reduction techniques and how to sharpen your images

Sharpen

Control detail
The Radius and Detail sliders 
need to be used very sparingly, 
particularly on noisy images. The 
Detail slider controls how much 
detail is sharpened and the 
Radius slider dictates how many 
pixels are used

Set the amount
Under the Detail tab in Lightroom, 
the Sharpening section was used to 
apply edits based on contrast edge 
detection. The most simple control 
to understand is the Amount slider

Unedited 
JPEG

Edited from RAW

Sharpen up 
As sharpening is based on 
edge contrast, the more 
image information that you 
have to work with, the better 
the sharpening effect will be
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Reduce noise

RAW noise reduction 
Adobe Camera Raw and 
Lightroom both do great jobs at 
reducing noise in RAW files. The 
editor is able to extract enough 
information to reduce noise to 
produce a usable image

Bit-depth unravelled
Understanding your base bit-depth 
settings and how they can help
The principles of bit-depth are simple. DSLRs normally capture 

12-bit data, with high-end DSLRs offering up to 14-bits. Why does 

bit-depth make RAW files better to edit?

An 8-bit JPEG file contains just 256 levels of brightness for each 

pixel, while a 12-bit RAW file contains 4,096 levels and a 14-bit file 

has 16,384 levels. When exporting to 8-bit JPEG from RAW, you’re 

throwing away all those additional brightness levels, hence why it 

is important to carry out editing in the RAW editor before exporting.

So what does this mean? With a JPEG image you stretch the 

data beyond the point where there is sufficient information to fill the 

histogram. This is in contrast to RAW files, which have more scope 

for exposure and adjustments as there is plenty of data.
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Avoid detail loss
Using the Luminance 
noise slider, the control 
was pushed far enough 
to reduce the noise 
significantly without 
losing too much detail

Go easy on sliders
The Detail adjustment slider is 
used to tell the software how 
much detail you want to retain. 
Retaining detail can also mean 
keeping noise, so go easy on 
this slider. For this image a 
setting of 50 worked fine

Blend colour noise
The Colour slider in the 
Noise section is used to 
tell the software which 
areas of noise colour 
in the image to blend 
together. It is set to 25 as 
a default, which usually 
works well

Difficult lighting 
This is a typical image that benefitted 
from being captured at 14-bit depth 
so that the maximum detail could be 
retained and enhanced

Unedited 
JPEG

Edited from RAW
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By using your RAW editor to convert to 

mono, you have the advantage of knowing 

that anything you do is non-destructive.

In Lightroom, the HSL tab has another 

tab right next to it called B&W – in Adobe 

Camera Raw there is simply a box marked 

Grayscale. The really clever trick is that the 

Color Channel sliders can then be used as 

tone adjusters to tailor your image. It’s as 

simple as playing about with the sliders to 

see what settings look best. 

You can also use the Targeted Adjustment 

tool in both Adobe Camera Raw and 

Lightroom to click on a specific tone in the 

image that you want to darken or lighten. 

If you then drag them up and down, 

the corresponding Color Channels will 

automatically adjust.

Convert to mono
Use your RAW editor to 
change to black and white 
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You can usually set your camera to 

capture images in sRGB or Adobe 

RGB, but does it really matter? 

The truth is that if you’re working 

in RAW then no, not really, as you 

will be choosing your colour space 

once you export to an image file. 

When you do that, you’re faced 

with three options: sRGB, Adobe 

RGB or ProPhoto RGB, each with 

their own benefits.

In short, sRGB has the smallest 

range of tones available, but is 

more widely used than any other 

colour space in the industry, so it’s 

a safe bet for most applications, 

including web use. Adobe RGB 

and ProPhoto RGB are mainly 

aimed at those requiring high-end 

prints, particularly ProPhoto RGB.

What colour 
space?
Should you choose 
sRGB or Adobe RGB?

Saturate colours
At the base of the Basic tab there are 
two settings that are useful for global 
adjustments, vibrance and saturation. 
It’s worth playing about with these 
to see what suits your image, but as 
this scene didn’t contain skin tones it 
was fine to make adjustments using 
the Saturation slider a little

Adobe Camera Raw and Lightroom have two 

key areas where you can enhance colours – 

the Vibrance and Saturation sliders and the HSL 

and Color tab. As you’re working with RAW you 

have the maximum colour information to play 

with, so don’t be afraid to experiment.

Increasing the Saturation will add intensity to 

all the colours in your scene. The key difference 

between Vibrance and Saturation is that the 

Vibrance slider is set to deliberately limit its 

effect on skin tones. This makes it perfect 

for when you’re editing portraits or shots 

with people in and want to increase colour 

saturation without creating unnatural skin tones.

Probably the most powerful control in 

relation to colour alteration, though, is the Hue, 

Saturation and Luminance tab (HSL). This tab 

enables you to alter the HSL values of virtually 

any colour in your image. Say you have a light 

blue sky in your image and you want it a little 

darker and warmer in tone. You can click the 

Luminance tab and reduce the Blue and Aqua 

channels to darken only those colours. You can 

then click the Hue tab and adjust the Blue and 

Aqua channels to produce a different shade of 

blue. However, even more useful than this is 

the Targeted Adjustment tool, which enables 

you to select the Luminance tab, then click and 

drag on an area of your image and the software 

will automatically adjust the relevant sliders to 

darken the specific colour you have selected.

The same works for both Hue and Saturation, 

meaning you can selectively adjust areas of 

colour. When looking at the Saturation slider, 

don’t just think about increasing saturation – 

look at areas of colour that are oversaturated 

already and use this adjustment to reduce 

saturation of that colour to bring back detail. 

Lightroom has an additional tab next to HSL 

called Color. The Color tab works in a similar 

way to HSL but it’s more suited to making 

broader adjustments to colours.

Enhance colours
Bring out all the vibrant hues and tones in your 
images by taking the files through your RAW editor

Mono manipulations 
The B&W tab shows the eight Color Channels 
available for adjustment. A positive Value increases 
the brightness of that channel
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Lift the tones
The HSL controls can be used in 
a number of ways. Here the sky 
was a little dark to start with, so 
the deep purple and blue tones 
weren’t showing through well. A 
positive Luminance value was 
applied to the Blue channel to lift it

Selectively emphasise
The Saturation tab was then used 
to selectively pick out the colours 
that were lacking punch. Doing it 
in this way made it easy to avoid 
oversaturating one particular 
colour, which can happen when 
making global adjustments

Edited from RAW

Unedited JPEG

Take control of colours 
Out-of-camera, this image lacked 
the punch that it needed. In post-
production, though, the RAW 
editor provides plenty of scope for 
making selective adjustments
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Mimic natural lighting 
It is particularly important to remove colour casts 
from food shots. This shot was taken under 
tungsten lighting and had a strong yellow cast 
at the time of shooting, but editing the RAW file 
removed it easily

Edited from JPEG

Adjusting white balance in RAW is probably 

one of the biggest advantages that RAW has 

over JPEG. Yes, you can tweak colour casts in 

JPEG images, but the JPEG image has already 

had a white balance setting applied at the time 

it was shot, so any further adjustments are only 

going to degrade the image further. RAW files 

have no white balance applied to them, so you 

can adjust these settings dramatically without 

the worry of losing image quality.

In the RAW editor you will see that the white 

balance is set to As Shot as a default. This is 

the setting stored in the metadata with the RAW 

file at the time of shooting. If you click on this 

As Shot selection, you’ll see the same presets 

that you have available on your camera. There 

are three ways of adjusting the white balance: 

by using one of the presets, using the White 

Balance tool to click on a white area of the 

image, or manually adjusting the sliders.

If shooting RAW and using a white balance 

card or device such as the SpyderCUBE in your 

frame, it would be best to use the Eyedropper 

tool, which will automatically adjust both 

temperature and tints. However, this can make 

the image look a little cold, so remember that 

while it may be accurate, a pleasing image isn’t 

necessarily one that is totally correct – it might 

be that you want the image to be warmer.

There are occasions where the presets or 

Eyedropper tool won’t give you the results 

you want, so you’ll need to adjust the image 

manually. This can seem daunting at first, but 

there is a handy tip to help you identify any 

strong colour casts in the scene. Remember, 

when we’re talking about colour casts, we are 

thinking about cold or warm (blue or yellow) 

together with tint (green or purple). Simply 

slide the Vibrance and Saturation sliders to 

the far-right and the colours in the image will 

become saturated and quite garish. It should 

emphasise any colour cast in your scene to 

enable you to make the necessary temperature 

or tint adjustments. Once you’ve balanced the 

colour cast, you can return your Vibrance and 

Saturation sliders to 0. This works particularly 

well with architectural photography, but 

can be applied to any genre.

Perfect white balance
Take control of your white balance and remove any unwanted 
colour casts from images using three simple techniques

Edited from RAW

Unedited JPEG
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Warm it up
Even though the Eyedropper tool 
makes the big changes to set the 
correct white balance, you still need 
to check overall colour temperature. 
What is technically correct isn’t 
always the most pleasing to the eye, 
so this image was warmed slightly 
using the Temperature slider

Adjust the tint
It’s worth checking the Tint 
slider is set correctly. Look for 
slight green or purple casts, 
then use the slider to adjust it 
until the cast is removed. You 
can also use the Editing brush 
to warm or cool specific areas

Neutralise casts
One of the most reliable ways to 
remove a colour cast is by using 
the Eyedropper Neutral Point 
tool to click on a part of the 
image you know to be neutral 
grey or white. In this case, the 
white plate worked well
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an account with our secure 
FileSilo system, log in and 
unlock the bookazine by 
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then access the 
content for free 
at any time, and 
download it to 
your desktop.

02 Once you have 
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the more your instantly 
accessible collection of 
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accessing content on 
FileSilo, or with the 
registration process, take a 
look at the FAQs online or 
email filesilohelp@
imagine-publishing.co.uk.

facebook.com/ImagineBookazines
facebook.com/DigitalPhotographerUK

194   Photography Tips, Tricks & Fixes





Everything you need to get more from your camera

Photography

Tricks

Fixes

Capture stunning vistas, improve 
your macro skills and learn the secrets 
behind great wildlife photography

Tips

Volume 3

Master monochrome, create 
inspiring compositions and 
shoot amazing macros

Rescue and recover your 
overexposed photos 
and damaged prints

The ultimate creative assets

 100 essential brush strokes

 20 skin retouching actions

 80 beautiful bokeh brushes

 Gorgeous faded � lm � lters

Brushes, actions, filters & moreFREE DOWNLOAD


